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1 Zusatzmodul Anonymisierung
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•

1.1 Installation Zusatzmodul Anonymisierung

1.1.1 Voraussetzung
KIX Professional 17 - aktuelle Version

1.1.2 Paket Installation
Installieren Sie das Paket "Ticket Anonymization" mit der "Paketverwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile.
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•

1.2 Konfiguration Zusatzmodul Anonymisierung
Um die Einstellungen für diese Funktion zu konfigurieren, wählen Sie in der SysConfig die Gruppe 
"KIXTicketAnonymization". Nachdem die Seite neu geladen wurde, wählen Sie die Untergruppe "Core".

Anonymer Agent (siehe Seite 14) 

Attribute für anonymen Agenten (siehe Seite 14) 

E-Mail Domain als anonymer Agent (siehe Seite 15) 

Anonymen Agenten erzeugen bei Notwendigkeit (siehe Seite 15) 

Anonyme Kunden-ID (siehe Seite 17) 

Match-Kriterien für Kunden-ID (siehe Seite 17) 

Anonyme Kunden-ID durch Backend (siehe Seite 17) 

Match-Kriterien für Kunden-ID durch Backend (siehe Seite 18) 

Anonymer Ansprechpartner (siehe Seite 18) 

Match-Kriterien für Ansprechpartner (siehe Seite 18) 

Anonymer Ansprechpartner durch Backend (siehe Seite 19) 

Match-Kriterien für Ansprechpartner durch Backend (siehe Seite 19) 

E-Mail als anonymer Ansprechpartner (siehe Seite 19) 

Anonymisierte Historien-Komentare (siehe Seite 20) 

Artikel E-Mail Adressen (siehe Seite 21) 

Dynamisches Feld für Anonymisierungs-Flag (siehe Seite 21) 

Tickets mit Anonymisierungs-Flag ignorieren (siehe Seite 21) 

1.2.1 Anonymer Agent
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousAgent

Mit dieser Einstellung können Sie einen anonymen Agenten-Login definieren, der den Bearbeiter und 
Verantwortlichen bei anonymisierten Tickets ersetzt.

 

1.2.2 Attribute für anonymen Agenten
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousAgentAttribute 

Mit dieser Einstellung können Sie ein Attribut des derzeitigen Agenten für ein Ticket angeben, dessen Wert 
den Bearbeiter und Verantwortlichen in anonymisierten Tickets ersetzt.

Bitte beachten: Diese Einstellung wird auch als Fallback genutzt. D.h. der Agent sollte existieren, 
sonst werden die Agenten-Daten nicht anonymisiert. Der Standardwert ist: "root@localhost". Diese 
Einstellung ist notwendig.
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1.2.3 E-Mail Domain als anonymer Agent
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousAgentFromEMailDomain

Mit dieser Einstellung können Sie festlegen, ob die Domain des E-Mail-Attributs eines Agenten als anonymer 
Agent verwendet werden soll. Diese Einstellung wird genutzt, wenn sie auf "Ja" gesetzt ist und wenn die 
Einstellung: "KIXTicketAnonymization###AnonymousAgentFromEMailDomain" nicht konfiguriert wurde oder 
wenn es keinen Attributwert des aktuellen Agenten gibt.

 

1.2.4 Anonymen Agenten erzeugen bei Notwendigkeit
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousAgentCreate

Wenn diese Einstellung aktiv ist und der Agent im Attribut der Einstellung: 
"KIXTicketAnonymization###AnonymousAgentAttribute" bzw. der Agent aus der Einstellung: 
"KIXTicketAnonymization###AnonymousAgentFromEMailDomain" nicht existiert, wird ein neuer, "ungültiger" 
Agent mit folgenden Attributen und Werten erzeugt: 
 

Attribut Wert

UserFirstName Ano

UserLastName Nymous

UserLogin Attributswert von : 
"KIXTicketAnonymization###AnonymousAgentAttribut"

oder Domain von Einstellung: 
"KIXTicketAnonymization###AnonymousAgentFromEM"

Bitte beachten: Diese Einstellung ist standardmäßig aktiviert.

UserEmail Attributswert oder Domain "@noreply.local"

Bitte beachten: Diese Einstellung ist standardmäßig deaktiviert.

Bitte beachten: Die Einstellung ist standardmäßig deaktiviert und auf "Nein" gesetzt.
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Bitte beachten: Die Einstellung ist standardmäßig deaktiviert.
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1.2.5 Anonyme Kunden-ID
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousCustomerID

Mit dieser Einstellung können Sie festlegen, welche Kunden-ID die Kunden-ID bei anonymisierten Tickets 
ersetzt. Wenn Sie stattdessen einen Wert eines Kundenattributs nutzen möchten, dann verwenden Sie bitte 
die Einstellung: "KIXTicketAnonymization###AnonymousCustomerIDByCustomerBackend".

 

1.2.6 Match-Kriterien für Kunden-ID
SysConfig-Einstellung: KIXTicketAnonymization###AnonymizationCustomerID_MatchCriteria 

Mit dieser Einstellung können Sie einen regulären Ausdruck definieren. Die Kunden-ID wird mit dem Wert aus 
der Einstellung "KIXTicketAnonymization###AnonymousCustomerID" nur in den Tickets ersetzt, in denen die 
aktuelle Ticket-Kunden-ID mit dem angegebenen regulären Ausdruck übereinstimmt.

 

1.2.7 Anonyme Kunden-ID durch Backend
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousCustomerIDByCustomerBackend

Mit dieser Einstellung können Sie eine spezifische Kunden-ID angeben, die in anonymisierten Tickets die 
Kunden-ID ersetzt abhängig vom Backend des derzeitigen Ticketkunden. Der Inhalt kann eine Kunden-ID oder 
ATTRIBUTE_BeliebigesAttribut sein, um den Wert des jeweiligen Attributs des aktuellen Kundenbenutzers zu 
verwenden.

 

Bitte beachten: Die Einstellung wird als Fallback genutzt, wenn die Einstellung 
"KIXTicketAnonymization###AnonymousCustomerIDByCustomerBackend" nicht konfiguriert ist. 
Wenn in beiden Einstellungen nichts konfiguriert ist, wird die Kunden-ID nicht anonymisiert. Der 
Standardwert ist "AnonymousCompany" und diese Einstellung ist notwendig.



Bitte beachten: Die Einstellung ist ebenfalls der Fallback für die Einstellung 
"KIXTicketAnonymization--- AnonymousCustomerUserIDByCustomerBackend_MatchCriteria". Der 
Standardwert (.*) passt für alles. Wenn die Kunden-ID nicht übereinstimmt, wird der Ansprechpartner 
ebenfalls nicht anonymisiert.



Bitte beachten: Die Einstellung ist standardmäßig deaktiviert. 
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1.2.8 Match-Kriterien für Kunden-ID durch Backend
SysConfig-Einstellung:  
KIXTicketAnonymization###AnonymousCustomerIDByCustomerBackend_MatchCriteria

Mit dieser Einstellung können Sie einen regulären Ausdruck definieren. Die derzeitige Kunden-ID wird nur 
dann mit dem Wert aus der Einstellung: 
"KIXTicketAnonymization###AnonymousCustomerIDByCustomerBackend" ersetzt, wenn sie dem hier 
definierten regulären Ausdruck entspricht.

 

1.2.9 Anonymer Ansprechpartner
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousCustomerUser

Mit dieser Einstellung können Sie einen Ansprechpartner-Login definieren, der in anonymisierten Tickets den 
Ansprechpartner des derzeitigen Tickets ersetzt. Wenn Sie einen Wert eines Ansprechpartner-Attributs 
nutzen möchten, dann nutzen Sie bitte die Einstellung: "AnonymousCustomerUserByBackend".

 

1.2.10 Match-Kriterien für Ansprechpartner
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousCustomerUser_MatchCriteria

Mit dieser Einstellung können Sie einen regulären Ausdruck definieren. Der derzeitige Ansprechpartner wird 
nur dann mit dem Wert aus der Einstellung: "KIXTicketAnonymization###AnonymousCustomerUser" ersetzt, 
wenn sie dem hier definierten regulären Ausdruck entspricht.

 

Bitte beachten: Die Einstellung ist standardmäßig deaktiviert. Der Standardwert ist "(.*)"

Bitte beachten: Diese Einstellung wird als Fallback genutzt. Wenn diese Einstellung nicht spezifiert 
ist, dann werden die Ansprechpartner-Daten nicht anonymisiert. Der Standardwert ist 
"AnonymousUser". Die Einstellung wird benötigt.



Bitte beachten: Diese Einstellung wird auch als Fallback für die Einstellung: 
"KIXTicketAnonymization###AnonymousCustomerUserByBackend_MatchCriteria" genutzt. Der 
Standardwert ist "(.*)".
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1.2.11 Anonymer Ansprechpartner durch Backend
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousCustomerUserByBackend

Mit dieser Einstellung können Sie einen spezifischen Ansprechpartner angeben, der in anonymisierten 
Tickets den Ansprechpartner ersetzt abhängig vom Backend des derzeitigen Ticketkunden. Der Inhalt kann 
eine Ansprechpartnerkennung oder ATTRIBUTE_BeliebigesAttribut sein, um den Wert des jeweiligen Attributs 
des aktuellen Ansprechpartner zu verwenden.

1.2.12 Match-Kriterien für Ansprechpartner durch Backend
SysConfig-Einstellung: 
KIXTicketAnonymization###AnonymousCustomerUserByBackend_MatchCriteria

Mit dieser Einstellung können Sie einen regulären Ausdruck definieren. Die derzeitige Kunden-ID wird nur 
dann mit dem Wert aus der Einstellung: "KIXTicketAnonymization###AnonymousCustomerUserByBackend" 
ersetzt, wenn sie dem hier definierten regulären Ausdruck entspricht.

 

1.2.13 E-Mail als anonymer Ansprechpartner
SysConfig-Einstellung: KIXTicketAnonymization###AnonymousCustomerUserFrom

Mit dieser Einstellung können Sie festlegen, ob die Domain des E-Mail-Attributs eines Ansprechpartners als 
anonymer Ansprechpartner verwendet werden soll. Diese Einstellung wird genutzt, wenn sie auf "Ja" gesetzt 
ist und wenn die Einstellung: "KIXTicketAnonymization###AnonymousCustomerUserByBackend" nicht 
konfiguriert wurde oder wenn es keinen Attributwert des aktuellen Agenten gibt.  

 

Bitte beachten: Diese Einstellung ist standardmäßig deaktiviert.

Bitte beachten: Die Einstellung ist standardmäßig deaktiviert. Der Standardwert ist "(.*)"

Bitte beachten: Die Einstellung ist standardmäßig deaktiviert und auf "Nein" gesetzt. 
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1.2.14 Anonymisierte Historien-Komentare
SysConfig-Einstellung: KIXTicketAnonymization###HistoryTypeAnonymousComments

Mit dieser Einstellung können Sie festlegen, welche Kommentare in der Historie anonymisierter Tickets 
enthalten sein sollen und welchen Text die Kommentare enthalten. Es sind folgende Standardwerte gegeben:

 

Attribut Wert

CustomerUpdate CustomerUpdate: comment replaced by CustomerUpdate 
KIXTicketAnonymization.

OwnerUpdate OwnerUpdate: comment replaced by OwnerUpdate 
KIXTicketAnonymization.

ResponsibleUpdate ResponsibleUpdate: comment replaced by KIXTicketAnonymization.

SendAgentNotification SendAgentNotification: comment replaced by KIXTicketAnonymization.

SendAnswer SendAnswer: comment replaced by KIXTicketAnonymization.

SendAutoReply SendAutoReply: comment replaced by KIXTicketAnonymization.

SendCustomerNotification SendCustomerNotification: comment replaced by 
KIXTicketAnonymization.

TicketLinkAdd Added involved personen: comment replaced by 
KIXTicketAnonymization.

Bitte beachten: Die Einstellung ist standardmäßig aktiviert und wird benötigt.
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1.2.15 Artikel E-Mail Adressen
SysConfig-Einstellung: KIXTicketAnonymization###ReplaceEmailAddresses

Mit dieser Einstellung können Sie eine anonyme E-Mail-Adresse definieren, mit der die E-Mail-Adressen in 
Artikeln von anonymisierten Tickets ersetzt werden, wenn die Artikel-E-Mail-Adresse keine Systemadresse 
ist.

 

1.2.16 Dynamisches Feld für Anonymisierungs-Flag
SysConfig-Einstellung: KIXTicketAnonymization###AnonymizationFlag

 Mit dieser Einstellung können Sie ein dynamisches Feld konfigurieren, das genutzt wird, um den Wert des 
Anonymisierungs-Flag zu setzen.

 

1.2.17 Tickets mit Anonymisierungs-Flag ignorieren
SysConfig-Einstellung: KIXTicketAnonymization###IgnoreTicketsWithAnonymizationFlag

Mit dieser Einstellung können Sie festlegen, dass Tickets, die bereits anonymisiert wurden, in zukünftigen 
Anonymisierungsprozeduren ignoriert werden.

 

 Bitte beachten: Der Standardwert ist "kix@localhost". Die Einstellung ist notwendig. 

 Bitte beachten: Diese Einstellung ist standardmäßig aktiviert. Während der Installation dieser 
Erweiterung wurde das dynamische Feld "Anonymized" erstellt, so dass Sie die gegebene 
Konfiguration benutzen können. Möglicherweise müssen Sie Ihre Konfiguration aktualisieren, wenn 
Sie das dynamische Feld in einigen Anzeigen dargestellt haben möchten.



Bitte beachten: Diese Einstellung ist standardmäßig aktiviert.
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1.3 Benutzung
Es gibt zwei unterschiedliche Möglichkeiten, Tickets zu anonymisieren. Sie können im Admin-Bereich dafür 
einen Generic Agent erzeugen oder Sie nutzen das Kommandozeilen-Skript.

1.3.1 Konfiguration eines Generic Agent
Der Generic Agent für diese Funktionalität muss manuell erzeugt werden. Wählen Sie dazu im Bereich 
"Admin" im Widget "Systemverwaltung" den Punkt "Generic Agent". Klicken Sie im Bereich "Generic Agent" auf 
die Schaltfläche "Job hinzufügen". Legen Sie nun in den einzelnen Widgets die Details zu den Tickets fest, die 
anonymisiert werden sollen.

Geben Sie im Widget "Benutzerdefiniertes Modul ausführen" folgende Modulbezeichnung ein:

  Kernel::System::GenericAgent::KIXTicketAnonymization

 

Klicken Sie abschließend auf die Schaltfläche "Übermitteln". Der Job erscheint nun in der Liste der definierten 
Jobs.

Klicken Sie auf "Diesen Job ausführen" in der Spalte "Jetzt ausführen", um den erzeugten Job sofort 
auszuführen.

1.3.2 Tickets via Skript anonymisieren
Es gibt ebenfalls die Möglichkeit, Tickets via Kommandozeile zu anonymisieren. Führen Sie dazu:

/bin/kix.Console.pl Admin::KIXTicketAnonymization::Anonymize

 

mit einem der Parameter "--user agent_login" oder "--customer customer_user_login" aus.

Wenn ein Agenten-Login angegeben wurde, werden alle Tickets von denen der Agent Bearbeiter oder 
Verantwortlicher ist basierend auf den Angaben in der SysConfig anonymisiert. Wenn ein Ansprechpartner- 
Login angegeben wurde, werden alle Tickets dieses Ansprechpartners basierend auf den Angaben in der 
SysConfig anonymisiert.
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1.3.3 Beispiel eines anonymisierten Tickets
 

Ticket vor der Anonymiseirung

 

Im Generic Agent wird der Job zur Anonymisierung ausgeführt.

 

So sieht das anonymisierte Ticket aus.
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2 Zusatzmodul Field Service
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2.1 Installation des Moduls

2.1.1 Voraussetzungen
KIX Professional 17 - aktuelle Version
Sofern bereits vorhanden: Kanban-Board deinstallieren.

Das Modul Field Service bringt von Haus aus das Kanban-Board mit. Ist das Modul Kanban- 
Board bereits installiert, kann das Modul Field Service nicht installiert werden und das System 
gibt eine Fehlermeldung aus.

2.1.2 Paket Installation
Installieren Sie das Paket "KIXFieldService" mit der "Paket-Verwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile.

2.1.3 Neue Gruppe
Während der Installation wird eine neue Gruppe "FieldService" erzeugt. Die Gruppe bietet Zugriff zum Widget 
"Kartenansicht" in der Seitenleiste des Kanban-Board. Der Initial-Benutzer (Standard: root@localhost) hat 
nach der Installation Schreibrechte für diese Gruppe. 
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2.2 Installation der App auf einem Mobile Device
Die FieldService App ist eine mobile Anwendung (App) für Android-Geräte, um Daten aus KIX auf dem 
mobilen Endgerät für Servicetechniker offline bereitzustellen, damit sie in Umgebungen ohne 
Internetverbindung arbeiten können. Die Servicetechniker können mit der App die notwendigen Daten 
ansehen und ihre Arbeit dokumentieren. Nachdem alle Arbeiten durchgeführt wurden, kann diese 
Dokumentation wieder mit dem Server synchronisiert werden.

2.2.1 Voraussetzung
Damit die App genutzt werden kann, müssen folgende Voraussetzungen erfüllt sein:

Ein mobiles Endgerät (Smartphone, Tablet, etc.) mit Android 4.0 oder höher.
Eine Netzwerkverbindung zwischen mobilen Endgerät und dem KIX-Server für den Down-/Upload.

2.2.2 Installation der App
Die App ist nicht im Google Play Store verfügbar. Wenn Sie die App herunterladen möchten, geben Sie im 
Browser des mobilen Endgerätes folgende URL ein:

 
"http://<FQDN KIX-Server>FQDN KIX-Server/kix-web/FieldService.apk"

 
Öffnen Sie nach dem Download die heruntergeladene Datei: FieldService.apk.

 

2.2.3 Konfigurieren der Server URL
Damit die App mit dem KIX-Server kommunizieren kann, muss in der App die URL des KIX-Servers angeben 
werden. Wenn Sie die App das erste Mal starten, werden Sie aufgefordert die Server URL einzutragen.

Beispiel: "http://<FQDN KIX-Server>/kix/index.pl"' 
 

Hinweis

In den Systemeinstellungen des Android Gerätes müssen Sie ggf. die Einstellung für die Installation 
von Apps "unbekannter Herkunft" anpassen.
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2.2.4 Geräte-ID in KIX registrieren
Sobald die Server-URL konfiguriert wurde, zeigt die App einen Bildschirm mit einem Link "DeviceID anzeigen". 
Wenn Sie auf diesen Link tippen, wird Ihnen die Geräte-ID angezeigt.  
Diese Geräte-ID muss in KIX bei dem ConfigItem, was das mobile Endgerät repräsentiert, als Attribut 
"Seriennummer" eingetragen sein. Diese Angabe ist wichtig, damit die mobilen Datensätze für das jeweilige 
mobile Endgerät erzeugt und übertragen werden können.

 

 

 

Abbildung: ConfigItem - Attribut Seriennummer
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2.3 Konfiguration
Wenn Sie das Paket installiert haben, können Sie bei Bedarf im Admin-Bereich/SysConfig die Standardwerte 
einstellen. Wählen Sie dazu die SysConfig-Gruppe "KIXFieldService". Nachdem die Seite neu geladen wurde, 
wählen Sie die Untergruppen "Frontend::Agent::FieldService".

Wenn Sie Einstellungen für das Modul "Kanban-Board" machen möchten, wählen Sie dazu die SysConfig- 
Gruppen "Kanban4KIX" und eine der Untergruppen "Frontend::Agent::KanbanView" oder "Frontend::Agent:: 
AgentKanbanActionCommonPopup".

Eine Standard-Konfiguration ist bereits im Paket enthalten. Sie können diese nach ihren Wünschen 
anpassen. In den folgenden Abschnitten werden die SysConfig-Einstellungen erklärt.

2.3.1 Widget "Kartenansicht" in Kanban-Seitenleiste
SysConfig-Einstellung: Frontend::KanbanSidebarBackend###FieldServiceMap

Diese Option aktiviert das Widget "Kartenansicht" in der Seitenleiste des Kanban-Boards. Im Schlüssel 
"Group" stehen die Agentengruppen, getrennt durch Semikolon, die Zugriff auf das Widget haben.

 

2.3.2 Regionsangabe für Google Maps
SysConfig-Einstellung: FieldServiceMap::Region

Bestimmt die Regionsangabe für Google Maps. Dies hat Einfluss auf das Verhalten von Funktionen wie das 
Ermitteln von Geolokationsdaten. Die meisten Regionsangaben sind identisch zu den jeweiligen 
länderspezifischen Top-Level-Domains (siehe hierzu ISO 3166-1), aber es gibt einige Ausnahmen (z.B. "GB" 
statt "UK" für Großbritannien).  
 

Bitte beachten: Der Standardwert für diese Gruppe ist "FieldService".

Bitte beachten: Diese Einstellung ist notwendig. Der Standardwert ist "DE".
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2.3.3 Google API Schlüssel
SysConfig-Einstellung: FieldServiceMap::GoogleApiKey

Hier können Sie Ihren Google-API-Schlüssel eingeben. Der Schlüssel ist notwendig, um die FieldService-  
Kartenansicht zu nutzen. Mehr Informationen finden Sie unter:

https://developers.google.com/maps/documentation/javascript/get-api-key

2.3.4 Maximale Suchtiefe
SysConfig-Einstellung: FieldServiceMap::MaxLinkDepth

Mit dieser Einstellung legen Sie fest, wie tief die Suche nach verknüpften CIs folgt, um Adressdaten zu 
erhalten.  
 

2.3.5 Relevante CI-Klasse
SysConfig-Einstellung: FieldServiceMap::CIClassWithAddress

Diese Einstellung gibt die relevante CI-Klasse mit den Adressdaten an.  
 

2.3.6 Relevante CI-Klassenattribute
SysConfig-Einstellung: FieldServiceMap:CIClassWithAddressAttributes 

Diese Einstellung legt die relevanten CI-Klassenattribute fest, die Adressdaten enthalten.  
 

Bitte beachten: Diese Einstellung ist notwendig und der Standardwert ist "3".

Bitte beachten: Der Standardwert ist "Location".

Bitte beachten: Der Standardwert ist "Address".
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2.3.7 Relevante Ansprechpartner-Attribute
SysConfig-Einstellung: FieldServiceMap::UserAddressFields 

Mit dieser Einstellung legen Sie die relevanten Ansprechpartner-Attribute fest, in denen die Adressdaten 
enthalten sind. Diese Daten werden als Fallback verwendet, wenn ein Ticket keine verlinkten CIs hat oder 
wenn mit verlinkten CIs keine Adressdaten ermittelt werden konnten.

2.3.8 Cache Time To Live
SysConfig-Einstellung: FieldServiceMap::GeoLocationCacheTTL 

Diese Einstellung legt fest, wie viele Tage die Geolocation-Daten einer Adresse im Cache behalten werden.  
 

2.3.9 Hervorhebung der Farben
SysConfig-Einstellung: FieldServiceMap::EmphasizeColor

Mit dieser Einstellung legen Sie die Füll- und Randfarbe der Kartenmarkierungen und Kanban-Tickets fest.  
 

2.3.10 Karteneinstellungen für Kanban-View Konfiguration
SysConfig-Einstellung: 
Frontend::Output::FilterElementPre###OutputFilterAgentFieldServiceMapSettings

Diese Einstellung bestimmt den Ausgabefilter, den die Karteneinstellung in der Kanban-View Konfiguration 
zur Verfügung stellt. Der Wert bei "DefaultMapCenter" kann eine Adresse oder Breiten- /Längengrad- 
Koordinate sein. Der Wert bei "DefaultZoom" sollte eine Zahl zwischen 1 und 18 sein.

Bitte beachten: Die Standardwerte sind "UserStreet" , "UserZip" , "UserCity" und "UserCountry".

Bitte beachten: Der Standardwert ist "30".

Bitte beachten: Der Standardwert ist blau "#00B1D5" für die Füllung und "#005D70" für den Rand.

Bitte beachten: Die Standardwerte sind "51.163375 , 10.447683" (Mitte von Deutschland) und "6" für 
den Zoom.
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2.3.11 Tour-Status Workflow
SysConfig-Einstellung: FieldService::Tour###StateWorkflow 

Diese Einstellung definiert den Zustandsablauf einer Außendiensttour.  
 

2.3.12 MobileDataSet: Maximum Leerlauf-Zeit
SysConfig-Einstellung: FieldService::MobileDataSet###Directory 

Diese Einstellung legt die maximale Leerlaufzeit in der FieldService-App fest. Wenn der Nutzer innerhalb 
dieser Zeit nicht in der App arbeitet, meldet die App den Nutzer ab.  
Der Standardwert ist 1800 Sekunden (30 Minuten).

2.3.13 MobileDataSet: Ausgabeverzeichnis
SysConfig-Einstellung: FieldService::MobileDataSet###Directory 

Diese Einstellung gibt das Ausgabeverzeichnis an, in dem die MDS-Daten erzeugt werden.  
 

2.3.14 MobileDataSet: Enthaltene Anhänge
SysConfig-Einstellung: FieldService::MobileDataSet###IncludeAttachments

Diese Einstellung definiert die Voreinstellung für Anhänge der Objekte, die in einer Tour enthalten sind. Sie 
können diese Einstellung im Dialog beim Erzeugen einer Tour überschreiben.

2.3.15 MobileDataSet: Enthaltene verknüpfte Objekte
SysConfig-Einstellung: FieldService::MobileDataSet###IncludeLinkedObjects

Diese Einstellung definiert die Voreinstellung für direkt verknüpfte Objekte, die in einer Tour enthalten sind. 
Sie können diese Einstellung im Dialog beim Erzeugen einer Tour überschreiben.

Bitte beachten: Nur ändern, wenn Sie sicher sind, was Sie tun.

Bitte beachten: Nur ändern, wenn Sie sicher sind, was Sie tun.
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2.3.16 MobileDataSet: Geräte-ID Attribute
SysConfig-Einstellung: FieldService::MobileDataSets###CIAttributeDeviceID 

Diese Einstellung legt das CI-Attribut fest, das die ID des mobilen Endgerätes enthält. Der Standardwert ist 
"SerialNumber".

2.3.17 MobileDataSet: Typ des Eintrages in der Tickethistorie für neue, 
synchronisierte Artikel

SysConfig-Einstellung: FieldService::MobileDataSet###HistoryType

Diese Einstellung legt den Typ des entsprechenden Historie-Eintrags fest, wenn ein neuer Artikel vom 
mobilen Endgerät mit dem Server synchronisiert wird. Der Standardwert ist "AddNote".

2.3.18 MobileDataSet: Kommentar des Eintrages in der Tickethistorie für 
neue, synchronisierte Artikel

SysConfig-Einstellung: FieldService::MobileDataSet###HistoryComment 

Diese Einstellung legt den Kommentar eines Historie-Eintrages fest, wenn ein neuer Artikel vom mobilen 
Endgerät mit dem Server synchronisiert wird. Der Standardwert ist "synchronized article from mobile device" .
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3 Zusatzmodul Inventarisierung Baramundi Backend
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3.1 Installation Baramundi Backend

3.1.1 Vorraussetzungen
KIX Professional 17 - aktuelle Version
Baramundi 8.9 oder höher

3.1.2 Paket Installation
Installieren Sie das Paket "kixpro-inventorysync-baramundi" mit der "Paketverwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile. 
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3.2 Konfiguration Baramundi Backend
Das Paket beinhaltet eine Beispielkonfiguration, die Sie nach Ihren Bedürfnissen anpassen können. Um die 
Einstellungen für diese Funktion zu konfigurieren, wählen Sie in der SysConfig die Gruppe "KIX Pro". 
Nachdem die Seite neu geladen wurde, wählen Sie die Untergruppe "ITSMConfigItem::InventorySync".  
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3.2.1 Source
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Sources

 
Eine Quelle benötigt einen benannten Kommunikationspunkt. Zur Konfiguration wird ein Hash benutzt. Der 
Hash-Schlüssel ist der interne Name der Quelle. bspw. "inventory1". Der Hash-Wert ist der Anzeigename für 
diese Quelle, bspw. "inventory server 1".  
Sie können mehrere Quellen für jeden externen Inventory-Server hinzufügen.  
 
 
Source-Backend-Mapping

SysConfig-Einstellung: ITSMConfigItem::InventorySync###Backend

 
Diese Einstellung definiert das zu nutzende Backend. Zur Konfiguration wird ein Hash benutzt. Der Hash- 
Schlüssel ist der Identifikator der Quelle (in unserem Beispiel "inventory1"). Der Hash-Wert muss für nicht 
mobile Geräte im Feld "Inhalt" mit "Baramundi" angegeben werden. Für mobile Geräte muss in das Feld 
"Inhalt" der Wert "BaramundiMD" eingetragen werden. 
 
 
Source-Parameter

SysConfig-Einstellung: ITSMConfigItem::InventorySync###Parameters

 

 

In dieser Einstellung müssen Sie den database connection string (DSN) in der folgenden Form angeben:

DatabaseDSN=DBI:ODBC:<DataSource>;DatabaseUser=<uid>;DatabasePw=<pwd>;<additonal parameters>

 

 

Parameter Benötigt Beschreibung

DataSource x Der Name der Baramundi ODBC Datenquelle.

DatabaseUser x Nutzername des Datenbank-Nutzers.

DatabasePw x Passwort des Datenbank-Nutzers.
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Parameter Benötigt Beschreibung

Additional Parameters  Hängt von der konfigurierten Datenquelle ab. Wenn die 
Datenquelle ein MSSQL-Server ist, müssen Sie als 
zusätzlichen Parameter "Type=mssql" angeben.

UseInventoryType  Optionaler Parameter zur Angabe, welcher Typ von 
Inventory-Daten genutzt werden soll. Wenn nicht 
angegeben, werden die Daten des "Standard Template" 
benutzt. Wenn Sie WMI-Daten nutzen wollen, setzen Sie 
den Wert auf "WMI".

 

Hinweis

Bitte beachten: Für mobile Geräte ist dieser 
Parameter nicht möglich.



Hinweis

Bitte beachten: Es muss ein DSN basierter ODBC connection string benutzt werden. Andere 
Konfigurationen werden nicht funktionieren.
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3.2.2 Backend „Baramundi“
Standardmäßig wird folgende Information zu den Daten der unterschiedlichen Hardware-Scans (Standard 
und WMI) hinzugefügt:

General Information
Manufacturer
ModelName
OperatingSystem
CurrentUser
PrimaryIP
PrimaryMAC
TimeZone
MACList
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3.2.3 Backend „BaramundiMD“ (Mobile Devices)
Die Daten der mobilen Endgeräte werden in Baramundi anders verwaltet als die Daten der nicht-mobilen 
Endgeräte. Daher unterscheidet sich die von diesem Backend gelieferte Datenstruktur signifikant von der des 
Backends„Baramundi".  
Es werden folgende Daten aus Baramundi bereitgestellt:

Übersicht
Allgemein
Betriebssystem
Netzwerk

Geräteinventur
Geräteinformationen
Einschränkungen
Sicherheitseinstellungen
Installierte Wi-Fi-Konfigurationen

Installierte Apps (inkl. System-Apps)

Für die detaillierte Auflistung der gelieferten Daten sei auf das mitgelieferte Console-Script verwiesen (siehe 
„InventoryContentXPath").
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Standard Hardware Scans

Die Struktur und der Inhalt von Hardware Inventory-Daten, die vom Baramundi-Backend zurück gegeben 
werden, ist nahezu identisch zu den Inhalten der Baumansicht für jeden Hardware Inventory-Scan in 
Baramundi. Es hat folgende Form:

Central Processor Unit(s)
<Liste von Attributen für jede CPU>

Motherboard
<Liste von Attributen für jedes Motherboard>

Memory 
<Liste von Attributen für jeden RAM-Slot>

Video Adapter 
<Liste von Attributen für jeden Video-Adapter>

Monitor 
<Liste von Attributen für jeden Monitor>

Drives::Floppy
<Liste von Attributen für jedes Floppy-Laufwerk>

Drives::IDE Drives
<Liste von Attributen für jedes IDE-Laufwerk>

Audio
<Liste von Attributen für jedes Audiogerät>

Network
<Liste von Attributen für jedes Netzwerkgerät>

Ports
<Liste von Attributen für jeden Port>
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WMI Hardware Scans

Die Struktur von WMI-Scans unterscheidet sich in Baramundi von den Standard-Scans. Deswegen werden die 
Daten in InventorySync in eine Struktur gemappt, die ähnlich der Struktur der Standard-Scans ist. Es hat 
grundsätzlich die folgende Form, wo die Attribute eines jeden Punktes mit den in Baramundi angezeigten 
Spalten übereinstimmen:

 

Central Processor Unit(s)

Bezieht sich auf den Baramundi-Knoten "Win32_Processor"
<Liste von Attributen für jede CPU>

 

BIOS

Bezieht sich auf den Baramundi-Knoten "Win32_Bios"
<Liste von Attributen für jeden BIOS-Node>

 

Motherboard

Bezieht sich auf den Baramundi-Knoten "Win32_BaseBoard"
<Liste von Attributen für jedes Motherboard>

 
Memory

Bezieht sich auf den Baramundi-Knoten "Win32_PhysicallyMemory"
<Liste von Attributen für jeden RAM-Slot>

 
Video Adapter

Bezieht sich auf den Baramundi-Knoten "Win32_VideoController"
<Liste von Parametern für jeden Video-Adapter>

 

Monitor

Bezieht sich auf den Baramundi-Knoten "Win32_DesktopMonitor"
<Liste von Attributen für jeden Monitor>

 
Drives::Floppy

Bezieht sich auf den Baramundi-Knoten "Win32_FloppyDrive"
<Liste von Attributen für jedes FloppyDrive>
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Drives::CDROM

Bezieht sich auf den Baramundi-Knoten "Win32_CDROMDrive"
<Liste von Attributen für jedes CDROM-Laufwerk>

 
Drives::PhysicalDisk

Bezieht sich auf den Baramundi-Knoten "Win32_DiskDrive"
<Liste von Attributen für jede Festplatte>

 
Drives::LogicalDisk

Bezieht sich auf den Baramundi-Knoten "Win32_LogicalDrive"
<Liste von Attributen für jedes logische Laufwerk>

 
Network

Bezieht sich auf den Baramundi-Knoten "Win32_NetworkAdapterConfiguration"
<Liste von Attributen für jedes Netzwerkgerät

 
Ports

Bezieht sich auf den Baramundi-Knoten "Win32_PortConnector"
<Liste von Attributen für jeden Port>

 
Wenn Baramundi keine detaillierten Attribute für ein Gerät enthält, wird dieses Gerät ignoriert.
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Software scans

Jede Software Struktur wird durch die einzigartige Software-GUID (Globally unique identifier) identifiziert und 
enthält die folgenden Attribute:

Name

Producer

Version
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3.2.4 InventoryContentXPath für das Baramundi-Backend
Die Basis-Erweiterung von ConfigItem-Klassen und die Benutzung der InventoryContentXPath-Parameter 
werden im Kapitel "KIX SysConfig/KIX Pro/InventorySync" beschrieben. Um die relevanten Daten zu 
analysieren, steht ein Console-Script bereit:

Admin::ITSM::InventorySync::DumpBaramundiData 

 
Dies ist besonders hilfreich, um den korrekten XPath bestimmen zu können. Mit dem Parameter „--source" 
wird die ID der Source angegeben, mit welcher das Script kommunizieren soll. Ein Aufruf mit demParameter 
„--list-clients" zeigt eine Liste der in der konfigurierten Source  vorhandenen Geräte.

Der Parameter „--client-id", dem der Name des entsprechenden Gerätes übergeben wird, erzeugt die Ausgabe 
der ermittelten Datenstruktur. Aus dieser können anschließend die relevanten XPath-Angaben erstellt 
werden.
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3.2.5 Xpath-Struktur und Beispiele
Der Xpath für Baramundi hat folgende Strukur:

Hardware Xpath: HW/<node>/<attribute>
Software Xpath: SW/<guid>/<attribute>

  
Typische Xpath für Baramundi können so aussehen:

HW/Central Processors(s)/CPU Brand Name to get the name attribute of each processor
HW/Drives::IDE Drives/Drive Model to get the model attribute of each harddisk drive
SW/.*?/Name to get the name of the software, regardless of its GUID 
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3.2.6 Beispiel
Das folgende Beispiel zeigt eine ConfigItem-Klassendefintion für die Klasse "Computer" mit einigen 
Änderungen für das Baramundi-Backend basierend auf Standard-Hardwarescans. Bitte beachten Sie, dass 
dies keine notwendigen Änderungen sind. Sie können Ihre eigenen Änderungen machen. Sie müssen nur 
sicherstellen, dass notwendige ConfigItem-Attribute während der Synchronisation Werte erhalten. 
Andernfalls wird eine Fehlermeldung angezeigt.

 

[ 
    {
        Key => 'ClientGroup',
        Name => 'verinice ClientGroup',
        Searchable => 1,
        Input => {
            Type => 'CIClassReference',
            ReferencedCIClassName => 'ClientGroup',
            ReferencedCIClassLinkType => 'Includes',
            ReferencedCIClassLinkDirection => 'Reverse',
            ReferencedCIClassReferenceAttributeKey => 'Name',
            Required => 0,
        },
    },
    { 
        Key => 'Vendor', 
        Name => 'Vendor', 
        Searchable => 1, 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 50, 
        }, 
    }, 
    { 
        Key => 'Model', 
        Name => 'Model', 
        InventoryContentXPath => 'HW/Motherboard/Computer Brand Name', 
        Searchable => 1, 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 50, 
        }, 
    }, 
    { 
        Key => 'Description', 
        Name => 'Description', 
        Searchable => 1, 
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        Input => { 
            Type => 'TextArea', 
        }, 
    }, 
    { 
        Key => 'Type', 
        Name => 'Type', 
        Searchable => 1, 
        Input => { 
            Type => 'GeneralCatalog', 
            Class => 'ITSM::ConfigItem::Computer::Type', 
            Translation => 1, 
        }, 
    }, 
    { 
        Key => 'Owner', 
        Name => 'User', 
        Searchable => 1, 
        Input => { 
            Type => 'Customer', 
        }, 
    }, 
    { 
        Key => 'CPU', 
        Name => 'CPU', 
        InventoryContentXPath => 'HW/Central Processor\(s\)/CPU Brand Name', 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 100, 
        }, 
        CountMax => 16, 
        Sub => [ 
            { 
                Key => 'Cores', 
                Name => 'Kerne', 
                InventoryContentXPath => 'HW/Central Processor\(s\)/Number of CPU 
Cores', 
                Input => { 
                    Type => 'Text', 
                    Size => 20, 
                    MaxLength => 10, 
                }, 
            }, 
        ], 
    }, 
    { 
        Key => 'Ram', 
        Name => 'Ram', 
        Input => { 
            Type => 'Dummy', 
        },
        Sub => [
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            { 
                Key => 'MemoryBank', 
                Name => 'Bank', 
                InventoryContentXPath => 'HW/Memory/Row Size', 
                Input => { 
                    Type => 'Text', 
                    Size => 50, 
                    MaxLength => 100, 
                }, 
                CountMax => 16,
            },
        ], 
    }, 
    { 
        Key => 'Drives', 
        Name => 'Drives', 
        InventoryContentXPath => 'HW/Drives::IDE Drives/Device Type', 
        InventoryContentEvalString => '$Inventory{\'Device Type\'} eq \'Disk 
drive\'', 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 100, 
        }, 
        CountMax => 10, 
        Sub => [ 
            { 
                Key => 'Model', 
                Name => 'Model', 
                InventoryContentXPath => 'HW/Drives::IDE Drives/Drive Model', 
                Input => { 
                    Type => 'Text', 
                    Size => 50, 
                    MaxLength => 50, 
                }, 
            }, 
        ], 
    }, 
    { 
        Key => 'CD-Rom', 
        Name => 'CD-Rom', 
        Searchable => 1, 
        InventoryContentXPath => 'HW/Drives::IDE Drives/Drive Model', 
        InventoryContentEvalString => '$Inventory{\'Drive can read\'}', 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 100, 
        }, 
    }, 
    { 
        Key => 'FQDN', 
        Name => 'FQDN', 
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        Searchable => 1, 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 100, 
        }, 
    }, 
    { 
        Key => 'NIC', 
        Name => 'Network Adapter', 
        InventoryContentXPath => 'HW/Network/Network Card', 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 100, 
        }, 
        CountMin => 0, 
        CountMax => 10, 
        CountDefault => 1, 
        Sub => [ 
            { 
                Key => 'IPoverDHCP', 
                Name => 'IP over DHCP', 
                Input => { 
                    Type => 'GeneralCatalog', 
                    Class => 'ITSM::ConfigItem::YesNo', 
                    Translation => 1, 
                }, 
            }, 
            { 
                Key => 'IPAddress', 
                Name => 'IP Address', 
                Searchable => 1, 
                Input => { 
                    Type => 'Text', 
                    Size => 40, 
                    MaxLength => 40, 
                }, 
                CountMin => 0, 
                CountMax => 20, 
                CountDefault => 0, 
            }, 
        ], 
    }, 
    { 
        Key => 'GraphicAdapter', 
        Name => 'Graphic Adapter', 
        InventoryContentXPath => 'HW/Video Adapter/Video Chipset', 
        InventoryContentEvalString => '$Inventory{\'Video Chipset\'}', 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 100, 
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        }, 
    }, 
    { 
        Key => 'Software', 
        Name => 'Software', 
        InventoryContentXPath => 'SW/.*?/Name', 
        InventoryContentEvalString => '$Inventory{Name}', 
        Input => { 
            Type => 'Text', 
            Size => 50, 
            MaxLength => 100, 
        }, 
        CountMax => 1000, 
        Sub => [ 
            { 
                Key => 'Version', 
                Name => 'Version', 
                InventoryContentXPath => 'SW/.*?/Version', 
                Input => { 
                    Type => 'Text', 
                    Size => 20, 
                    MaxLength => 20, 
                }, 
            }, 
            { 
                Key => 'SoftwareVendor', 
                Name => 'Vendor', 
                InventoryContentXPath => 'SW/.*?/Producer', 
                Input => { 
                    Type => 'Text', 
                    Size => 50, 
                    MaxLength => 255, 
                }, 
            }, 
        ], 
    }, 
    { 
        Key => 'OtherEquipment', 
        Name => 'Other Equipment', 
        Input => { 
            Type => 'TextArea', 
        }, 
        CountMin => 0, 
        CountDefault => 0, 
    }, 
    { 
        Key => 'WarrantyExpirationDate', 
        Name => 'Warranty Expiration Date', 
        Searchable => 1, 
        Input => { 
            Type => 'Date', 
        }, 
    }, 
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    { 
        Key => 'InstallDate', 
        Name => 'Install Date', 
        Searchable => 1, 
        Input => { 
            Type => 'Date', 
        }, 
        CountMin => 0, 
        CountDefault => 0, 
    }, 
    { 
        Key => 'Note', 
        Name => 'Note', 
        Searchable => 1, 
        Input => { 
            Type => 'TextArea', 
        }, 
        CountMin => 0, 
        CountDefault => 0, 
    }, 
];
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4 Zusatzmodul Inventarisierung DB Backend
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4.1 Installation DB Backend

4.1.1 Voraussetzungen
KIX Professional 17 - aktuelle Version
Eine externe Datenbank mit Inventory-Daten organisiert in einer Tabellenmatrix, siehe unten folgende 
Abbildung

 

 

 

 
 
Dieses Bild ist nur ein Schema-Beispiel, um Ihnen zu zeigen, wie die Daten organisiert werden müssen, um 
mit diesem "DB"-Backend arbeiten zu können. Sie können so viele Tabellen mit so vielen Attributen haben, 
wie Sie möchten. Sie müssen aber immer einen foreign key (Fremdschlüssel) zu der Tabelle mit allen 
Objekten (bspw. Server, Mobile Devices,...) haben. Diese so genannte "object table" ist die primäre Objektliste 
für InventorySync und darf nur eine Reihe pro Objekt enthalten. Alle anderen Tabllen enthalten die 
spezifischen Objektdaten.

4.1.2 Installation
Installieren Sie das Paket "kixpro-inventorysync-db" mit der "Paketverwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile.
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4.2 Konfiguration DB Backend
Das Paket beinhaltet eine Beispielkonfiguration, die Sie nach Ihren Bedürfnissen anpassen können. Um die 
Einstellungen für diese Funktion zu konfigurieren, wählen Sie in der SysConfig die Gruppe "KIX Professional". 
Nachdem die Seite neu geladen wurde, wählen Sie die Untergruppe "ITSMConfigItem::InventorySync".

4.2.1 Sources
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Sources

Eine Quelle benötigt einen benannten Kommunikationspunkt. Zur Konfiguration wird ein Hash benutzt. Der 
Hash-Schlüssel ist der interne Name der Quelle. bspw. "opsisrv1". Der Hash-Wert ist der Anzeigename für 
diese Quelle, bspw. "inventory1".

Sie können mehrere Quellen für jeden externen Inventory-Server hinzufügen.

4.2.2 Source - Backend - Mapping
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Backend

Diese Einstellung definiert das zu nutzende Backend. Zur Konfiguration wird ein Hash benutzt. Der Hash- 
Schlüssel ist der Identifikator der Quelle (in unserem Beispiel "inventory1"). Der Hash-Wert muss mit "DB" 
angegeben werden, damit das Modul InventorySync das opsi-Backend für diese Datenquelle benutzt.

4.2.3 Konfiguration in Config.pm
Nur der Name (und der interne Schlüssel) einer DB-Datenquelle und ihr Mapping auf die DBBackend wird in 
der SysConfig konfiguriert. Alle anderen "komplexen" Konfigurationen für die konfigurierten DB-Datenquellen 
erfolgt in der Config.pm auf eine Art und Weise, wie sie von der Konfiguration von CustomerUser-Backends 
bekannt ist.

Für jede DB-Datenquelle, die Sie in der SysConfig für InventorySync konfiguriert haben, müssen Sie einen 
Konfigurations-Hash in der Config.pm erstellen. Hier ist ein Beispiel für eine Konfiguration unserer 
Beispieldatenquelle.

Hier wird die Konfiguration für die ConfigItem-Klasse "Computer" vorgenommen, die ihre Daten aus einer 
weiteren MySQL-Datenbank "ocsweb" auf localhost erhält. Alle Objekte (Computer) sind eindeutig in der 
Datenbanktabelle (oder View) "all_clients" enthalten und der Bezeichner für jeden Client ist das Attribut 
"HARDWARE_ID" in dieser Tabelle.

Der Name des Objekts ist im Tabellenattribut "NAME" enthalten. Das als Objektkennung benannte Attribut 
(hier "HARDWARE_ID") muss in allen anderen Tabellen/Views, aus denen das DB-Backend seine Daten 
beziehen soll, vorhanden sein (Foreign Key).
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Gemeinsame Tabellen für Software (SW) und Hardware (HW) Informationen werden so konfiguriert, wie zwei 
separate/spezielle Tabellen/Views, die verwendet werden sollen, um alle Daten zu erhalten, die für die 
Gerätetypen "PROZESSOR" und "CONTROLLER" relevant sind.

Im Abschnitt "Mapping" werden die Attribute aus den konfigurierten Tabellen/Views in die Datenstruktur 
gemappt., die für jedes Objekt angelegt wird. Daher wird die Struktur für das Attribut "InventoryContentXPath" 
in der ConfigItem-Klassen definiert.

$Self - > {
    InventorySyncDB
  } - > {
    inventory1
  } = {
    Params => {
      #
      if you want to use an external database, add the# required settings# DSN => 
'DBI:odbc:yourdsn',
        DSN => 'DBI:mysql:database=ocsweb;host=localhost',
        User => 'Test',
        Password => 'xxxxx',
        SourceCharset => 'utf-8',
        DestCharset => 'utf-8',
    },
    Classes => {
      Computer => {
        Params => {
          #
          client list and key value
          ObjectTable => 'all_clients',
            ObjectID => 'HARDWARE_ID',
            ObjectName => 'NAME', #common SW and HW tables / views# where our 
hardware / software info comes from
          HWTable => 'csweb.test_view2',
            SWTable => 'ocsweb.test_view1', #special tables to use
          for PROCESSOR / CONTROLLER mapping
          SpecialTables => {
            HW => {
              PROCESSOR => 'cpu_table',
                CONTROLLER => 'controllers',
            }
          }
        }, #the following mapping defines the structure
        for# InventoryContentXpath
        Mapping => {
          HW => {
              PROCESSOR => {
                  name => 'NAME',
                    type => 'TYPE',
                    version => 'VERSION',
                },
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•
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                serialNumber => {
                  serialnumber => 'SNR',
                },
                BIOS => {
                  description => 'DESCRIPTION',
                    name => 'NAME',
                },
                CONTROLLER => {
                  description => 'DESCRIPTION',
                    name => 'NAME',
                    type => 'CONTROLLER_TYPE',
                },
            },
            SW => {
              Software => {
                name => 'NAME',
                  version => 'VERSION',
                  descriptions => 'DESCRIPTION',
              },
            }
        }
      }
    }

4.2.4 Inventory Content XPath
Die Struktur und der Inhalt der Inventory-Daten (Hardware und Software), die vom DB-Backend 
zurückgegeben werden, wird in der "Config.pm" definiert. Der XPath hat allgemein folgende Struktur:

Hardware Xpath:

HW/<some device key>/<attribute>

Software Xpath:

SW/<configured key>/<attribute>
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5 Zusatzmodul Inventarisierung OPSI Backend
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5.1 Installation OPSI Backend

5.1.1 Vorraussetzungen
KIX Professional 17 - aktuelle Version
Ein OPSI-Server

5.1.2 Paket Installation
Installieren Sie das Paket "kixpro-inventorysync-opsi" mit der "Paketverwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile.
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5.2 Konfiguration OPSI Backend
Das Paket beinhaltet eine Beispielkonfiguration, die Sie nach Ihren Bedürfnissen anpassen können. Um die  
Einstellungen für diese Funktion zu konfigurieren, wählen Sie in der SysConfig die Gruppe "KIX Professional".  
Nachdem die Seite neu geladen wurde, wählen Sie die Untergruppe "ITSMConfigItem::InventorySync".

5.2.1 Source
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Sources

Eine Quelle benötigt einen benannten Kommunikationspunkt. Zur Konfiguration wird ein Hash benutzt. Der 
Hash-Schlüssel ist der interne Name der Quelle. bspw. "opsisrv1". Der Hash-Wert ist der Anzeigename für 
diese Quelle, bspw. "opsi server 1".  
Sie können mehrere Quellen für jeden externen Inventory-Server hinzufügen.

5.2.2 Source-Backend-Mapping
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Backend

Diese Einstellung definiert das zu nutzende Backend. Zur Konfiguration wird ein Hash benutzt. Der Hash- 
Schlüssel ist der Identifikator der Quelle (in unserem Beispiel "opsisrv1"). Der Hash-Wert muss mit "opsi" 
angegeben werden, damit das Modul InventorySync das opsi-Backend für diese Datenquelle benutzt.

5.2.3 Source-Parameter
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Parameters

In dieser Einstellung konfigurieren Sie die Parameter zur Nutzung des opsi-Backends. Alle Parameter 
müssen in der folgenden Form angegeben werden:

<parameter>=<value>, <parameter>=<value>, ...

 
 

Parameter Benötig 
t

Beschreibung

URL x Der URL zum rpc-Interface des opsi-Servers  (gewöhnlich http:// 
<host>:4447/rpc)

User x Nutzername des Datenbank-Nutzers.
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Parameter Benötig 
t

Beschreibung

Password x Passwort des Datenbank-Nutzers.

5.2.4 SSL-Verification
SysConfig-Untergruppe "ITSMConfigItem::InventorySync::opsi
SysConfig-Einstellung: InventorySync::Backend::opsi###UserAgentVerifyHostname

Mit dieser Einstellung können Sie die SSL-Zertifikatsprüfung für den konfigurierten Host ein- bzw. 
ausschalten.

5.2.5 InventoryContentXPath-Struktur
 
Die Struktur und der Inhalt der Inventory-Daten, die von opsi zurückgegeben werden (Hardware und 
Software), werden auf dem opsi-Server unter /etc/opsi/hwaudit definiert.

Der XPath für opsi hat die folgende Struktur:

Hardware XPath:

HW/<opsi device class>/<attribute>

Software XPath:

SW/<software registration key pattern>/<attribute>

 
Typische XPath für opsi können sein:

HW/PROCESSOR/name , um das Namensattribut von jeder CPU zu erhalten.
HW/HARDDISK_DRIVE/model, um das Modellattribut für jedes Festplatten-Laufwerk zu erhalten.
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5.3 Beispiel ConfigItem-Klasse
Das folgende Beispiel zeigt eine ConfigItem-Klassendefintion für die Klasse "Computer" mit einigen 
Änderungen für das opsi-Backend basierend auf Standard-Hardwarescans. Bitte beachten Sie, dass dies 
keine notwendigen Änderungen sind. Sie können Ihre eigenen Änderungen machen. Sie müssen nur 
sicherstellen, dass notwendige ConfigItem-Attribute während der Synchronisation Werte erhalten. 
Andernfalls wird eine Fehlermeldung angezeigt.

 

[ 
    {
        Key => 'Vendor',
        Name => 'Vendor',
        Searchable => 1,
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 50,
        },
    },
    {
        Key => 'Model',
        Name => 'Model',
        InventoryContentXPath => 'HW/COMPUTER_SYSTEM/model',
        Searchable => 1,
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 50,
        },
    },
    {
        Key => 'Description',
        Name => 'Description',
        Searchable => 1,
        Input => {
            Type => 'TextArea',
        },
    },
    {
        Key => 'Type',
        Name => 'Type',
        Searchable => 1,
        Input => {
            Type => 'GeneralCatalog',
            Class => 'ITSM::ConfigItem::Computer::Type',
            Translation => 1,
        },
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    },
    {
        Key => 'Owner',
        Name => 'Owner',
        Searchable => 1,
        Input => {
            Type => 'Customer',
        },
    },
    {
        Key => 'SerialNumber',
        Name => 'Serial Number',
        InventoryContentXPath => 'HW/BASE_BOARD/serialnumber',
        Searchable => 1,
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 100,
        },
    },
    {
        Key => 'Software',
        Name => 'Software',
        InventoryContentXPath => 'SW/.*?/displayName',
        InventoryContentEvalString => '$Inventory{displayVersion}',
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 100,
        },
        CountMax => 1000,
        Sub =>  [
            {
                Key => 'Version',
                Name => 'Version',
                InventoryContentXPath => 'SW/.*?/displayVersion',
                Input => {
                    Type => 'Text',
                    Size => 20,
                    MaxLength => 20,
                },
            },
        ],
    },
    {
        Key => 'CPU',
        Name => 'CPU',
        InventoryContentXPath => 'HW/PROCESSOR/name',
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 100,
        },
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        CountMax => 16,
    },
    {
        Key => 'Ram',
        Name => 'Ram',
        InventoryContentXPath => 'HW/MEMORY_MODULE/memorytype',
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 100,
        },
        CountMax => 10,
    },
    {
        Key => 'HardDisk',
        Name => 'Hard Disk',
        InventoryContentXPath => 'HW/HARDDISK_DRIVE/name',
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 100,
        },
        CountMax => 10,
        Sub =>  [ 
            {
                Key => 'Capacity',
                Name => 'Capacity',
                InventoryContentXPath => 'HW/HARDDISK_DRIVE/size',
                Input => {
                    Type => 'Text',
                    Size => 20,
                },
            },
        ],
    },
    {
        Key => 'CD-Rom',
        Name => 'CD-Rom',
        Searchable => 1,
        InventoryContentXPath => 'HW/OPTICAL_DRIVE/name',
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 100,
        },
    },
    {
        Key => 'FQDN',
        Name => 'FQDN',
        Searchable => 1,
        InventoryContentXPath => 'HW/COMPUTER_SYSTEM/name',
        Input => {
            Type => 'Text',
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            Size => 50,
            MaxLength => 100,
        },
    },
    {
        Key => 'NIC',
        Name => 'Network Adapter',
        InventoryContentXPath => 'HW/NETWORK_CONTROLLER/name',
        InventoryContentEvalString => '$Inventory{ipAddress}',
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 100,
        },
        CountMin => 0,
        CountMax => 10,
        CountDefault => 1,
        Sub =>  [ 
            {
                Key => 'IPoverDHCP',
                Name => 'IP over DHCP',
                Input => {
                    Type => 'GeneralCatalog',
                    Class => 'ITSM::ConfigItem::YesNo',
                    Translation => 1,
                },
            },
            {
                Key => 'IPAddress',
                Name => 'IP Address',
                Searchable => 1,
                InventoryContentXPath=> 'HW/NETWORK_CONTROLLER/ipAddress',
                Input => {
                    Type => 'Text',
                    Size => 40,
                    MaxLength => 40,
                },
                CountMin => 0,
                CountMax => 20,
                CountDefault => 0,
            },
        ],
    },
    {
        Key => 'GraphicAdapter',
        Name => 'Graphic Adapter',
        InventoryContentXPath => 'HW/VIDEO_CONTROLLER/name',
        InventoryContentEvalString => '$Inventory{deviceId}',
        Input => {
            Type => 'Text',
            Size => 50,
            MaxLength => 100,
        },
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    },
    {
        Key => 'OtherEquipment',
        Name => 'Other Equipment',
        Input => {
            Type => 'TextArea',
        },
        CountMin => 0,
        CountDefault => 0
     },
     {
        Key => 'WarrantyExpirationDate',
        Name => 'Warranty Expiration Date',
        Searchable => 1,
        Input => {
            Type => 'Date',
        },
    },
    {
        Key => 'InstallDate',
        Name => 'Install Date',
        Searchable => 1,
        Input => {
            Type => 'Date',
        },
        CountMin => 0,
        CountDefault => 0,
    },
    {
        Key => 'Note',
        Name => 'Note',
        Searchable => 1,
        Input => {
            Type => 'TextArea',
        },
        CountMin => 0,
        CountDefault => 0,
    },
];
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6 Zusatzmodul Inventarisierung VMWare Backend
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6.1 Installation VMWare Backend

6.1.1 Vorraussetzungen
KIX Professional 17 - aktuelle Version
Ein installiertes vSphere Perl SDK für vSphere 5.5+ auf dem KIX-Server
Einen vCenter-Nutzer mit read-only Rechten (gewöhnlich ist ein Nutzer mit der im Datacenter level 
zugewiesenen Standard "read-only"-Rolle ausreichend)

6.1.2 Paket Installation
Installieren Sie das Paket "kixpro-inventorysync-vmware" mit der "Paketverwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile.
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•
•

•

•

•

6.2 Konfiguration VMWare Backend

6.2.1 Grundlagen
Das VMWare-Backend arbeitet basierend auf Objekttypen. Jeder Objekttyp hat seinen eigenen Satz von 
Attributen und liefert die Daten, die zu den ConfigItem-Klassenattributen in der ConfigItem-Klassendefinition 
gemappt werden.

Es ist immer notwendig, einen Objekttyp zuzuordnen, entweder auf der Ebene der Datenquelle selbst oder auf 
der Ebene des ConfigItem-Klassennamen-Mappings oder basierend auf den Namen der ConfigItem-Klasse 
selbst.

Die folgenden Objekttypen sind möglich:

Datacenter
Datastore
Cluster
Host
VM

 
Beispiel:  
Wenn Sie eine ConfigItem-Klasse mit dem Namen "VMWare-Servers" haben, müssen Sie den Objekttyp 
zuordnen, weil dies die Daten für ein VMWare-Hostsystem bereit stellt.

Möglichkeit 1: Auf der Ebene der Datenquelle

Definieren Sie eine Datenquelle und fügen Sie ";ObjectType=Host" an das Ende der Parameterzeile in der 
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Parameters.

Möglichkeit 2: Definieren eines Klassennamen-Mapping

Erzeugen Sie ein ConfigItem-Klassenmapping, wo der Schlüssel "VMWare-Servers" lautet und der Wert den 
Objekttyp definiert.

SysConfig-Einstellung: InventorySync::Backend::VMWare###CIClassObjectTypeMapping .

Möglichkeit 2: Die ConfigItem-Klasse umbenennnen

Wenn Sie nicht die Möglichkeit 1 oder 2 nutzen möchten, bleibt noch die Möglichkeit, die ConfigItem-Klasse 
von "VMWare-Servers" umzubenennen in "Host". In diesem Fall repräsentiert der Name der ConfigItem-Klasse 
den zu nutzenden Objekttyp.
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•

•

•

6.2.2 SysConfig-Optionen
Um die Einstellungen für diese Funktion zu konfigurieren, wählen Sie in der SysConfig die Gruppe "KIX 
Professional". Nachdem die Seite neu geladen wurde, wählen Sie die Untergruppe "ITSMConfigItem:: 
InventorySync".

6.2.3 Source
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Sources

Eine Quelle benötigt einen benannten Kommunikationspunkt. Zur Konfiguration wird ein Hash benutzt. Der 
Hash-Schlüssel ist der interne Name der Quelle. bspw. "VMWare". Der Hash-Wert ist der Anzeigename für 
diese Quelle, bspw. "my VMWare environment". Sie können mehrere Quellen für jeden externen Inventory- 
Server hinzufügen.

6.2.4 Source-Backend-Mapping
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Backend

Diese Einstellung definiert das zu nutzende Backend. Zur Konfiguration wird ein Hash benutzt. Der Hash- 
Schlüssel ist der Identifikator der Quelle (in unserem Beispiel "VMWare"). Der Hash-Wert muss mit "VMWare" 
angegeben werden, damit das Modul InventorySync das VMWare-Backend für diese Datenquelle benutzt.

6.2.5 Source-Parameter
SysConfig-Einstellung: ITSMConfigItem::InventorySync###Parameters

In dieser Einstellung konfigurieren Sie die Parameter zur Nutzung des VMWare-Backends. Alle Parameter 
müssen in der folgenden Form angegeben werden:

<parameter>=<value>;<value>;...

 

Parameter Benötigt Beschreibung

URL x Der URL zum WebService-Interface des vCenter servers 
(gewöhnlich http://<host>:443/sdk/webService)

User x Nutzername des Datenbank-Nutzers.

Password x Passwort des Datenbank-Nutzers.
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•
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•
•

•

•
•
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•
•

ObjectType

 

 

 

 

 

Optionaler Parameter, um die Datenquelle bezüglich 
eines speziellen Objekttyps einzuschränken. Mögliche 
Werte sind:

Datacenter
Datastore
Cluster
Host
VM

6.2.6 Alternatives ObjectType mapping
SysConfig-Einstellung: InventorySync::Backend::VMWare###CIClassObjectTypeMapping

 
Diese Einstellung finden Sie in der Untergruppe "ITSM::ConfigItem::InventorySync::VMWare". Wenn in der 
Datenquelle selbst keine Restriktionen bezüglich eines bestimmenten Objekttyps konfiguriert sind, können 
Sie hier den zu nutzenden Objekttyp für jede ConfigItem-Klasse zuordnen. Der Schlüssel des Hashs 
repräsentiert den Name der ConfigItem-Klasse und der Wert repräsentiert den Objekttyp. Folgende 
Objekttypen sind möglich:

Datacenter
Datastore
Cluster
Host
VM

 

6.2.7 ObjectType Fallback
Wenn weder die Datenquelle auf einen bestimmten Objekttyp beschränkt wurde, noch ein klassenbasiertes 
Mapping existiert, wird der Name der CI-Klasse vom System zur Bestimmung des Objekttyps verwendet.
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•
•

•
•

6.2.8 SSL Verification
SysConfig-Untergruppe "ITSMConfigItem::InventorySync::opsi  

SysConfig-Einstellung: InventorySync::Backend::VMWare###UserAgentVerifyHostname

 
Mit dieser Einstellung können Sie die SSL-Zertifikatsprüfung für den konfigurierten Host ein- bzw. 
ausschalten.

6.2.9 InventoryContentXPath-Struktur
Die Erweiterung von ConfigItem-Klassen und die Nutzung der InventoryContentXPath Parameter werden im 
Kapitel "KIX SysConfig/KIX Professional/InventorySync" beschrieben.

Der XPath für VMWare hat die folgende Struktur:

Hardware XPath: HW/<Container>/<Attribute>
Software XPath: Derzeit existiert kein Software XPath 

 
Welche Attribute und Container verfügbar sind, hängt von den Rechten des Nutzers ab, den Sie zur 
Verbindung zum vCenter-Server benutzen. Weiterhin hängt es ab vom Status der übereinstimmenden 
Objekte. Es werden nicht immer alle dieser Attribute verfügbar sein.

Gewöhnlich sind die folgenden Attribute verfügbar:

ObjectType Container Attribute

Datacenter 
 
 
 
 
 
 
 
 
 

Info 
 
 
 
 
 
 

configStatus

numVMDKs

numHosts

numClusters

numDatastores

numVMs

overallStatus

Clusters name

Datastores name
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ObjectType Container Attribute

Host name

Network name

Datastore 
 
 
 
 
 
 
 

Info 
 
 
 
 
 
 
 

 LUN

build

capacity

capacityGB

capacityKB

capacityMB

freeSpace

freeSpaceGB

freeSpaceKB

freeSpaceMB

instanceUuid

isSSD

numHosts

numVMs

type

url

version

vmfsVersion
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ObjectType Container Attribute

Hosts name

VMs name
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ObjectType Container Attribute

Cluster 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Info 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

actionHistory
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ObjectType Container Attribute

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

alarmActionsEnabled

apiType

apiVersion

build

configStatus

disableMethod

effectiveCpuGhz

effectiveCpuMhz

effectiveMemory

effectiveMemory

effectiveMemoryGB

effectiveMemoryKB

effectiveMemoryMB

fullName

hBDatastoreCandidatePolicy

instanceUuid

licenseProductName

licenseProductVersion

localeBuild

localeVersion

name
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ObjectType Container Attribute

numCpuCores

numCpuThreads

numDatastores

numEffectiveHosts

numHosts

numVMs

osType

overallStatus

productLineId

resourcePool

totalCpuGhz

totalCpuMhz

totalMemory

totalMemoryKB

totalMemoryMB

totalMemoryGB

vendor

version
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ObjectType Container Attribute

HA 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

admissionControl

configuredFailoverCapacity

dasConfig

dasIsolationAddress

defaultVmSettings.dasIsolationResponse

defaultVmSettings.restartPriority

defaultVmSettings.vmToolsMonitoringSettings

defaultVmSettings.vmToolsMonitoringSettings.clusterS 
ettings

defaultVmSettings.vmToolsMonitoringSettings.failureInt 
erval

defaultVmSettings.vmToolsMonitoringSettings.maxFailu 
reWindow

defaultVmSettings.vmToolsMonitoringSettings.maxFailu 
res

defaultVmSettings.vmToolsMonitoringSettings.minUpTi 
me

defaultVmSettings.vmToolsMonitoringSettings.vmMonit 
oring

failover.Level

hostMonitoring

status

vmMonitoring
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ObjectType Container Attribute

DRS defaultVmBehavior

 status

Datastores extent.diskName

 extent.partition

 name

 url

Hosts name

VMs name

Hosts Info bootTime

build

cluster

datacenter

DNS.dhcp

DNS.hostname

DNS.nameserver

DNS.searchDomains

defaultGateway

cpuMhz

cpuGhz

cpuModel

datacenter
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ObjectType Container Attribute

fullname

hostMaxVirtualDiskCapacity

hostMaxVirtualDiskCapacityKB

hostMaxVirtualDiskCapacityMB

hostMaxVirtualDiskCapacityGB

licenseProductName

memorySizeGB

memorySizeKB

memorySizeMB

model

name

numCpuCores

num CpuPkgs

numCpuThreads

numDatastores

numHBAs

numNICs

numVMs

port

powerState

uptime
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ObjectType Container Attribute

uuid

vendor

version

vmotion.ipAdress

vmotion.subnetMask

vSwitches

 

 

 

 

 

 

 

mtu

name

numPorts

numPortsAvailable

portgroup.name

portgroup.usedPorts

portgroup.vlanId

usedPorts
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ObjectType Container Attribute

NICs

 

 

 

 

 

 

 

 

 

autoNegotiateSupported

dhcp

driver

duplex

ipAdress

macAdress

name

pci

resourcePoolSchedulerAllowed

speedMb

subnetMask

wakeOnLanSupported

VMs name
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ObjectType Container Attribute

VM 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Info 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

cluster

faultToleranceState

guestId

guestMemoryUsage

guestMemoryUsageKB

guestMemoryUsageMB

guestMemoryUsageGB

guestOS

host

hostMemoryUsage

hostMemoryUsageKB

hostMemoryUsageMB

hostMemoryUsageGB

host

instanceUuid

ipAddress

isTemplate

memorySize
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ObjectType Container Attribute

memorySizeKB

memorySizeMB

memorySizeGB

name

numCPU

numEthernetCards

numVirtualDisks

overallStatus

resourcePool

storageFree

storageFreeKB

storageFreeMB

storageFreeGB

storageTotal

storageTotalKB

storageTotalMB

storageTotalGB

storageUsed
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ObjectType Container Attribute

storageUsedKB

storageUsedMB

storageUsedGB

toolsStatus

uptime

vmPathName

vmState

CDRoms

 

label

summary

Datastores name

VDisks

 

backingObjectId

capacity

capacityKB

capacityMB

capacityGB

datastore

diskMode

filename
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ObjectType Container Attribute

label

size

type

uuid

writeTrough

VNICs ipAddress

label

macAdress

network

Snapshots createTime

description

name

quiesced

state

 

Hinweis

Bitte beachten: Die vCenter API definiert Virtual Machine Templates ebenfalls als Virtual Machine 
Objects. Ob eine VM ein Template ist oder nicht, können Sie feststellen, wenn Sie auf das Attribut 
"isTemplate" schauen.
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6.2.10 Beispiel ConfigItem-Klassen für das VMWare-Backend
Das Paket enthält Beispiel ConfigItem-Klassendefinitionen für alle Objekttypen. Diese Beispiele finden Sie im 
Verzeichnis:

/opt/kix/var/packagesetup/InventorySyncVMWareBackend

 

  
Diese Beispiele nutzen das ConfigItem-Attribut "CICReference", das bereits in KIX enthalten ist. Es ist sehr 
hilfreich, um automatisch Links zwischen verschiedenen ConfigItems zu erzeugen.  
Um die Vorteile dieser Konfigurationsbeispiele voll nutzen zu können, sollten Sie zunächst importieren und 
anschließend synchronisieren, damit alle Objekte im Synchronisationsprozess bereits verfügbar sind und 
somit verknüpft werden können.

Hinweis

Bitte beachten Sie, dass dies nur Beispiele sind, die alle verfügbaren Attribute enthalten, inklusive 
einiger Attribute mit Nutzungswerten (bspw. aktueller Speicher oder Prozessorauslastung) oder 
verschiedener Einheiten (kB,MB,GB,Mhz, Ghz,...) . Sie können diese Definitionen nach Ihren 
Wünschen anpassen.
Wichtig: Bitte beachten Sie, dass gemappte Nutzungswerte gewöhnlich eine neue Version eines 
ConfigItem erzeugen, weil sie häufigen Änderungen unterliegen. Sie sollten sie aus Ihrer ConfigItem- 
Klassendefinition entfernen, wenn diese Werte in Ihrer CMDB nicht von Interesse sind.
Sie müssen ebenfalls sicherstellen, dass zwingend erforderliche ConfigItem-Attribute während des 
Synchronisationsprozesses Werte erhalten. Andernfalls wird durch KIX Professional eine 
Fehlermeldung angezeigt, weil die Attribute keinen Wert haben.
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7 Zusatzmodul ITSM-Standard Workflows
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•

7.1 Installation Zusatzmodul ITSM-Standard Workflows

7.1.1  Voraussetzungen
KIX Professional 17 - aktuelle Version

7.1.2 Paket Installation
Installieren Sie das Paket "KIXITSMTicketStatusWorkflows" mit der "Paket-Verwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile. 
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7.2 Tickettypen
Ziel ist die Abbildung von Tickettyp-spezifischen Statusworkflows. Für jeden Tickettyp existieren passende 
Status und mögliche Statusübergänge – sowohl automatisch als auch manuell. Die Grundfunktion des 
Ticketstatus wird von KIX zur Verfügung gestellt. Im Erweiterungspaket wurden die entsprechenden 
Konfigurationen angepasst.  
 
Außerdem wurden zusätzliche, in KIX nicht vorhandene, TicketStateWorkflow-ACLs und Ticket-Events 
erstellt. Alle noch nicht vorhandenen/deaktivierten Ticketstatus und Tickettypen werden bei der 
Paketinstallation angelegt/aktiviert. Alle nicht relevanten oder obsoleten Tickettypen sind dabei deaktiviert / 
umbenannt und stehen nicht mehr zur Auswahl.  
 

7.2.1 Relevante Ticketstatus

Statusname Statustyp Statusname (DE)

closed with workaround closed geschlossen mit Workaround

done by forwarding closed erledigt durch Weiterleitung

finally closed closed geschlossen

insoluble closed nicht lösbar

non-reproductible closed nicht reproduzierbar

rejected closed abgelehnt

canceled closed abgebrochen

solved closed gelöst

solved at once closed sofort gelöst

solved by change 
implementation

closed gelöst durch Umsetzung eines Change
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new new neu

problem candidate new Problemkandidat

accepted open akzeptiert

processing open in Bearbeitung

re-activated open reaktiviert

workaround documented open Workaround dokumentiert

review open in Nachkontrolle

pending final closure pending auto warten auf finalen Abschluss

waiting for customer pending auto warten auf Kundenrückmeldung

waiting for external supplier pending auto warten auf Rückmeldung eines externen 
Dienstleisters

pending reminder pendig reminder warten auf Erinnerung

pending for change 
implementation

pending reminder warten auf Umsetzung eines Change
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7.2.1.1 Workflow "Incident" + "Incident::Disaster"
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7.2.1.2 Workflow "Service Request" + "Information Request"
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7.2.1.3 Workflow "Problem"
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7.2.1.4 Workflow "RfC::Standard"

7.2.2 Speicherung des Abschlusscodes
Bei Erreichen eines Ticketstatus vom Typ „closed" („geschlossen") wird dieser als Abschlusscode in ein 
dynamisches Feld geschrieben. Der Status „finally closed" ist von diesem Automatismus ausgenommen. 
Welches dynamische Feld für die Verwendung des Abschlusscodes verwendet wird ist konfigurierbar.

 
Beispiel:  
Erweiterung der Einstellung: "Ticket::Frontend::AgentTicketZoom###TicketDataKeys"  
mit "Schlüssel" = 2000 und Wert = "CallMethod::TicketObject::GetClosureCodeTranslated"

 
Erweiterung der Einstellung: "Ticket::Frontend::AgentTicketZoom###TicketDataLabel"  
mit "Schlüssel " = "CallMethod::TicketObject::GetClosureCodeTranslated" und Wert = ClosureCode

Bitte beachten: Der Abschlusscode wird ohne Übersetzung in der Ticketansicht angezeigt, so wie er 
gespeichert wurde.  
Wenn eine Übersetzung gewünscht ist, kann eine sog. CallMethod für die Ticketansicht in der 
SysConfig konfiguriert werden.





KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul ITSM-Standard Workflows

Tickettypen

Erstellt am: 19.01.2022                                                                   Seite 95
 

 

7.2.3 Ticketaktion "Workaround erfassen"
Diese Ticketaktion erscheint nur bei Tickettyp "Problem" im spezifischen Status (siehe Konfiguration für 
Match::ExcludedAction::HideWorkaroundNote) und ermöglicht das Anlegen eines Artikels analog zur Funktion 
"Notiz" mit dem Unterschied des zugeordneten Artikeltyps und einer separaten Ticketaktion. Die Artikeltypen 
"Workaround (extern)" / "Workaround (intern)" kennzeichnen Notizen/Artikel, in den ein Workaround 
beschrieben ist.

 
Des Weiteren wird dieser Artikel an verknüpfte Kindtickets eines konfigurierbaren Tickettypes weitergegeben. 
Der weitergegebene Artikel erhält dabei den Typ einer internen Notiz. Auf diese Weise werden Workarounds, 
die in einem Problemticket erarbeitet werden, an verbundene Störungstickets weitergegeben.

7.2.4 Ticketaktion "Schließen"
Diese Ticketfunktion wird nur angezeigt wenn dem aktuellem Ticketstatus ein Folgestatus vom Typ 
„Geschlossen" (closed) zugeordnet ist. Dies ist im jeweiligen Ticketstatus-Workflow definiert.
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7.3 Konfiguration von ITSM-Standard Workflows

Schlüsselname Erklärung

Ticket::Acl::Module###950_TicketStateWorkflow Ticket-ACLs zur Definition der möglichen 
Folgestatus.

TicketStateWorkflow Einstellungen für den Ticketstatusworkflow, zur 
Definition der möglichen Folgestatus. Status 
werden komma-separiert aufgelistet. Als 
Platzhalter dienen ANY , PREVIOUS und NONE.

TicketStateWorkflow::FallbackForPreviousState Ticketstatus der benutzt wird, falls "PREVIOUS" 
nicht bestimmte werden konnte.

TicketStateWorkflow::DefaultTicketState Einstellungen für den DefaultTicketstatus, zur 
Definition der möglichen Folgestatus. Status 
werden komma-separiert aufgelistet. Als 
Platzhalter dienen ANY , PREVIOUS und NONE.

Ticket::CreateOptions::DefaultTicketType Vorausgewählter Tickettyp in AgentTIcketPhone 
und AgentTicketEmail

Ticket::EventModulePost###1- 
ForceStateChangeOnLock

Ticket Event Modul für automatisches Setzen eines 
neuen Ticketstatus, nachdem das Ticket gesperrt 
wurde. Der Schlüssel ist der Tickettyp + ":::" + 
aktueller Status, der Inhalt ist der Status nach dem 
Sperren.

Ticket::EventModulePost###700- 
TicketStateWorkflowTypeUpdate

Aktualisiert Ticketstatus, sofern konfiguriert oder 
notwendig, nach Änderung des Tickettyps.

TicketStateWorkflow::PostmasterFollowUpState Status für ein Ticket, für das ein Follow-up eintrifft 
(nutzen Sie PREVIOUS als Platzhalter für den 
letzten Status in der Tickethistorie vor dem 
aktuellen).

Ticket::PendingAutoStateType Definiert mögliche Statustypen für Pendng-Tickets.
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Schlüsselname Erklärung

TicketStateWorkflow::PostmasterFollowUpCheckC 
ustomerIDFrom

Prüft, ob der Absender einer Nachricht als 
Kundennutzer vorhanden ist und dieselbe Kunden- 
ID hat, wie am Ticket hinterlegt ist. Ist dem so, wird 
die Email als "email-external" betrachtet, 
andernfalls als "email-internal". Standard Verhalten, 
wenn deaktiviert.

TicketStateWorkflowPostmasterFollowUpCheckAg 
entFrom

Überprüft, ob der Sender als Agent in der 
Datenbank gespeichert ist, und wenn ja, setzt den 
Sendertyp auf „Agent".

Ticket::EventModulePost###701- 
TicketStateWorkflowAutomaticStateAction

Führt Ticketaktionen nach Statusaktualisierung 
durch - derzeit beschränkt auf Status- oder 
Queuewechsel.

TicketStateWorkflowAutomaticStateAction###Nex 
tStateSet

Ermöglicht das automatische Setzen von Status 
bei Erreichen eines anderen Status.

TicketStateWorkflowAutomaticStateAction###Nex 
tStatePendingOffset

Wenn der automatisch gesetzte Status vom Typ 
„warten" ist, wird die hier konfigurierte Zeit als 
Wartezeit benutzt.

Ticket::StateAfterPending Definiert, welcher Status gesetzt werden soll, 
nachdem die Wartezeit erreicht wurde.

Ticket::Type Aktivieren des Tickettyp-Features

Ticket::Frontend::AgentTicket*###StateType Mögliche Statustypen bei bestimmten Ticket- 
Aktionen

Ticket::EventModulePost###650- 
TicketWriteClosureCodeToDynamicField

De-/Aktiviert Eventhandler zur Hinterlegung des 
Abschlusscodes in einem dynamischen Feld

TicketWriteClosureCodeToDynamicField###Dyna 
micField

Definiert, welches dynamische Feld für die 
Hinterlegung des Abschlusscodes verwendet 
werden soll (Default ist "ClosureCode")

TicketWriteClosureCodeToDynamicField###NoClo 
sureStates

Definiert, welche Status vom Typ "close" nicht als 
Abschlusscode für die Speicherung in das 
dynamische Feld betrachtet werden soll.
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Schlüsselname Erklärung

Ticket::EventModulePost###800- 
ProblemWorkaroundNote

Workflow-Modul, welches Workaroundartikel und 
Aktualisierung des Ticketstatus von Problem- 
Tickets an verknüpfte Tickets weiterleitet.

 
Parameter:

Event: auslösendes Ticketevent
LinkType: zu verfolgender Verknüpfungstyp
LinkDirection: zu verfolgende 
Verknüpfungsrichtung
TargetTicketType: Tickettypen an die die 
Weitergabe des Artikel erfolgen soll
TriggerTicketType: Tickettyp für den diese 
Aktion ausgeführt wird
TriggerArticleType: Artikeltyp für den diese 
Aktion ausgeführt wird
TriggerTicketNewState: Status des Problem- 
Tickets nach der Anlage eines Workarounds

Frontend::Module###AgentTicketNoteWorkaround 
External

Frontend-Modul Registrierung für die Ticket-Aktion 
"AgentTicketNoteWorkaroundExternal" im Agenten- 
Interface

Ticket::Frontend::MenuModule### 420-Note- 
Workaround-External

Anzeige Ticketaktion für eine Workaroundnotiz in 
der Ticketvorschau

Ticket::Frontend::AgentTicketNoteWorkaroundExte 
rnal###

Alle für die Maske 
"AgentTicketNoteWorkaroundExternal" notwendigen 
Konfigurationen, wie z.B. Eingabe Notiz-Feld, 
Artikeltyp, Statusupdate, Besitzerwechsel, etc. 
sofern diese notwendig sind.

Relevante Parameter:

ArticleTypes
Note
State and StateDefault
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Schlüsselname Erklärung

Ticket::Frontend::AgentTicketNotWorkaroundExter 
nal::KIXSidebarBackend

De-/Aktivierung von Textbausteine, Kunden-Info, 
Verlinkte Personen für die Maske 
"AgentTicketNoteWorkaroundExternal"

Ticket::ArticleTypeIcon Definiert, welche Icons für bestimmte Artikeltypen 
verwendet werden.

Ticket::Acl::Module###803- 
MatchActionRestrictions

Ticket-ACL, um basierend auf Ticketdaten 
bestimmte Ticketaktionen zu deaktivieren.

Match::ExcludedAction::HideWorkaroundNote Definiert, unter welchen Bedingungen die 
Ticketaktion "Workaround erfassen" NICHT 
sichtbar ist. Im Schlüssel sind die Ticket- 
Eigenschaften enthalten, bei denen die Aktion nicht 
möglich sein soll.

Ticket::Acl::Module###880-HideAgentTicketClose Ticket-ACL um Funktionen "Schließen" auf Basis 
des aktuellen Ticketstatus einzuschränken.
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8 Zusatzmodul Kanban Board
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8.1 Installation Zusatzmodul Kanban Board

8.1.1 Vorraussetzungen
KIX Professional 17 - aktuelle Version

8.1.2 Paket Installation
Installieren Sie das Paket "Kanban-Board" mit der "Paketverwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile.

8.1.3 Neue Gruppen
Während der Installation werden zwei neue Gruppen erzeugt. Die Gruppe "kanbanview" ermöglicht den Zugriff 
auf das Kanban-Board und die Konfiguration des Kanban-Boards. Mit Nur-Lesen-Rechten (ro) kann das 
Kanban-Board angeschaut werden. Mit Schreiben-Recht (rw) können die Tickets im Kanban-Board bewegt 
werden.  
Die Gruppe "kanbanview_dispatchSidebar" ermöglicht Zugriff auf das Widget "Verteilbare Tickets". Der Initial- 
Benutzer (Standard: root@localhost) hat automatisch Schreibrechte für beide Gruppen.

8.1.4 Neue Tabellen
Während der Installation werden zwei neue Tabellen erzeugt. Die Tabelle "kanban4kix_shared_sets" 
beinhaltet alle Sichten, die Benutzer mit anderen Agenten teilen. Die Tabelle "kanban4kix_subscribed_sets" 
beinhaltet die Sicht-Abonnements.
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8.2 Konfiguration Zusatzmodul Kanban Board
Wenn Sie das Paket installiert haben, können Sie bei Bedarf im Admin-Bereich/SysConfig die Standardwerte 
einstellen. Wählen Sie dazu die SysConfig-Gruppe "Kanban4KIX".

Nachdem die Seite neu geladen wurde, wählen Sie eine der Untergruppen "Frontend::Agent::KanbanView" 
oder "Frontend::Agent:: AgentKanbanActionCommonPopup".

Eine Standard-Konfiguration ist bereits im Paket enthalten. Sie können diese nach ihren Wünschen 
anpassen. In den folgenden Abschnitten werden die SysConfig-Einstellungen erklärt.

 

Widget "Verteilbare Tickets" in der Kanban-Seitenleiste (siehe Seite 103) 

Normalisierung der Spaltenbreiten (siehe Seite 103) 

Ticket-Attribute im Kopfbereich einer Ticket-Karte (siehe Seite 103) 

Ticket-Attribute im Inhaltsbereich einer Ticket-Karte (siehe Seite 103) 

Dynamische Links für Ticket-Attribute (siehe Seite 104) 

Dummy Attributes (siehe Seite 104) 

Fortschrittsbalken für Ticket-Attribute (siehe Seite 105) 

Meta Status als Spalten (siehe Seite 105) 

Farben der Tickettypen (siehe Seite 105) 

Tickettyp-spezifische CSS-Klassen (siehe Seite 105) 

Dynamische Felder als Swimlane-Attribute (siehe Seite 106) 

Anzahl der Tickets im Kanban-Board (siehe Seite 106) 

Zugriff auf das "Änderungs"-Popup (siehe Seite 106) 

Einstellen der benötigten Sperre (siehe Seite 106) 

Anzeigen des "Incident State" des Ticketservices (siehe Seite 108) 

Ändern verschiedener Ticketattribute und Dynamische Felder beim Verschieben eines Tickets im 
Kanban-Board (siehe Seite 108) 

Nächste mögliche Statustypen (siehe Seite 110) 

Hinzufügen einer Notiz beim Verschieben eines Tickets im Kanban-Board (siehe Seite 110) 

Notizfeld als Pflichtfeld (siehe Seite 110) 

Standardwerte für Notizüberschrift und Notizinhalt (siehe Seite 110) 

Größe des Notiz-Eingabefeldes (siehe Seite 111) 

Standard Artikeltyp (siehe Seite 111) 

Mögliche Artikeltypen (siehe Seite 111) 

Historie-Typ (siehe Seite 111) 

Historie-Kommentar (siehe Seite 112) 
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8.2.1 Widget "Verteilbare Tickets" in der Kanban-Seitenleiste
SysConfig-Einstellung: Frontend::KanbanSidebarBackend###Dispatch

Diese Einstellung aktiviert das Widget "Verteilbare Tickets" in der Kanban-Seitenleiste. Mit dem Schlüssel 
"Group" können Sie festlegen, in welcher Gruppe ein Benutzer sein muss, um das Widget zu nutzen. Um die 
verteilbaren Tickets im Widget anzuzeigen, muss der Benutzer ebenfalls Rechte für das Popup haben, dass 
beim Verschieben von Tickets erscheint. (Schlüssel: "Frontend:: 
Module###AgentKanbanActionCommonPopup").  
 

8.2.2 Normalisierung der Spaltenbreiten
SysConfig-Einstellung: AgentKanbanView::NormalizeColWidth

Diese Einstellung legt fest, ob die Spalten die gleiche Breite haben sollen.  
 

8.2.3 Ticket-Attribute im Kopfbereich einer Ticket-Karte
SysConfig-Einstellung: AgentKanbanView::CardContent::HeadArea

Diese Einstellung legt fest, welche und in welcher Reihenfolge die Ticket-Attribute im Kopf eines Tickets im 
Kanban-Board sichtbar sind. Die Zahl bei "Schlüssel" legt die Reihenfolge fest. Der Wert bei "Inhalt" ist die 
darzustellende Information, bspw. "Queues". Dynamische Felder müssen im Stil "DynamicField*"_ angegeben 
werden.

 

8.2.4 Ticket-Attribute im Inhaltsbereich einer Ticket-Karte
SysConfig-Einstellung: AgentKanbanView::CardContent::ContentArea

Diese Einstellung legt fest, welche und in welcher Reihenfolge Ticket-Attribute im Inhaltsbereich eines 
Tickets (in Ticketdarstellung "L") im Kanban-Board sichtbar sind. Die Zahl bei "Schlüssel" legt die Reihenfolge 
fest. Der Wert bei "Inhalt" ist die darzustellende Information, bspw. "Owner". Dynamische Felder müssen im 
Stil "DynamicField*"_ angegeben werden.

 

Bitte beachten: Der Standardwert für "Group" ist "kanbanview_dispatchSidebar".

Bitte beachten: Diese Einstellung ist notwendig und der Standardwert ist "Nein".
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8.2.5 Dynamische Links für Ticket-Attribute
SysConfig-Einstellung: AgentKanbanView::CardContent::AttributeAsLink

Mit dieser Einstellung können Sie einen spezifischen Link für die Ticket-Attribute im Kopf und im 
Inhaltsbereich einer Ticket-Karte definieren. Zum Beispiel um das relevante Ticket zu öffnen:

"index.pl?Action=AgentTicketZoom;TicketID=" 

 
<TICKET_*> für Ticket-Attribute

<CONFIG_*> für SysConfig Optionen

<ENV_*> für Umgebungsvariablen.

Externe Links benötigen das Protokoll, z.B. http://www.somesite.com

 

8.2.6 Dummy Attributes
SysConfig-Einstellung: AgentKanbanView::CardContent::DummyAttribute

Mit dieser Einstellung können Sie ein Dummy-Attribut definieren, bspw. für Ticket-unabhängige Links. 
"Schlüssel" ist der Dummy-Bezeichner und "Inhalt" der sichtbare Text auf der Ticket-Karte. Der relevante 
Dummy-Schlüssel muss in "AgentKanbanView::CardContent::HeadArea" oder 
"AgentKanbanView::CardContent::ContentArea" benutzt werden, um sichtbar zu sein.

 

http://www.somesite.com
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8.2.7 Fortschrittsbalken für Ticket-Attribute
SysConfig-Einstellung: AgentKanbanView::CardContent::ProgressBar

Mit dieser Einstellung können Sie zusätzliche Ticket-Attribute angeben, die als Fortschrittsbalken im 
Inhaltsbereich einer Ticket-Karte dargestellt werden. Die Zahl bei "Schlüssel" legt die Reihenfolge fest. Der 
Wert bei "Inhalt" ist die darzustellende Information.

 

8.2.8 Meta Status als Spalten
SysConfig-Einstellung: AgentKanbanView::TicketMetaStates

Mit dieser Einstellung können Sie die Spalten und ihre zugehörigen Status definieren. Die Status sind nur eine 
Vorgabe, sie werden ggf. durch persönliche Einstellungen in der Kanban-Konfiguration ersetzt. Alle Status 
sollten existieren und werden durch Komma (ohne zusätzlichem Leerzeichen) getrennt. Ein einmal 
vergebener Status kann nur in jeweils einer Spalte sein, nicht in mehreren (das erste Auftauchen zählt).

 

8.2.9 Farben der Tickettypen
SysConfig-Einstellung: AgentKanbanView::TicketType::Colors

Mit dieser Einstellung können Sie die Farben für die Tickettypen festlegen. Diese Einstellung überschreibt die 
Farbdeklarationen der CSS-Klasse "AgentKanbanView::TicketType:CSSClass".

 

8.2.10 Tickettyp-spezifische CSS-Klassen
SysConfig-Einstellung: AgentKanbanView::TicketType::CSSClass

Mit dieser Einstellung können Sie eine CSS-Klasse für einen spezifischen Tickettyp konfigurieren. Die 
Farbdeklarationen werden durch "AgentKanbanView:TicketType:Colors" überschrieben.

 

Bitte beachten: Diese Einstellung ist notwendig.

Bitte beachten: Diese Einstellung ist notwendig.
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8.2.11 Dynamische Felder als Swimlane-Attribute
SysConfig-Einstellung: AgentKanbanView::DynamicFieldsAsSwimlanes

Mit dieser Einstellung können Sie dynamische Felder als weitere Swimlanes (Zeilen) im Kanban-Board 
festlegen. Dynamische Felder vom Typ: "Artikel" / "Datum" / "Zeit" / "Mehrfachauswahl" und "Textfeld" können 
nicht verwendet werden.

 

Es ist möglich, das Kanban Board nach referenzierten ConfigItems in einer Swimlanes abzubilden. Sie 
müssen dafür bei der Verwendung eines DynamicFields vom Typ "ITSMConfigItemReference" als Swimlane  

die Swimlanes mit den Anzeigewerten des DynamicFields beschriften
die Tickets entsprechend der Zuordnung im DynamicField einordnen

 

8.2.12 Anzahl der Tickets im Kanban-Board
SysConfig-Einstellung: AgentKanbanView::SearchLimit

Diese Einstellung legt fest, wie viele Tickets maximal in den Listen (Sidebar und Tickettyp-Gruppen) und als 
Kanban-Tickets im Kanban-Board angezeigt werden.

 

8.2.13 Zugriff auf das "Änderungs"-Popup
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###Permission

Diese Einstellung legt fest, welche Rechte benötigt werden, um Änderungen in den konfigurierten 
Ticketattributen vorzunehmen, wenn das Ticket im Kanban-Board verschoben wird.

 

8.2.14 Einstellen der benötigten Sperre
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###RequiredLock

Bitte beachten: Diese Angabe ist notwendig. Es sind nur Zahlen als Wert möglich.

Bitte beachten: Diese Einstellung ist notwendig.
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Diese Einstellung legt fest, ob ein Ticket gesperrt sein muss, um das "Änderungs"-Popup nutzen zu können. 
Wenn das Ticket bisher nicht gesperrt ist, wird es gesperrt und der aktuell angemeldete Agent wird als 
Bearbeiter gesetzt.

 

Bitte beachten: Diese Einstellung ist notwendig.
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8.2.15 Anzeigen des "Incident State" des Ticketservices
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###ShowIncidentState

Diese Option legt fest, ob der Service-Vorfallstatus bei Service-Auswahl im "Änderungspopup" angezeigt 
werden soll.

 

8.2.16 Ändern verschiedener Ticketattribute und Dynamische Felder beim 
Verschieben eines Tickets im Kanban-Board

Die folgenden Einstellungen legen fest, ob im "Änderungs"-Popup beim Verschieben eines Tickets im  
Kanban-Board Änderungen an folgenden Ticketattributen möglich sind:

SysConfig-Schlüssel Erläuterung

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###Owner

Der Bearbeiter des Tickets kann geändert werden.

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###OwnerMandatory

Die Auswahl des Bearbeiters ist ein Pflichtfeld.

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###TicketType

Der Tickettyp kann geändert werden.

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###Queue

Die Queue des Tickets kann geändert werden.

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###Service

Der Service des Tickets kann geändert werden.

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###Responsible

Der Verantwortliche des Tickets kann geändert 
werden.

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###State

Der Ticketstatus kann geändert werden.

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###Priority

Die Ticketpriorität kann geändert werden.
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SysConfig-Schlüssel Erläuterung

Ticket::Frontend::AgentKanbanActionCommonPopu 
p###Title

Der Tickettitel kann geändert werden.
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8.2.17 Nächste mögliche Statustypen
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###StateType

Mit dieser Einstellung können Sie festlegen, welche nächst-mögliche Statustypen für ein Ticket im 
"Änderungs"-Popup auswählbar sind.

 

8.2.18 Hinzufügen einer Notiz beim Verschieben eines Tickets im Kanban- 
Board

SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###Note

Diese Einstellung legt fest, ob im "Änderungs"-Popup das Hinzufügen einer Notiz möglich ist. 
 

8.2.19 Notizfeld als Pflichtfeld
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###NoteMandatory

Mit dieser Einstellung legen Sie fest, ob das Notizfeld im "Änderungs"-Popup ein Pflichtfeld ist.  
 

 
Die Einstellung kann durch die Einstellung "Ticket::Frontend::NeedAccountedTime" überschrieben werden.

 

8.2.20 Standardwerte für Notizüberschrift und Notizinhalt
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanCommonPopup###Subject
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanCommonPopup###Body

Diese Einstellungen legen die Standardwerte für Titel und Inhalt einer Notiz fest, die im "Änderungs"-Popup 
beim Verschieben eines Tickets im Kanban-Board erscheint. 
 

Bitte beachten: Diese Einstellung ist notwendig.

Bitte beachten: Die Standardeinstellung ist "Nein". Diese Einstellung wirkt sich nur aus, wenn die 
Einstellung "Ticket::Frontend::AgentKanbanActionCommonPopup###Note" auf "Ja" gesetzt ist.
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8.2.21 Größe des Notiz-Eingabefeldes
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanCommonPopup::TextAreaNoteCols
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanCommonPopup::TextAreaNoteRows

Diese beiden Einstellungen legen die Standardgröße des Notiz-Eingabefeldes fest. Wenn Richtext deaktiviert 
ist, dann stehen die Werte für Anzahl der Zeilen oder Spalten (Buchstaben pro Zeile). Wenn Richtext aktiviert 
ist, dann werden die Werte in Pixel berechnet (Spalten x 10 und Reihen x 20).

8.2.22 Standard Artikeltyp
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###ArticleDefault

Hier können Sie den Standardtyp für den Artikel festlegen, der mit dem "Änderungs"-Popup beim Verschieben 
eines Tickets im Kanban-Board erzeugt wird.

 

8.2.23 Mögliche Artikeltypen
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###ArticleTypes

Mit dieser Einstellung können Sie die verfügbaren Notiztypen für den Artikel festlegen, der mit dem 
"Änderungs"-Popup beim Verschieben eines Tickets im Kanban-Board erzeugt wird. Wenn diese Einstellung 
deaktiviert ist, dann wird als Artikeltyp die Einstellung von "Ticket::Frontend:: 
AgentKanbanActionCommonPopup###ArticleDefault" verwendet.

 

8.2.24 Historie-Typ
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###HistoryType

Mit dieser Einstellung legen Sie den erzeugten Historie-Typ für die Tickethistorie fest, wenn ein Ticket im 
Kanban-Board verschoben wird.

 

Bitte beachten: Diese Einstellungen sind notwendig. Die Standardwerte sind 60 und 10.

Bitte beachten: Der Standardwert ist "note-internal".

Bitte beachten: Der Standardwert ist "AddNote".
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8.2.25 Historie-Kommentar
SysConfig-Einstellung: Ticket::Frontend::AgentKanbanActionCommonPopup###HistoryComment

Mit dieser Option legen Sie den erzeugten Historien-Kommentar für die Tickethistorie fest, wenn ein Ticket 
im Kanban-Board verschoben wird.

Bitte beachten: Der Standardwert ist "%%Note".
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9 Zusatzmodul KIX-Connect
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9.1 Installation von KIX Connect
Das Modul "KIX Connect" bietet Ihnen vorkonfigurierte Webservices zum Datenaustausch via HTTP(S) mit 
externen Backends. Das Paket nutzt dabei die Funktionalität der Webservices und liefert Ihnen definierte 
Invoker und Operations zur Kommunikation mit den externen Backends. Damit ist es möglich aus KIX heraus 
als führendes System (Requester) Dienste vom externen Backend (Provider) zu nutzen, wie bspw. ein Ticket 
in einem externen KIX erstellen. Aktuell bietet Ihnen das Paket folgende Schnittstellen:

KIX2KIX zur Kommunikation mit einem externen KIX / OTRS als Backend

KIX2JIRA zur Kommunikation mit JIRA als Backend

9.1.1 Vorraussetzungen
KIX2KIX: Requester-System: mindestens KIX17.4 / Response-System: KIX17.x / OTRS 5.x
KIX2JIRA: Das Paket wurde getestet mit JIRA V7.3.2, JIRA REST API Version 2

9.1.2  
Installation

Installieren Sie das Modul "KIX Connect" mit der Paket-Verwaltung Ihres Betriebssystems. Der Paketname ist 
"kixpro-connect".

9.1.3 Neue Dynamische Felder
Bei der Installation werden folgende Dynamische Felder angelegt:

Name Beschriftung Übersetzung Funktion

KIX2JIR 
AType

Type of JIRA- 
Issue

Typ des JIRA- 
Issues

Auswahl des JIRA-Issue Typs.

Angezeigt in: Dialog "Neues Ticket erstellen"

KIX2JIR 
AProject

Project of JIRA- 
Issue

Projekt des JIRA- 
Issues

Benennung des JIRA-Projekts

Angezeigt in: Dialog "Neues Ticket erstellen" nach 
Auswahl des JIRA-Issues 

KIX2JIR 
AKey

Key of JIRA- 
Issue

 Vermerkt die ID des JIRA-Issue.

Angezeigt in: wird nicht angezeigt
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Name Beschriftung Übersetzung Funktion

KIX2JIR 
ASend

Send to JIRA An JIRA senden Checkbox zum Übermitteln von Artikeln inklusive 
Anhängen nach JIRA

Angezeigt in: Tab "Neue Notiz" in der Ticket- 
Detailansicht. (Wenn die ID eins JIRA-Issue im 
Dynamischen Feld "KIX2JIRAKey" gespeichert 
wurde.)

KIX2KIX 
Create

Create external 
ticket

Erstelle ein 
externes Ticket

Checkbox zum Erstellen eines externen Tickets

Angezeigt in: Dialog "Neues Ticket erstellen" 

KIX2KIX 
Key

Key of external 
ticket

 Vermerkt die ID des externen Tickets.

Angezeigt in: wird nicht angezeigt

KIX2KIX 
Send

Send to 
external ticket

An ein externes 
Ticket senden

Checkbox zum Übermitteln von Artikeln inklusive 
Anhängen an ein externes Ticket

Angezeigt in: Dialog "Notiz hinzufügen" / Tab "Neue 
Notiz" in der Ticket-Detailansicht. (Wenn die ID eins 
JIRA-Issue im Dynamischen Feld "KIX2KIXKey" 
gespeichert wurde.)

9.1.4 Neue ACls
Bei der Installation werden folgende ACLs angelegt: 
 

Name Funktion

000_KIXConnect_HideSendFields Blendet im Agentenfrontend (Actions die RegExp /Agent.*/ 
entsprechen) die Felder IX2JIRASend und KIX2KIXSend aus

001_KIXConnect_HideKIX2JIRAPr 
oject

Blendet im Agentenfrontend (Actions die RegExp /Agent.*/ 
entsprechen) das Feld IX2JIRAProject aus.

010_KIXConnect_ShowKIX2JIRAS 
end

Blendet KIX2JIRASend ein, wenn in KIX2JIRAKey ein Wert hinterlegt 
ist. Der Wert wird durch den Webservice eingetragen.



KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul KIX-Connect

Installation von KIX Connect

Erstellt am: 19.01.2022                                                                   Seite 116
 

Name Funktion

011_KIXConnect_ShowKIX2KIXSe 
nd

Blendet KIX2KIXSend ein, wenn in KIX2KIXKey ein Wert hinterlegt ist. 
Der Wert wird durch den Webservice eingetragen.

012_KIXConnect_ShowKIX2JIRAP 
roject

Blendet KIX2JIRAProject ein, wenn in KIX2JIRAType ein Wert 
ausgewählt wurde.

 

Hinweis

Bitte beachten: Bei Paketdeinstallation werden die ausgelieferten Webservices, ACLs und 
DynamicFields ebenfalls gelöscht.
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9.2 Generischer Invoker
Beim Einrichten von Webservices können Sie den "generischen Invoker" nutzen, um basierend auf Zeitplänen 
Invoker aufzurufen, auch ohne Abhängigkeit von KIX-Objekten.

Anwendungsfälle

Anwendungsfälle sind unter anderem:

Erzeugen von SessionIDs oder Tokens für Webservices die nicht Username und Password- 
Authentifizierung in jedem Aufruf akzeptieren.
Als Grundlage für alternatives InventorySync
Bidirektionale Schnittstelle KIX-2-Jira, das heißt aktives Holen von JIRA-Issues und Erzeugung von 
Tickets

9.2.1 Verwendung
Ausführungsmöglichkeiten

Es stehen folgende Ausführungsmöglichkeiten zur Verfügung:

Zeitgesteuert mit Zeitplankonfiguration wie bei Generic Agent
Eventbasiert mit Zugriff auf die Daten des Events
Manuell in der Administration des Invoker 
 

Anlegen eines Invokers

Legen Sie einen neuen Webservice an und speichern Sie diesen. Anschließend können Sie bei "KIX als 
Requester" den GenericInvoker über "Generic::MethodCall" auswählen.

Hinweis

Hinweise: Der Invoker 'Generic::MethodCall' liefert selbst keine Datenverarbeitung.
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Allgemeine Konfiguration 

 

Vorbereitung / Prepare

Wenn hier nichts konfiguriert ist, wird die Anfrage an dieser Stelle erfolgreich beendet. Wenn eine Methode 
hinterlegt ist, wird der Hash-Schlüssel 'Data' zusammen mit den konfigurierten 'PrepareParameter' an die 
konfigurierte Methode des konfigurierten Moduls übergeben. Als UserID wird der konfigurierte 'RunAs' 
verwendet. Als Rückgabe vom Aufruf wird ein Hash erwartet, welcher für 'Data' in der Anfrage zu verwenden 
ist.

 

Validierung / Validate

Wenn hier nichts konfiguriert ist, wird die Rückgabe vom 'Prepare' weitergereicht. Wenn eine Methode 
hinterlegt ist, wird die Rückgabe vom 'Prepare' zusammen mit den konfigurierten 'ValidateParameter' an die 
konfigurierte Methode des konfigurierten Moduls übergeben. Als UserID wird der konfigurierte 'RunAs' 
verwendet. Als Rückgabe vom Aufruf wird ein Hash erwartet. Ist dieser nicht gefüllt, oder ist der Schlüssel 
'StopCommunication' mit einem wahren Wert gesetzt, so wird die Anfrage an dieser Stelle erfolgreich 
beendet.

 

Rückmeldung / Response

Wenn hier nichts konfiguriert ist, werden die Daten des Response einfach weitergereicht. Wenn eine Methode 
hinterlegt ist, werden die Daten des Response zusammen mit den konfigurierten 'ResponseParameter' an die 
konfigurierte Methode des konfigurierten Moduls übergeben. Als UserID wird der konfigurierte 'RunAs' 
verwendet. Als Rückgabe vom Aufruf wird ein Hash erwartet, welcher für 'Data' in der Rückgabe zu 
verwenden ist.

 

Statische Werte / Static values

Wenn 'Parameter (Statisch)' konfiguriert sind, werden diese aus der Rückgabe vom 'Prepare' übernommen, 
sofern sie definiert sind und stehen im Mapping im 'Response' zur Verfügung.
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Abbildung: Erster Teil der Maske für Generic::MethodCall

Mappings

Für folgende Daten können am Invoker Mappings hinterlegt werden:

Mapping für Vorbereitungsdaten
Mapping für ausgehende Anfragedaten
Mapping für eingehende Antwortdaten
Mapping für erfolglose Antwortdaten
Mapping für Rückmeldungsdaten

Abbildung: Mappings für Daten
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Für jedes Mapping können Sie aus den Optionen "Einfach", "Ticketvorlage" oder "XSLT" wählen. Nachdem Sie 
am Ende des Formulars auf "Speichern" geklickt haben, erscheint neben dem neu gewählten Mappingtyp ein 
Button, über den Sie das Mapping anpassen oder neu hinterlegen können.

Möchten Sie kein Mapping verwenden, klicken Sie auf das kleine Kreuz beim bereits ausgewählten Eintrag.

 

Abbildung: Zusammenspiel von Mappings und Daten

Automatische Ausführung

Gegen Sie hier Minuten, Stunden oder Tage an und steuern Sie so den Zeitpunkt, an dem der Invoker 
ausgeführt werden soll.

Eventbasierte Ausführung

Wählen Sie hier das Event, mit welchem der Invoker getriggert werden soll.

Hinweis

Klicken Sie das PLUS rechts neben den "Event-Trigger hinzufügen" Feldern an, um einen Trigger 
auszuwählen. Danach erscheint dieser oben in der Liste.
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Sollten Sie keine Eventauswahl sehen, liegt es an noch nicht gespeicherten Änderungen. 
Übernehmen Sie diese mit "Speichern".
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9.3 Erweiterte Transportoptionen

9.3.1 Zusätzliche Header
In der Administration für den Transport bei 'REST' und 'SOAP' können zusätzliche HTTP-Header angegeben 
werden. Bei LWP ist dies nicht vorhanden, da der Header für LWP in den Daten zu definieren ist.

9.3.2 Proxy-Einstellungen
In der Administration für den Transport bei 'LWP', 'REST' und 'SOAP' kann die Verwendung eines Proxys 
angegeben werden. Für 'REST' und 'SOAP' kann eine Proxy-Authentifizierung angegeben werden. Bei LWP ist 
dies nicht vorhanden, da diese Authentifizierung im Header gesendet wird und der Header für LWP in den 
Daten zu definieren ist. Der konfigurierter Proxy wird für HTTP und HTTPS verwendet. Eine Konfiguration 
'NO_PROXY' ist NICHT implementiert.

Hinweis: Die Felder zur Proxy-Einstellung werden erst sichtbar, wenn Sie das "Proxy verwenden" Feld auf "Ja" 
stellen.

9.3.3 Konfiguration SSL
In der Administration für den Transport bei 'LWP', 'REST' und 'SOAP' können die Hostnameprüfung bei SSL 
deaktiviert sowie weitere SSL Konfigurationen vorgenommen werden.
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9.4 Umgang mit großen Datenmengen
Um beim Sync von Daten von der Schnittstelle nach KIX effizienter und schneller arbeiten zu können, stellt 
KIXConnect einige Mechanismen zur Optimierung bereit.

9.4.1 Caching bearbeiteter Datensätze
Über einen Cache soll das System bewerten können, ob die Verarbeitung von Daten für ein configItem-Eintrag 
notwendig ist, oder übersprungen werden kann. Dies gilt bei der Verwendung des Invoker 
'Generic::MethodCall' mit den Methoden von 'Kernel::System::KIXConnect::ITSMConfigItem'.

Dabei ist folgendes zu beachten:

Was als CacheKey genutzt werden soll, wird im Mapping hinterlegt.
Ein CacheKey gilt global im gesamten Webservice.
Um einen Cache-Eintrag anlegen zu lassen, muss eine TTL (Gültigkeitszeit) definiert werden. Ist keine 
TTL definiert, wird kein Cache-Eintrag angelegt.
Zur Prüfung eines Cache-Eintrags muss keine TTL definiert werden.
Wenn ein Cache-Eintrag vorhanden ist, wird die Datenverarbeitung samt PreCall und PostCall 
übersprungen
Über den Befehl kix.Console.pl Maint::Cache::Delete kann der Cache geleert werden

Ein Mapping mit Verwendung von CacheKeys kann so aussehen:

# Part of ConfigItems-Entry
ConfigItems => {
  Cache => {
    Key => 'Test123', # Identifier for cache entry, valid for every invoker of 
current webservice.
    TTL => '14400'    # Time the cache entry is valid in seconds. 14400 seconds => 4 
 hours.
                      # If TTL is not given, check for cache entry is performed, but 
no cache entry will be created.
                      # Cache entry is created after sucessful processing of config 
item entry
  },
  ConfigItem => {
    ...               # Known structure for this part
  }
  ...
}
 
# or as array
ConfigItems => [
  {
    Cache => {
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      Key => 'Test123', # Identifier for cache entry, valid for every invoker of 
current webservice.
      TTL => '14400'    # Time the cache entry is valid in seconds. 14400 seconds => 
4 hours.
                        # If TTL is not given, check for cache entry is performed, 
but no cache entry will be created.
                        # Cache entry is created after sucessful processing of config 
item entry
    },
    ConfigItem => {
      ...               # Known structure for this part
    }
    ...
  },
  ...
]

9.4.2 IncidentStateRecalc verzögern/auslassen
IncidentStateRecalc ist eine Funktion in KIX, mit der anhand der LinkTypen und ihrer Richtung bei Config 
Items der Vorfallstatus beim Aktualisieren eines Objektes neu berechnet wird. 
Während der Datenverarbeitung von 'Kernel::System::KIXConnect::ITSMConfigItem' als Modul für den Invoker 
'Generic::MethodCall' soll 'InciStateRecalc' nicht ausgeführt werden, um das System nicht unnötig durch sich 
ständig ändernde Daten auszubremsen. Nach Abschluss der Verarbeitung kann für alle aktualisierte 
ConfigItems ein 'InciStateRecalc' ausgeführt oder vollständig ignoriert werden.

Um dieses Vorgehen zu steuern, passen Sie Ihre Mappings wie folgt an:

# Delay recalc of processed config items till all entries are done
{
  DelayInciStateRecalc => '1',
  ConfigItems => [...],          # or ConfigItems => {...} for only one entry
}
 
# Skip recalc for every processed config item
{
  SkipInciStateRecalc => '1',
  ConfigItems => [...],          # or ConfigItems => {...} for only one entry
}
 
# To add processed config items of a PreCall or PostCall to the relevant list for 
 DelayInciStateRecalc
{
  DelayInciStateRecalc => '1',
  ConfigItems => [          # or ConfigItems => {...} for only one entry
    {
      PreCall => {
        ...
        ExtendConfigItemList => 1
      },
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      ConfigItem => {...},
      PostCall => {
        ...
        ExtendConfigItemList => 1
      }
    },
    ...
  ]
}

 

 

9.4.3 Asynchrones Ausführen von Calls
Während der Datenverarbeitung von 'Kernel::System::KIXConnect::ITSMConfigItem' als Modul für den Invoker 
'Generic::MethodCall' soll es für 'PreCall' und 'PostCall' möglich sein, die Aufrufe als eigenständige Tasks 
asynchron ausführen zu lassen.

Im verarbeiteten Eintrag wird durch `{PreCall}->{Asynchronous}` mit einem True-Value (1, 2...etc) 
festgelegt das der Aufruf als eigener Task vom Scheduler ausgeführt wird

Parameter, welche die Rückgabe auswerten (SkipOnFailure und ExtendConfigItemList), 
werden nicht verarbeitet

Im verarbeiteten Eintrag wird durch `{PostCall}->{Asynchronous}` mit einem True-Value (1, 2...etc) 
festgelegt das der Aufruf als eigener Task vom Scheduler ausgeführt wird

Parameter, welche die Rückgabe auswerten (ExtendConfigItemList), werden nicht verarbeitet

Ein Mapping kann so angepasst werden:

# Run calls asynchronous
{
  ConfigItems => [          # or ConfigItems => {...} for only one entry
    {
      PreCall => {
        ...
        Asynchronous => 1,
      },
      ConfigItem => {...},
      PostCall => {
        ...
        Asynchronous => 1,
      }
    },
    ...
  ]
}
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9.5 Vorkonfigurierte WebServices
Bei Auslieferung von KIX Connect sind bereits einige WebSerives vorkonfiguriert enthalten. Diese können 
nach Bedarf aktiviert werden. Dabei sollten sie jedoch an die jeweils gegebenen Umstände angepasst 
werden.



KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul KIX-Connect

Vorkonfigurierte WebServices

Erstellt am: 19.01.2022                                                                   Seite 128
 

•
•

•
•
•

•
•
•
•

9.5.1 KIX2KIX
Bei "KIX2KIX" haben Sie die Möglichkeit, zwei KIX-Instanzen miteinander zu verbinden. Dabei ist ein KIX- 
System ein Requester und das andere KIX-System ein Provider. Damit ist es möglich, aus KIX heraus im 
anderen KIX-System:

 

Tickets erstellen
Am erstellten Ticket:

Artikel erstellen
Priorität ändern
Anlagen hinzufügen (beim Erstellen eines Artikels) 

Dazu muss auf beiden Systemen das Paket "KIXConnect" installiert sein. Das Paket liefert die Konfiguration 
der Webservices für KIX als Requester und KIX als Provider.  
Das Paket liefert auch ein neues Sidebar-Widget "Externe Ticket-Informationen" in der Ticket-Detailansicht.  
In diesem Widget werden die Informationen des externen Tickets angezeigt.

 

 

 

Abb.: Sidebar-Widget "Externe Ticket-Informationen"

 

9.5.1.1 Voraussetzungen

Im "führenden" KIX-System muss der Webservice "KIX2KIXRequester" aktiviert sein.
Im "geführten" KIX-System muss der Webservice "KIX2KIXProvider" aktiviert sein.
Die Qeuebezeichnung muss in beiden Systemen identisch sein.
Der Login-Name des Ansprechpartners muss in beiden Systemen identisch sein. 
 

Das Widget ist nach der Installation noch auf inaktiv gesetzt. Wenn Sie es aktivieren möchten, 

setzen Sie einen   im SysConfig-Schlüssel "Frontend::KIXSidebarBackend###KIXSBGIItem002".
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9.5.1.2 Webservice "KIX2KIXRequester" auf dem Requester-System aktivieren

 

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "Webservices".

Es öffnet sich die Webservice-Verwaltung-Übersicht.

 

  
Abb.: Webservice-Verwaltung-Übersicht  
 

Klicken Sie auf den Eintrag "KIX2KIXRequester" in der Liste.

Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern".
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 Wählen Sie im Drop-down Menü "Gültigkeit" den Wert "gültig".
Klicken Sie auf die Schaltfläche .

Klicken Sie im Widget "KIX als Requester" auf die Schaltfläche .

 
Es öffnet sich das Widget "Netzwerk Transport":

"Speichern"

"Konfigurieren"
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Abb.: Widget "Netzwerk-Transport"  
 

Geben Sie im Feld "Host" den URL des Remote-Hosts an (den URL des Provider-KIX).
Geben Sie in den Feldern:

Controller-Mapping für Invoker 'ArticleCreate'
Controller-Mapping für Invoker 'TicketCreate'
Controller-Mapping für Invoker 'TicketGet'
Controller-Mapping für Invoker 'TicketUpdate'

bei <USERNAME> und <PASSWORT> den Login-Name und das Passwort für das Provider-KIX ein.

Klicken Sie abschließend auf die Schaltfläche ."Speichern"
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9.5.1.3 Webservice "KIX2KIXProvider" auf dem Provider-System aktivieren

 

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "Webservices".

 
Es öffnet sich die Webservice-Verwaltung-Übersicht. 
  

 

Abb.: Webservice-Verwaltung-Übersicht  
 

Klicken Sie auf den Eintrag "KIX2KIXProvider" in der Liste.

 
Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern".

 

 

 

Abb.: Webservice-Verwaltung ändern  
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Wählen Sie im Drop-down Menü "Gültigkeit" den Wert "gültig".
Klicken Sie auf die Schaltfläche "Speichern".  
 

 

Hinweis

Die maximale Nachrichtenlänge ist standardmäßig auf 24000000 Bytes festgelegt. Diese Einstellung 
ist speziell für die Übertragung von Anhängen relevant. Requests, die größer als diese Einstellung 
sind, werden mit einer Hinweismeldung im Debugger des Providers abgewiesen. Wenn Sie den 
Standardwert verändern möchten, klicken Sie auf die Schaltfläche "Konfigurieren" im Widget "KIX als 
Provider". Es öffnet sich dann das Widget "Netzwerk-Transport". Legen Sie im Feld "Maximale 
Nachrichtenlänge" den gewünschten Wert fest und klicken Sie auf "Speichern".
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9.5.1.4 Ein neues Ticket aus dem Requester-KIX im Provider-KIX erstellen

 

 Wählen Sie im Menü "Tickets" den Eintrag "Neues Ticket".

 

 

 

 
 

Füllen Sie die Eingabefelder wie beim Erstellen eines Tickets aus.

Setzen Sie einen   im Feld "Erstelle externes Ticket".
Klicken Sie abschließend auf die Schaltfläche "Erstellen".

 
Das Ticket wurde nun mit den angegebenen Daten im durch das Requester-KIX im Provider-KIX erstellt.
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Abb.: Sidebar-Widget "Externe Ticket-Informationen" 
 
 
In der Standardauslieferung des Paketes werden bei Ticketerstellung folgende Ticket-/Artikelattribute 
übertragen: 
 

Ticket Artikel Anhang

Titel (Title) Typ (ArticleType) Dateiname (Filename)

Typ (Type) Sendertyp (Sendertype) Inhaltstyp (ContentType)

Queue Von (From) Inhalt (Content) (Base64)

Status (State) An (To) Disposition

Priorität (Priority) Betreff (Subject) ContentID

Ansprechpartner-ID 
(CustomerUserID)

Inhalt (Body)  

Kunden-ID (CustomerID) Inhaltstyp (ContentType)  

 Historientyp (HistoryType)  

 

Die bei der Ticketerstellung zu setzenden Attribute müssen in beiden Systemen die identische 
Bezeichnung haben. Bei nicht identischen Bezeichnungen gibt es eine Fehlermeldung im Debugger 
des Provider-Systems.





KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul KIX-Connect

Vorkonfigurierte WebServices

Erstellt am: 19.01.2022                                                                   Seite 136
 

•
•

9.5.1.5 Einen neuen Artikel im externen Ticket erstellen

 

Wenn Sie Artikel zu einem externen Ticket hinzufügen möchten, haben Sie zwei Möglichkeiten:

Über die Schaltfläche "Bearbeiten""Bearbeiten" oder
Über das "Notiztab" in der Ticketdetailansicht

  
Wenn Sie die Schaltfläche "Bearbeiten" nutzen, öffnet sich der Dialog "Notiz zu Ticket#.... hinzufügen - .... ". 
Hier haben Sie nun die Möglichkeit, über "Betreff" / "Text" den Artikel zu verfassen.

 

 

 

Abb.: Dialog Ticket bearbeiten  
 

Füllen Sie die Felder im Dialog aus und setzen Sie bei "An externes Ticket senden" einen   . Klicken Sie 
abschließend auf die Schaltfläche "Übermitteln".  
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Sie können in diesem Dialog auch den Status und die Priorität des externen Tickets ändern. Diese 
Möglichkeit unterliegt aber der Einschränkung, dass über diesen Dialog immer ein neuer Artikel erzeugt wird. 
Wenn Sie die Priorität oder den Status ändern möchten, ohne dass ein neuer Artikel erzeugt wird, dann 
empfiehlt sich die die Methode wie im Folgenden unter "Status und Priorität im externen Ticket ändern" 
beschrieben. 
 
Wenn Sie das Notiztab nutzen, haben Sie nur die Möglichkeit, durch Ausfüllen der Felder "Betreff" / "Text" 
einen Artikel im externen Ticket zu erstellen. Die Möglichkeiten, den Status und die Priorität zu wechseln gibt 
es hier nicht.

 

 

 

Abb.: Ticket-Detailansicht / Tab "Neue Notiz"

9.5.1.6 Priorität im externen Ticket ändern

 

Die Priorität im externen Ticket können Sie ändern, wenn Sie den Tab "Ticketkerndaten" im Requester-KIX 
nutzen.
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Abb.: Tab "Ticketkerndaten"  
 
Ändern Sie hier die Priorität und klicken Sie abschließend auf die Schaltfläche "Übermitteln" . Die Priorität 
wird im externen Ticket entsprechend geändert.  
Im Seitenleisten-Widget "Externe Ticket-Informationen" ist der geänderte Wert des externen Tickets sichtbar.
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9.5.2 KIX2JIRA
Mit "KIX2JIRA" haben Sie die Möglichkeit, KIX mit JIRA zu verbinden. KIX ist dabei als Requester das aktive / 
führende System, während JIRA als Provider fungiert. Damit ist es möglich, aus KIX heraus in JIRA:

In JIRA einen neuen Vorgang (Issue) erzeugen, wenn im KIX ein Ticket erstellt wird.
In JIRA einen Kommentar zu einem Vorgang hinzufügen.
Einen bestehenden JIRA-Vorgang aktualisieren.
Einen Anhang nach JIRA übermitteln.  
 

 
Besteht aus den Webservices:

KIX2JIRA
KIX2JIRA_Attachment 

 

 

9.5.2.1 Webservice "KIX2JIRA" aktivieren

 

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "Webservices"

 

Es öffnet sich die Webservice-Verwaltung-Übersicht.

Hinweis

Bitte beachten: Wenn Anhänge übermittelt werden sollen, dann muss für das relevante Projekt in 
JIRA Anhänge an Vorgängen erlaubt sein.



Hinweis

Bei spezifischen Anpassungen, die von der Standardkonfiguration abweichen, kann es zu einer 
Fehlermeldung durch das System kommen. Wir empfehlen zur Behebung des Fehlers unser Support- 
Team zu kontaktieren.
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•

 

 

 

Abb.: Webservice-Verwaltung-Übersicht  
 

Klicken Sie auf den Eintrag "KIX2JIRA" in der Liste.

 

Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern"

 

 

 

Abb.: Webservice-Verwaltung ändern

 

Wählen Sie im Drop-down Menü "Gültigkeit" den Wert "gültig".
Klicken Sie auf die Schaltfläche .

Klicken Sie im Widget "KIX als Requester" auf die Schaltfläche .

"Speichern"

"Konfigurieren"
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Abb.: Widget "KIX als Requester"

 
Es öffnet sich das Widget "Netzwerk Transport".
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Abb.: Widget "Netzwerk-Transport"  
 

Geben Sie im Feld "Host" den URL des Remote-Hosts an (in dem Fall JIRA).
Geben Sie im Feld "Benutzer" den Nutzernamen an, mit dem Sie sich auf dem Remote-Host einloggen. 
(In dem Fall der JIRA-Nutzername).
Geben Sie im Feld "Passwort" das Passwort an, mit dem Sie sich auf dem Remote-Hoste einloggen. 
(In dem Fall das JIRA-Passwort).  
Alle anderen Einstellungen sind durch das Modul "KIX Connect" bereits vorgenommen und müssen 
nicht geändert werden.
Klicken Sie auf die Schaltfläche  ."Speichern"
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9.5.2.2 Webservice "KIX2JIRA_Attachment" aktivieren

 

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "Webservices".

 
Es öffnet sich die Webservice-Verwaltung-Übersicht. 
   

 

Abb.: Webservice-Verwaltung-Übersicht  
 
 

Klicken Sie auf den Eintrag "KIX2JIRA" in der Liste.

 
Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern". 
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Abb.: Webservice-Verwaltung ändern

 

Wählen Sie im Drop-down Menü "Gültigkeit" den Wert "gültig".
Klicken Sie auf die Schaltfläche "Speichern".
Klicken Sie im Widget "KIX als Requester" auf die Schaltfläche "Konfigurieren".

 

  
Abb.: Widget "KIX als Requester" 
 

Es öffnet sich das Widget "Netzwerk Transport". 
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Abb.: Widget "Netzwerk-Transport"

Geben Sie im Feld "Host" den URL des Remote-Hosts an (in dem Fall JIRA).
Geben Sie im Feld "Benutzer" den Nutzernamen an, mit dem Sie sich auf dem Remote-Host einloggen. 
(In dem Fall der JIRA-Nutzername).
Geben Sie im Feld "Passwort" das Passwort an, mit dem Sie sich auf dem Remote-Host einloggen. (In 
dem Fall das JIRA-Passwort).  
Alle anderen Einstellungen sind durch das Modul "KIX Connect" bereits vorgenommen und müssen 
nicht geändert werden.
Klicken Sie auf die Schaltfläche "Speichern".

9.5.2.3 Das Seitenleisten-Widget "JIRA-Informationen"

 

Mit der Installation des Moduls "KIX Connect" wurde für die Ticket-Detailansicht ein neues Seitenleisten-  
Widget "JIRA-Informationen" angelegt. Das Widget zeigt Ihnen folgende Informationen:
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"Titel" = Der Name des Vorgangs in JIRA
"Schlüssel" = Bezeichnung des JIRA-Projektschlüssel
"Typ" = Typ des JIRA-Vorgangs (JIRA Issue)
"Status" = Status des JIRA-Vorgangs
"Priorität" = Priorität des JIRA-Vorgangs

 

 

 

Abb.: Seitenleisten-Widget "JIRA-Informationen"

 
Im Auslieferungszustand ist das Widget noch auf inaktiv gesetzt. Führen Sie folgende Schritte aus, wenn Sie 
es aktivieren möchten:

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "SysConfig".
Wählen Sie im Drop-down Menü die Gruppe "KIXConncet".
Wählen Sie die Untergruppe "Frontend::Agent::KIXSidebarGIView".

Setzen Sie einen  beim Eintrag "Frontend::KIXSidebarBackend###KIXSBGIItem001" und klicken 
Sie auf die Schaltfläche  .

 

 

 

Abb.: SysConfig - Schlüssel "Frontend::KIXSidebarBackend###KIXBGIItem001"

"Aktualisieren"
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9.5.2.4 In KIX ein Ticket erstellen und Daten nach JIRA übermitteln

 

Wählen Sie im Menü "Tickets" den Eintrag "Neues Ticket"

 

Füllen Sie die Eingabefelder wie beim Erstellen eines Tickets aus.
Wählen Sie im Drop-Down Menü "Typ des JIRA-Issue" einen Wert aus der Liste.
Tragen Sie im Feld "Projekt des JIRA-Issue" den Projektschlüssel des JIRA-Projekts ein.
Klicken Sie abschließend auf die Schaltfläche "erstellen"   

 

Das Ticket wurde nun mit den angegebenen Daten in KIX erstellt und in JIRA ein Vorgang entsprechend der 
angegebenen Daten. Wenn Sie die Ticket-Detailansicht des gerade erstellen Tickets aufrufen (Bspw. in dem 

Sie auf die Ticketnummer in der grünen Systemmeldung:  klicken), können Sie im 

.
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•
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Widget "JIRA-Informationen" sehen, dass die Daten erfolgreich an JIRA übermittelt wurden. Ebenso können 
Sie zur Kontrolle auch den Vorgang in JIRA öffnen.  
  

 

Abb.: Seitenleisten-Widget "JIRA-Informationen"

9.5.2.5 Einen JIRA-Vorgangstitel ändern

 

Rufen Sie die Ticket-Detailansicht des Tickets in KIX auf.
Klicken Sie auf den Tab "Ticketkerndaten".

 

 

 

Abb.: Ticket-Detailansicht mit Tab "Ticketkerndaten"  

Hinweis

Wenn das neue Ticket im KIX erstellt wurde, ist anschließend am ersten Artikel des Tickets trotzdem 
weiterhin der Button "An JIRA senden" zu sehen, obwohl die Daten bereits an JIRA übertragen 
wurden.
Hintergrund: Der Textinhalt des KIX-Tickets, und damit des ersten Artikels, ist identisch mit der 
Vorgangsbeschreibung im JIRA-Issue. Daher muss kein weiterer inhaltlich gleicher Kommentar im 
Jira angelegt werden.
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Geben Sie im Feld "Titel" die geänderte Bezeichnung für den Vorgangstitel an.
Klicken Sie abschließend auf die Schaltfläche .

Der Vorgangstitel wurde nun KIX und JIRA aktualisiert. Im Widget "JIRA-Informationen" sehen Sie den 
geänderten Titel.

9.5.2.6 Eine Notiz in KIX als JIRA-Kommentar übermitteln

 

 Rufen Sie die Ticket-Detailansicht des Tickets in KIX auf.
Klicken Sie auf die Schaltfläche "Bearbeiten" oder auf den Tab "Neue Notiz".

 
Wenn das Paket korrekt eingerichtet wurde und eine Referenz zu JIRA vorhanden ist, dann ist im Bearbeiten- 
Modus nun eine Checkbox "An JIRA senden" zu sehen.

 

 

 

Abb.: Ticket-Detailansicht mit Notiztab  
 

Füllen Sie die Felder "Betreff" und "Text" aus und markieren Sie "An JIRA senden" mit  .  

Optional haben Sie hier auch die Möglichkeit, eine Anlage mit der Notiz an JIRA zu übermitteln.
Klicken Sie abschließend auf die Schaltfläche "Übermitteln".

 
Die Daten werden von KIX nach JIRA übermittelt. Der "Betreff" erscheint in JIRA als 1. Zeile im 
Kommentarfeld. Nach einem Zeilenumbruch wird dann der Inhalt aus dem Feld "Text" im Kommentarfeld 

"Übermitteln"
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angezeigt. Die Anlage wird in JIRA im Bereich "Anhänge" platziert. Sie können beim Übermitteln von 
Anhängen auch mehrere Anhänge auswählen und übermitteln.
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9.5.3 KIX2i-doit
i-doit (I document IT) ist eine Web-basierte freie Software, die der Dokumentation komplexer IT- 
Infrastrukturen dient, welche mit zusätzlichen Funktionen einer Configuration Management Database 
(CMDB) ergänzt wird. Die Elemente der IT-Infrastruktur werden als Objekte angelegt und mit Attributen 
versehen.

 
KIX Connect stellt eine Integration der i-doit-Gerätedatenbank (i-doit-CMDB) in die Ticketbearbeitung in KIX 
bereit. Dies erfolgt durch Einrichtung eines Formularfeldes, welches seine Auswahlwerte aus der i-doit-CMDB 
bezieht. Das Feld kann mehrere Einträge enthalten. Die Anzahl der zulässigen Einträge ist konfigurierbar.

 
In der Erstellmaske und dem Ticket-Tab 'Dynamische Felder' in der Ticket-Ansicht sieht man ein Feld 
'Betroffene CIs'. Hier können per Autocomplete Einträge aus i-doit gesucht und ausgewählt werden. Die so 
am Ticket hinterlegten 'Betroffenen CIs' werden dann entsprechend in der Sidebar 'Betroffene CIs' in der 
Ticket-Ansicht angezeigt. Im Falle von Mehrfachauswahlen werden die Einzeleinträge als Seiten/Pages in der 
Sidebar dargestellt. Die angezeigten Attribute sind konfigurierbar. 
 

 
Mit "KIX2i-doit" haben Sie die Möglichkeit, Daten aus i-doit für die Ticketbearbeitung in KIX bereitzustellen. 
Damit ist es möglich:

 

Objekte aus i-doit als 'Betroffene CIs' an einem Ticket zu vermerken
Informationen vermerkter Objekte am Ticket anzuzeigen 
 

Besteht aus den Webservices:

KIX2i-doit 
 

9.5.3.1 Webservice " KIX2i-doit " aktivieren

 

Im Auslieferungszustand ist das Widget noch auf inaktiv gesetzt. Um es zu aktivieren, führen Sie folgende 
Schritte aus:

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "SysConfig".

Es werden keine Config-Item-Informationen in die KIX-CMDB synchronisiert.
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Wählen Sie im Drop-down Menü die Gruppe "KIXConnect".
Wählen Sie die Untergruppe "KIX2i-doit".
Füllen Sie die Konfigurationspunkte dieser Seite aus und klicken Sie "Aktualisieren".
Wählen Sie anschließend im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "Webservices".

 
Es öffnet sich die Webservice-Verwaltung-Übersicht.

  
Abb.: Webservice-Verwaltung-Übersicht  
 

Klicken Sie auf den Eintrag "KIX2i-doit" in der Liste.

 
Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern"

 

Abb.: Webservice-Verwaltung ändern  
 

Wählen Sie im Drop-down Menü "Gültigkeit" den Wert "gültig".
Klicken Sie auf die Schaltfläche "Speichern".
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Im Webservice müssen keine Anpassungen vorgenommen werden, bei der Verwendung von HTTP. Wenn 
HTTPS verwendet werden soll, muss im Webservice 'KIX2i-doit'

in der Transportkonfiguration beim 'Host' das '[http://' zu '[https://' geändert werden.

im Mapping für eingehende Antwortdaten des Invokers 'SidebarCMDBObjectRead' in der Zeile mit 
'SYSID' das '[http://' zu '[https://' geändert werden.

9.5.3.2 Das Seitenleisten-Widget "Betroffene CIs"

 

Mit der Installation des Moduls "KIX Connect" wurde für die Ticket-Detailansicht ein neues Seitenleisten- 
Widget "Betroffene CIs" angelegt. Das Widget zeigt Ihnen folgende Informationen:

 

Allgemeine Informationen 
"Kategorie" - Kategorie des Objektes in i-doit (Infrastruktur, Software, Kontakte, Sonstiges)
"Typ" - Typ des Objectes in i-doit (Gebäude, Server, Telefon, Monitor, ...)
"SYSID" - Die System-ID von i-doit, mit Link zum Objekt
"Titel" - Name des Objekts
"Status" - CMDB-Status des Objekts
"Verwendung" - Als was das Objekt verwendet wird (Produktiv, Qualitätssicherung)
"Tags" - Am Objekt vergebene Stichwörter
"Beschreibung"
"Erstellt" - Erstelldatum des Objekts
"Geändert" - Datum der letzten Änderung am Objekt

Modell-Information
"Hersteller"
"Modell"
"Produkt-ID" - Kennung des Produktes
"Seriennummer"

Adress-Informationen
"Straße"
"Nummer" - Hausnummer zur Straße
"Postleitzahl"
"Stadt"
"Region"
"Land"

 
 
Im Auslieferungszustand ist das Widget noch auf inaktiv gesetzt. Führen Sie folgende Schritte aus, wenn Sie 
es aktivieren möchten:
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Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "SysConfig".
Wählen Sie im Drop-down Menü die Gruppe "KIXConnect".
Wählen Sie die Untergruppe "Frontend::Agent::KIXSidebarGIView".

Setzen Sie einen   beim Eintrag "Frontend::KIXSidebarBackend###KIXSBGIItem003" und klicken 
Sie auf die Schaltfläche "Aktualisieren".

 
 

Abb.: SysConfig - Schlüssel "Frontend::KIXSidebarBackend###KIXSBGIItem003"  
 
Für diese Anbindung existiert ebenfalls eine Sidebar für das Kundenfrontend, welche auch inaktiv 
ausgeliefert wird. Die Schritte, um sie zu aktivieren, sind folgende:

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "SysConfig".
Wählen Sie im Drop-down Menü die Gruppe "KIXConnect".
Wählen Sie die Untergruppe "Frontend::Customer::KIXSidebarGIView".

Setzen Sie einen   beim Eintrag "CustomerFrontend::KIXSidebarBackend###KIXSBGIItem003" und 
klicken Sie auf die Schaltfläche "Aktualisieren".

9.5.3.3 In KIX betroffene CIs aus i-doit am Ticket vermerken

Wählen Sie im Hauptmenü den Punkt "Neues Ticket erstellen" aus.
Beim Ausfüllen der Inhalte finden Sie das Feld "Betroffene CIs". Hierbei handelt es sich um ein 
Autocomplete-Feld. Geben Sie hier einen Suchbegriff oder einen Teil davon ein. Sie können auch * als 
Wildcard verwenden. In der Standardauslieferung erwartet das Feld mindestens drei Zeichen bevor 
eine Suche ausgelöst wird.
Nach Erstellen des Tickets ist das betroffene CI am Ticket hinterlegt.

 
Um ein betroffenes CI aus i-doit an einem bereits bestehenden Ticket zu vermerken, öffnen Sie das Ticket 
und klicken auf den Reiter "Dynamische Felder". Hier finden Sie das Feld "Betroffene CIs". Das Ausfüllen 
erfolgt analog zum Vorgehen beim Erstellen eines neuen Tickets.
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9.5.4 BaramundiSync
Beim BaramundiSync haben Sie die Möglichkeit, Geräte (Device) und deren installierte Software (Software) 
von Baramundi in die CMDB von KIX zu synchronisieren. Dafür gibt es eine inaktiv ausgelieferte Webservice- 
Vorlage, die Daten von der Baramundi-Schnittstelle "bConnect" über REST abfragen kann.

Die CI-Klasse "Device" wird bei der Installation von KIX-Connect angelegt.
Die CI-Klasse "Software" wird von BaramundiSync mit den vorhandenen Standardattributen 
verwendet.

9.5.4.1 Webservice "BaramundiSync" aktivieren

Im  Auslieferungszustand ist der Webservice noch auf inaktiv gesetzt. Um ihn zu aktivieren, führen Sie 
folgende Punkte aus:

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "Webservices"

Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern"

Abb.: Webservice-Verwaltung-Übersicht

Klicken Sie auf den Eintrag "BaramundiSync" in der Liste.

 
Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern"
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Abb.: Webservice-Verwaltung ändern  
 

Wählen Sie im Drop-down Menü "Gültigkeit" den Wert "gültig".
Klicken Sie auf die Schaltfläche "Speichern". 
 
 

Um "BaramundiSync" auf Ihre Gegebenheiten anzupassen, nehmen Sie entsprechende Änderungen am 
Netzwerk-Transport vor.

Klicken Sie dazu im Bereich "KIX als Requester" auf "Konfigurieren". 
 

Abb.: Transport-Eigenschaften ändern 
 

Füllen Sie die erforderlichen Felder aus
Klicken Sie auf die Schaltfläche "Speichern".



KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul KIX-Connect

Vorkonfigurierte WebServices

Erstellt am: 19.01.2022                                                                   Seite 157
 

•

•

•

Abb.: Transport-Eigenschaften anpassen 

 

Das ausglieferte Mapping entspricht einigen Standardvorgaben. Hier müssen eventuell auch noch 
Anpassungen an die Gegebenheiten Ihrer Umgebung vorgenommen werden.

Wählen Sie dafür im Bereich "KIX als Requester" den ensprechenden Invoker.

Abb.: Invoker für Mapping-Anpassungen auswählen 

Es öffnet sich ein neues Formular.

Klicken Sie hier unter "Mappings" bei "eingehende Antwortdaten" auf den Button "Konfigurieren" und 
passen das vorhandene Mapping Ihren Bedürfnissen an.
Klicken Sie auf die Schaltfläche "Speichern".
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Abb.: Mappings anpassen 

 

Gehen Sie analog vor für die anderen Invoker und Mappings.
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9.5.5 VMWareAirWatchSync
Beim VMWareAirWatchSync haben Sie die Möglichkeit, Geräte (Device) und deren App-Liste (Software) in die 
CMDB von KIX zu synchronisieren. Dafür gibt es eine inaktiv ausgelieferte Webservice-Vorlage.

Die CI-Klasse "Device" wird bei der Installation von KIX-Connect angelegt.
Die CI-Klasse "Software" wird von VMWareAirWatchSync mit den vorhandenen Standardattributen 
verwendet.

9.5.5.1 Webservice "VMWareAirWatchSync" aktivieren

Im  Auslieferungszustand ist der Webservice noch auf inaktiv gesetzt. Um ihn zu aktivieren, führen Sie 
folgende Punkte aus:

Wählen Sie im Hauptmenü den Eintrag "Admin".
Wählen Sie im Bereich "Systemverwaltung" den Eintrag "Webservices"

Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern"

Abb.: Webservice-Verwaltung-Übersicht

Klicken Sie auf den Eintrag "VMWareAirWatchSync" in der Liste.

 
Es öffnet sich der Bereich "Webservice-Verwaltung-Ändern"
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Abb.: Webservice-Verwaltung ändern  
 

Wählen Sie im Drop-down Menü "Gültigkeit" den Wert "gültig".
Klicken Sie auf die Schaltfläche "Speichern". 
 
 

Um "VMWareAirWatchSync" auf Ihre Gegebenheiten anzupassen, nehmen Sie entsprechende Änderungen 
am Netzwerk-Transport vor.

Klicken Sie dazu im Bereich "KIX als Requester" auf "Konfigurieren". 
 

 

Abb.: Transport-Eigenschaften ändern 
 

Füllen Sie die erforderlichen Felder aus
Klicken Sie auf die Schaltfläche "Speichern".
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Abb.: Transport-Eigenschaften anpassen 

 

Das ausglieferte Mapping entspricht einigen Standardvorgaben. Hier müssen eventuell auch noch 
Anpassungen an die Gegebenheiten Ihrer Umgebung vorgenommen werden.

Wählen Sie dafür im Bereich "KIX als Requester" den ensprechenden Invoker.

 

Abb.: Invoker für Mapping-Anpassungen auswählen 

Es öffnet sich ein neues Formular.
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Klicken Sie hier unter "Mappings" bei "eingehende Antwortdaten" auf den Button "Konfigurieren" und 
passen das vorhandene Mapping Ihren Bedürfnissen an.
Klicken Sie auf die Schaltfläche "Speichern".

 

Abb.: Mappings anpassen 

 

Gehen Sie analog vor für die anderen Invoker und Mappings.
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10 Zusatzmodul KPI-Dashboard
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10.1 Installation Zusatzmodul KPI-Dashboard

10.1.1 Voraussetzungen
KIX Professional 17 - aktuelle Version
Microsoft Excel 2010 or 2013 mit PowerPivot Plugin

Wenn Sie eine direkte Verbindung vom Rechner, auf dem Microsoft Excel und PowerPivot installiert sind, zur 
KIX Professional Datenbank nutzen möchten, muss folgende Voraussetzung erfüllt sein:

Ein ODBC-Treiber und eine konfigurierte Datenquelle für die KIX Professional Datenbank.

 

10.1.2 Installation
Installieren Sie das Paket "KPI-Dashboard" mit der "Paketverwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile.

 

<IfModule mod_perl.c>
    # Setup environment and preload modules
    Perlrequire /opt/kix/scripts/apache2-perl-startup.pl
    
    # Reload Perl modules when changed on disk
    PerlModule Apache2::Reload
    PerlInitHandler Apache2::Reload
 
    # general mod_perl2 options
    <Location /otrs>
        # ErrorDocument 403 /kix/customer.pl
        ErrorDocument 403 /kix/index.pl
        SetHandler perl-script

Bitte beachten: Die Verwendung einer ODBC-Verbindung zur KPI-Datenbankansicht wird nicht 
empfohlen, da dies die letzte flexible Möglichkeit ist, die Erweiterung "KPI-Dashboard" zu verwenden. 
Es könnte nötig sein, wenn man mit einer großen Datenmenge arbeiten muss.



Wichtig:  
Wenn Sie KIX mit mod_perl verwenden, müssen Sie sicherstellen, dass das Skript /opt/kix/bin/cgi- 
bin /KPIDashboard.pl nicht von mod_perl ausgeführt wird. Um dies zu konfigurieren, fügen Sie bitte 
die folgenden Zeilen (ab # deactivate mod_perl for KPIDashboard.pl ) dem entsprechenden Teil in 
der Apache-Konfiguration für KIX hinzu (bitte korrigieren Sie den Skriptalias "kix" entsprechend Ihrer 
aktuellen KIX Installation). Außerdem muss mod_cgi aktiviert werden (a2enmod cgi). 
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        PerlResponseHandler ModPerl::Registry
        Options +ExecCGI
        PerlOptions +ParseHeaders
        PerlOptions +SetupEnv
        Order allow,deny
        Allow from all
    </Location>
 
    # mod_perl2 options for GenericInterface
    <Location /kix/nph-genericinterface.pl>
        PerlOptions -ParseHeaders
    </Location>
 
    # deactivate mod_perl for KPIDashboard.pl
    <Location /kix/KPIDashboard.pl>
        SetHandler cgi-script
    </Location>
</IfModule>

Bitte beachten: In einigen älteren Apache Versionen und Linux Distributionen müssen Sie "perl- 
script" mit "cgi-script" ersetzen, wenn Sie eine Fehlermeldung beim Laden des Datenstromes haben.
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10.2 Konfiguration Zusatzmodul KPI-Dashboard
Wenn Sie das Paket installiert haben, können Sie bei Bedarf im Admin-Bereich/SysConfig die Standardwerte 
einstellen. Wählen Sie dazu die SysConfig-Gruppe "KPI-Dashboard".  

Nachdem die Seite neu geladen wurde, wählen Sie eine der Untergruppen "Core".

 
Eine Standard-Konfiguration ist bereits im Paket enthalten. Sie können diese nach ihren Wünschen 
anpassen. In den folgenden Abschnitten werden die SysConfig-Einstellungen erklärt.

 

10.2.1 KPI Bereich - Analysierte Jahre
SysConfig-Einstellung: KPIDashboard###ShownYears

Mit dieser Einstellung legen Sie die Anzahl der Jahre fest, die für den KPI-Report analysiert werden sollen.  
Der Standardwert "3" bedeutet, dass das laufende Jahr und die zwei letzten Jahre analysiert werden.

10.2.2 Die Standard Dashboard-Datei
SysConfig-Einstellung: KPIDashboard###TemplateXML
SysConfig-Einstellung: KPIDashboard###TemplateODBC

Diese Einstellung legen den Ort der Dateien für die Dashboard-Vorlagen fest. Wenn diese Einstellung 
eingestellt werden, ist es nicht notwendig die KPI-Datenbank neu aufzubauen.

•

Bitte beachten: Wenn Sie eine der Einstellungen geändert haben und vorbereitete KPI-Daten nutzen, 
müssen Sie das KIX Konsole Kommando :

Maint::KPIDashboard::Rebuild

ausführen, um die gesamte KPI-Datenbank neu zu erstellen. 



Bitte beachten: Diese Einstellung ist nur anwendbar auf KPI-Dashboards, die nicht auf Suchvorlagen 
basieren.



Achtung: Bitte nur ändern, wenn unbedingt notwendig.
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10.2.3 Statustyp Einschränkung
SysConfig-Einstellung: KPIDashboard###StateTypes 

Mit dieser Einstellung können Sie die Tickets, die analysiert werden, nach ihrem Status einschränken. Im 
Standard werden nur Tickets im Status "geschlossen" analysiert. Bei Bedarf können Sie hier weitere 
Ticketstatus hinzufügen.

 

10.2.4 Archiv-Markierung Einschränkung
SysConfig-Einstellung: KPIDashboard###ArchiveFlags

Mit dieser Einstellung legen Sie fest, welche Archiv-Markierung die Tickets haben müssen, damit sie in die 
Analyse für die KPI-Datenbank mit einbezogen werden. Im Standard werden alle Tickets, archiviert oder nicht, 
in die Analyse mit einbezogen.

 

10.2.5 Ignorierte Queues
SysConfig-Einstellung: KPIDashboard###IgnoredQueues

Mit dieser Einstellung legen Sie fest, welche Queues ignoriert werden sollen, wenn Tickets für die KPI- 
Datenbank analysiert werden.  
Diese Einstellung ist eine Liste. Jeder Eintrag kann ein Suchmuster (regex) enthalten.  
 

Bitte beachten: Diese Einstellung ist nur anwendbar auf KPI-Dashboards, die nicht auf Suchvorlagen 
basieren.



Bitte beachten: Diese Einstellung ist nur anwendbar auf KPI-Dashboards, die nicht auf Suchvorlagen 
basieren.



Bitte beachten: Diese Einstellung ist nur anwendbar auf KPI-Dashboards, die nicht auf Suchvorlagen 
basieren.
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10.2.6 Ignorierte Tickettypen
SysConfig-Einstellung: KPIDashboard###IgnoredTicketTypes

Mit dieser Einstellung legen Sie fest, welche Tickettypen ignoriert werden sollen, wenn Tickets für die KPI- 
Datenbank analysiert werden.  
Diese Einstellung ist eine Liste. Jeder Eintrag kann ein Suchmuster (regex) enthalten.  
 

10.2.7 Ignorierte Services
SysConfig-Einstellung: KPIDashboard###IgnoredServices

Mit dieser Einstellung legen Sie fest, welche Services ignoriert werden sollen, wenn Tickets für die KPI- 
Datenbank analysiert werden.  
Diese Einstellung ist eine Liste. Jeder Eintrag kann ein Suchmuster (regex) enthalten.  
 

10.2.8 Ignorierte SLAs
SysConfig-Einstellung: KPIDashboard###Ignored SLAs

Mit dieser Einstellung legen Sie fest, welche SLAs ignoriert werden sollen, wenn Tickets für die KPI- 
Datenbank analysiert werden.  
Diese Einstellung ist eine Liste. Jeder Eintrag kann ein Suchmuster (regex) enthalten.  
 

Bitte beachten: Diese Einstellung ist nur anwendbar auf KPI-Dashboards, die nicht auf Suchvorlagen 
basieren.



Bitte beachten: Diese Einstellung ist nur anwendbar auf KPI-Dashboards, die nicht auf Suchvorlagen 
basieren.



Bitte beachten: Diese Einstellung ist nur anwendbar auf KPI-Dashboards, die nicht auf Suchvorlagen 
basieren.
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10.2.9 Eskalationsbasis
SysConfig-Einstellung: KPIDashboard###EscalationBase

Diese Einstellung legt fest, welche Basis für die Eskalationsdaten bei der KPI-Analayse genutzt werden sollen 
(Bspw. Lösungszeit).

Sie können hier abhängig von Ihrer Konfiguration und Ihrem Ticket-Prozess aus drei unterschiedlichen 
Werten wählen:

Option Beschreibung

Alle Alle Tickets werden analysiert. Wenn ein Ticket mit einem SLA verknüpft 
ist, werden die Eskalationszeiten basierend auf den SLA-Einstellungen 
berechnet. Wenn ein Ticket nicht mit einem SLA verknüpft ist, werden die 
Queue-Einstellungen zur Analyse benutzt.

nur Queue Es werden nur Tickets analysiert, die nicht mit einem SLA verknüpft 
sind.Die Eskalationszeiten werden basierend auf den Queue- 
Einstellungen berechnet.

nur SLA Es werden nur Tickets analysiert, die mit einem SLA verknüpft sind. Die 
Eskalationszeiten werden basierend auf den SLA-Einstellungen 
berechnet.
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10.2.10 Eskalations-Zeitbasis
SysConfig-Einstellung: KPIDashboard###EscalationTimeBase

Diese Einstellung legt fest, welche Eskalationszeiten benutzt werden sollen, um das KPI-Attribut "OutOfSLA" 
zu berechnen. In der Standardeinstellung wird für die Berechnung die Lösungszeit benutzt.

Sie können aus drei unterschiedlichen Werten wählen:

Option Beschreibung

Alle Das Attribut "OutofSLA" wird gesetzt, wenn eine der Ticket- 
skalationszeiten erreicht ist.

nur Reaktionszeit Das Attribut "OutofSLA" wird gesetzt, wenn nur die 
Reaktionszeit erreicht ist.

nur Lösungszeit Das Attribut "OutofSLA" wird gesetzt, wenn nur die 
Lösungszeit erreicht ist.

10.2.11 Datenstrom - Verzeichnis für die Datenaufbereitung
SysConfig-Einstellung: KPIDashboard###DataStreamPreparedDataDir

Diese Einstellung legt das Verzeichnis im lokalen Dateisystem fest, in dem die aufbereiteten Daten 
gespeichert werden sollen.

 

10.2.12 Datenstrom - Dynamische Felder
SysConfig-Einstellung: KPIDashboard###DataStreamIncludeDynamicFields

Mit dieser Einstellung können sie festlegen, ob Dynamische Felder bei der Auswahl der Datenstrom-Attribute 
verfügbar sein sollen. Der Standardwert ist "Ja".
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10.2.13 Liste der verfügbaren Ticket-Attribute
SysConfig-Einstellung: KPIDashboard###TicketAttributes

Diese Einstellung definiert die Liste der verfügbaren Attribute des Ticket-Datenhashs (einschließlich der 
erweiterte Ticket-Attribute). Alle konfigurierten Einträge sind in der Attributauswahl bei der Dashboard- 
Administration aufgelistet. "Schlüssel" ist das Ticket-Datenhash-Attribut und "Inhalt" der Name des Elements 
im Datenstrom.  
 

10.2.14 Liste der verfügbaren KPI-Attribute
SysConfig-Einstellung: KPIDashboard###KPIDataAttributes

Diese Einstellung definiert die Liste der verfügbaren KPI-Attribute des berechneten KPI-Datenhash. Alle 
konfigurierten Einträge sind in der Attributauswahl bei der Dashboard-Administration aufgelistet. "Schlüssel" 
ist das KPI-Datenhash-Attribut und "Inhalt" der Name des Elements im Datenstrom. Diese Konfiguration kann 
durch KPI-Dashboard Plugins erweitert werden, wenn die SysConfig-Einstellung 
"KPIDashboard::KPIDataAttributesExtension###..." genutzt wird.

 

10.2.15 Liste der standardmäßig ausgewählten Attribute
SysConfig-Einstellung: KPIDashboard###DefaultSelectedAttributes

Definiert die Liste der Attribute, die bei der Erstellung eines neuen Dashboards standardmäßig ausgewählt 
werden sollen.  
Bitte beachten: Der Eintrag bei "Schlüssel" muss identisch zu den Einträgen im Feld "Schlüssel" in den 
Konfigurationsoptionen "KPIDashboard###TicketAttributes" und "KPIDashboard###KPIDataAttributes" sein. 
Der Eintrag im Feld "Inhalt" muss "0" (nicht ausgewählt) oder "1" (ausgewählt) sein.

 

Wichtig: Ein Element der Liste muss mit einem Buchstaben beginnen und darf keine Leerzeichen 
oder Sonderzeichen beinhalten.



Wichtig: Ein Element der Liste muss mit einem Buchstaben beginnen und darf keine Leerzeichen 
oder Sonderzeichen beinhalten.



Wichtig: Diese Konfiguration kann durch KPI-Dashboard Plugins erweitert werden, wenn die 
SysConfig Option "KPIDashboard::KPIDataAttributesExtension###..." genutzt wird.
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10.2.16 Datenbank-Sicht
SysConfig-Einstellung: KPIDashboard###DBView

Diese Einstellung definiert die Datenbank-Sicht, welche die primären KPI-Daten enthält.

 

10.2.17 Liste der verfügbaren Datenbank-Sichtattribute
SysConfig-Einstellung: KPIDashboard###DBViewAttributes

Diese Einstellung enthält alle verfügbaren Attribute der berechneten KPI-Daten in der KPI-Datenbankansicht. 
Alle konfigurierten Einträge werden in der Attribut-Auswahl bei der Dashboard-Administration gelistet. Der 
Eintrag im Feld "Schlüssel" ist der Spaltenname der Datenbank-Sicht. Der Eintrag im Feld "Inhalt" repräsentiert 
den Namen des Elements im Datenstrom. Wichtig: Ein Element der Liste muss mit einem Buchstaben 
beginnen und darf keine Leerzeichen oder Sonderzeichen beinhalten.

 

10.2.18 Symbole für den OutOfSLA Prozentsatz
SysConfig-Einstellung: KPIDashboard###OutOfSLAPercentage

Diese Einstellung definiert die verwendeten Symbole für einzelne Prozentwerte in der Übersichtstabelle des 
Online-KPI-Dashboard. 
 

10.2.19 Einstellungen für die Elemente im Online-KPI-Dashboard
SysConfig-Einstellungen:

KPIDashboardBackend###-0000-FirstSolutionRate
KPIDashboardBackend###-0001-IncidentDurationTopTen
KPIDashboardBackend###-0002-IncidentDuration
KPIDashboardBackend###-0003-OutOfSLA
KPIDashboardBackend###-0004-Overview
KPIDashboardBackend###-0005-QueueMove
KPIDashboardBackend###-0006-TicketTrendBasedOnTicketType
KPIDashboardBackend###-0010-Filters

 
Diese SysConfig-Einstellungen beschreiben die im Online-KPI-Dashboard verfügbaren Elemente und legen die 

Bitte beachten: Diese Einstellung wird von KPI-Dashboards ignoriert, die auf Suchvorlagen basieren.
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Einstellungen für ein Element fest. Dabei bedeuten die Werte in den Feldern "Schlüssel" und "Inhalt" jeweils 
Folgendes: 
 

Schlüssel Beschreibung des Feldes "Inhalt"

Block ContentLarge oder ContentSmall.

CacheTTLLocal Cache-Zeit für das Plugin in Minuten.

Default Legt fest, ob das Plugin per Standard aktiv ist oder ob der Benutzer es

Description manuell aktiv schalten muss.

Group Beschreibung des Elements.

Module Schränkt den Zugriff auf die eingegebenen Gruppen ein.

Title Der Titel, der im Online-Dashboard angezeigt wird.

Type Benutzte Javascript-Funktion um die Anzeigedaten zu generieren.

10.2.20 Erklärung der Standard KPI-Daten
In der folgenden Tabelle finden Sie Beschreibungen der KPI-Attribute des Standard KPI-Datenhash. Der KPI- 
Datenhash kann bei Bedarf mit benutzerdefinierten Berechnungsmodulen erweitert werden. Nicht in der 
Tabelle enthalten sind die Ticket-Hash Attribute, weil es sich dabei um grundlegende KIX-Attribute handelt, 
die nicht Teil der KPI-Dashboard Erweiterung sind.

KPI Attribut Beschreibung

Calendar week Kalenderwoche, in der das Ticket erzeugt wurde.

FirstResponseTimeTotal Gesamte Zeitspanne in Minuten zwischen Ticketerzeugung und erster 
Reaktion.

FirstResponseTimeBusiness Wert des Attributes "FirstResponseTimeTotal" abzüglich der nicht- 
relevanten Zeiten (Bspw. die Zeit, in der man auf eine Antwort des 
Kunden wartet).
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KPI Attribut Beschreibung

FirstTimeResolution Dieses Attribut wird auf "1" gesetzt, wenn ein Ticket im ersten Kontakt 
gelöst wurde. Dies bedeutet, dass es in einem geschlossenen Status 
erstellt wurde / oder es gibt nur eine ausgehende Nachricht bzw. Artikel 
(E-Mail, Telefonanruf, externe Notiz).

FirstTimeResolutionText Das ist der menschlich lesbare Inhalt des Attributes 
"FirstTimeResolution" , bspw. "yes" oder "ja" bzw. "no" oder "nein".

Month Verwendeter Monat für die Filterung des KPI-Dashboards in PowerPivot.

OutOfSLA Dieser Wert wird auf "1" gesetzt, wenn das Ticket in seinem Lebenszyklus 
eskaliert ist. Der Wert ist abhängig von der Konfiguration des KPI- 
Dashboard. (Siehe SysConfig "EscalationTimeBase").

OutOfSLAFirstResponseTime 
Business

Wenn das Attribut "OutOfSLA" = "1" ist, enthält dieses Attribut die Anzahl 
in Minuten, die "FirstResponseTimeBusiness" gegenüber 
"FirstResponse"-Eskalationszeit überschreitet. Der Wert ist abhängig von 
der Konfiguration der KPI-Dashboard.

(Siehe SysConfig "EscalationTimeBase")

OutOfSLASolutionTimeBusin 
ess

Wenn das Attribut "OutOfSLA" = "1" ist, enthält dieses Attribut die Anzahl 
in Minuten, die "SolutionTimeBusiness" gegenüber 
"FirstResponse"-Eskalationszeit überschreitet. Der Wert ist abhängig von 
des Konfiguration der KPI-Dashboard.

(Siehe SysConfig "EscalationTimeBase")

Queue_Level1..x Die Queue des Tickets wird durch " :: " aufgeteilt und jeder Teil wird als 
separate Spalte zurückgegeben.

QueueMoves Anzahl der Ticketverschiebungen in unterschiedliche Queues.

Service_Level1..x Der Service des Tickets wird durch " :: " aufgeteilt und jeder Teil wird als 
separate Spalte zurückgegeben.

SolutionTimeTotal Gesamte Zeitspanne in Minuten zwischen Ticketerzeugung und 
Ticketschließung.
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KPI Attribut Beschreibung

SolutionTimeBusiness Wert des Attributes "SolutionTimeTotal" abzüglich der nicht-relevanten 
Zeiten. (Bspw. die Zeit, in der man auf eine Antwort des Kunden wartet).

TicketPriorityTranslated Übersetzte Ticket-Priorität zur Filterung des KPI-Dashboards in 
PowerPivot.

TicketStateTranslated Übersetzter Ticket-Status zur Filterung des KPI-Dashboards in 
PowerPivot.

Year Kalenderjahr, in dem das Ticket erzeugt wurde.
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10.3 Administration Zusatzmodul KPI-Dashboard
Wenn Sie neue KPI-Dashboards erstellen wollen, oder bestehende bearbeiten möchten, wählen Sie dazu im 
Menü "Berichte" den Menüpunkt "KPI-Dashboard".  
Zum Erstellen oder Bearbeiten neuer KPI-Dashboards, muss der Benutzer Lese-/Schreibrechte für die Gruppe 
"KPI-Dashboard" haben.

Wenn Sie sich im Bereich "KPI-Dashboard" befinden, sehen Sie eine Liste der konfigurierten KPI-Dashboards 
(sofern KPI-Dashboards bereits konifguriert wurden). In der Liste wird in der Spalte "Vorbereitete Daten 

nutzen" ein  Symbol angezeigt, wenn ein KPI-Dashboard für vorbereitete Daten konfiguriert ist und 
vorbereitete Daten für dieses KPI-Dashboard verfügbar sind. Wenn keine vorbereitete Daten verfügbar sind, 

wird stattdessen ein  Symbol in der Spalte angezeigt.

 

  
 

Sie können auf das   klicken, um Dateninformationen anzuzeigen. Wenn Datenvorbereitungs-Prozesse 
im Hintergrund laufen, wird eine Fortschrittsanzeige mit einem Stopp-Symbol angezeigt.  
Wenn Sie auf das Stopp-Symbol klicken, wird die Datenvorbereitung gestoppt. Es wird einige Sekunden 

dauern, um den Prozess zu stoppen. Zusätzlich wird neben der Fortschrittsanzeige links ein   Symbol 
angezeigt.  

Wenn Sie auf das   Symbol klicken, werden in einem Popup Informationen über jeden Hintergrund-Task 
der Datenvorbereitung angezeigt. 
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Bitte beachten: Wenn beim Erstellen oder Bearbeiten von KPI-Dashboards Fehler auftreten, werden 
Meldungen in der Informationsleiste unterhalb der Menüleiste angezeigt.

10.3.1 Neue KPI-Dashboards erstellen

Wenn Sie über die Schaltfläche  ein neues Dashboard erstellen, wird folgendes Widget 
angezeigt:

 

 

"Dashboard erstellen"

Das Widget enthält folgende Optionen:
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Begriff Erklärung

Dashboard 
URL

Das ist der URL der XML-Datenstrom-Verbindung.

Name* Name des KPI-Dashboards.

Beschreib 
ung

Optional können hier Beschreibungen zum KPI-Dashboard angegeben werden.

Online- 
Dashboard 
aktivieren

 
 

Hier können Sie wählen, ob eine Onlineversion dieses KPI-Dashboards zur Verfügung 
gestellt werden soll.

Suchvorla 
ge

Diese Option ermöglicht es, eines der eigenen Ticket-Suchprofile für die Suche nach 
relevanten Tickets auszuwählen. Wenn kein Suchprofil zugeordnet werden kann, wird die 
KPI-Datenbanksicht benutzt.

Berechnun 
g KPI- 
Daten  
 

Hier legen Sie fest, ob eine Live-Berechnung der KPI-Daten genutzt werden soll, oder ob 
vorberechnete Daten benutzt werden sollen.

vorbereitet 
e Daten 
nutzen

Mit dieser Option können Sie festlegen, ob die vorbereiteten Daten verwendet werden 
sollen. (Dies erfordert, dass einige automatisierte Jobs regelmäßig die notwendigen Daten 
vorbereiten). Wenn für diese Option "Nein" gewählt wurde, werden die Daten sofort erzeugt, 
was ewöhnlich mehr Zeit in Anspruch nimmt. Die Daten sind dann aber aktuell.

Bitte beachten: Wenn Sie das Online-Dashboard verfügbar machen wollen, müssen 
Sie sicherstellen, dass Ihre Online-Konfiguration kompatibel mit dem Datensatz 
dieses Dashboards ist.



Bitte beachten: Ein Ändern dieser Option ändert ebenfalls die verfügbaren 
Attriubute in der Attributsliste. Wenn Sie die Option "vorberechnete Daten aus dem 
DB-View" wählen, werden die kalkulierten Werte entfernt und stattdessen die Werte 
aus der KPI-Datenbankansicht verwendet.
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Begriff Erklärung

#Prozesse Hier legen Sie fest, wie viele parallele Prozesse zur Berechnung der KPI-Daten verwendet 
werden sollen. Je mehr Prozesse, desto höher die Systembelastung auf dem KIX-Server. 
Wenn die zu analysierende Ticketanzahl relativ klein ist, sollte immer nur 1 Prozess genutzt 
werden. Bei höheren Ticketanzahlen, empfehlen sich mehr Prozesse.

ausgewähl 
te 
Attribute

Abhängig von der Einstellung bei "Search Template" und "KPI Data Calculation" und 
abhängig von den Einstellungen in der SysConfig, können Sie hier die Attribute wählen, die 
in den Daten enthalten sein sollen.

Rechte Damit Benutzer auf ein KPI-Dashboard zugreifen können, müssen Sie hier eine oder 
mehrere Gruppen auswählen. Benutzer mit Lese-/Schreibrecht in diesen Gruppen können 
KPI-Dashboards anschauen und bearbeiten. Nutzer mit Leserecht können KPI-Dashboards 
nur anschauen.

Anlage* Laden Sie hier die XLS-Datei hoch, die das PowerPivot-Dashboard beinhaltet. In dieser XLS- 
Datei muss die Datenverbindung gemäß Ihrer Art des Zugriffs auf die KIX-Daten (XML- 
Datenstrom oder ODBC-Verbidung) bereits konfiguriert sein. 

Mit * gekennzeichnete Felder müssen ausgefüllt werden.

10.3.2 KPI-Datenquelle in PowerPivot konfigurieren
In PowerPivot müssen Sie eine Datenquelle konfigurieren, um die KPI-Daten anzeigen zu können. Dafür 
können Sie entweder einen XML-Datenstrom oder eine ODBC-Verbindung benutzen.

 
XML-Datenstrom:  
Das ist die für Benutzung bevorzugte Datenquelle, weil keine Datenbank-Verbindung, offene Ports oder 
erweiterte Datenbanktabellen konfiguriert werden müssen um mehr Attribute zu übertragen.  

Bitte beachten: Diese Option erzeugt immer die gewählte Anzahl paralleler 
Prozesse unabhängig von der tatsächlichen physischen CPU-Anzahl ihres KIX- 
Servers. Wenn die Anzahl der Prozesse höher als die CPU-Anzahl ist, wird sich das 
massiv auf die Systemleistung während der Berechnung auswirken!



Bitte beachten: Beim Erstellen eines neuen KPI-Dasboards, werden vom System 
einige Attribute vorausgewählt. Diese Attribute sind in der SysConfig definiert. Sie 
können jederzeit zu der Standard-Einstellung zurück gelangen, wenn sie die 
Schaltfläche "Standardattribute selektieren" betätigen.
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•

•

•

Um PowerPivot mit einem XML-Datenstrom eines Dashboards zu verbinden, müssen Sie in PowerPivot die 
Datenquelle angeben.  
Nutzen Sie zur Einbindung des XML-Datenstroms in PowerPivot den folgenden URL: 
 

http://<FQDN KIX Server>/kix/KPIDashboard.pl?DashboardToken=<Token> 

 
Den zu benutzenden Token finden Sie in der Liste der konfigurierten Dashboards. Für jedes neue KPI- 
Dashboard wird ein zufälliger Token generiert. Der Token wird benutzt, um das spezifische KPI-Dashbord im 
URL zu identifizieren.

 

 
Wenn Sie HTTPS-Verbindungen nutzen, müssen Sie den URL entsprechend ändern.  
 
ODBC:  
Die ODBC-Verbindung kann verwendet werden, wenn XML-Datenströme nicht benutzt werden können. Es 
erlaubt Ihnen, Daten aus der KIX-Datenbank direkt in PowerPivot zu übertragen. Das hat einige Vorteile 
hinsichtlich der Performance. Nachteilig ist dabei aber, dass in der Regel Firewall-Ports geöffnet werden 
müssen, damit man Zugriff auf das DBMS erhält. Informationen darüber, wie sie eine ODBC-Datenquelle 
erstellen, finden sie in Ihrer Excel-Dokumentation.

10.3.3 Vorbereitung der Datenströme
Wenn Sie KPI-Dashboards mit der Option "Aufbereitete Daten nutzen" konfiguriert haben, müssen Sie 
sicherstellen, dass die notwendigen Datenströme im Hintergrund vorbereitet werden. Für die Nutzung der 
Daten in PowerPivot ist ein XML-Datenstrom nötig. Für die Nutzung der Daten im Online-KPI-Dashboard ist 
ein JSON-Datenstrom nötig. Zur Vorbereitung der Daten gibt es drei Möglichkeiten:

 

Vorbereitung der Daten in der KIX-GUI

Vorbereitung der Daten mittels KIX-Konsolenscript

Vorbereitung der Daten mittels cronjobs

 



KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul KPI-Dashboard

Administration Zusatzmodul KPI-Dashboard

Erstellt am: 19.01.2022                                                                   Seite 181
 

10.3.4 Datenstrom mit KIX-GUI vorbereiten
Wenn Sie für ein KPI-Dashboard die Berechtigung zur Bearbeitung haben und es so konfiguriert ist, dass 

vorbereitete Daten genutzt werden, wird in der Liste der konfigurierten KPI-Dashboards ein  Symbol 

angezeigt. Wenn Sie auf das  Symbol klicken, wird die Datenvorbereitung im Hintergrund gestartet. 
 

Nach dem die Datenvorbereitung gestartet wurde, sehen Sie in der Liste eine Fortschrittsanzeige mit einem  
 Symbol. Wenn Sie auf das  Symbol klicken, wird die Datenvorbereitung gestoppt. Es wird einige Zeit 

dauern, bis der Prozess gestoppt wird.  

Zusätzlich wird neben der Fortschrittsanzeige ein   Symbol angezeigt. Wenn Sie auf das   Symbol 
klicken, werden in einem Popup Informationen über jeden Hintergrund-Task der Datenvorbereitung 
angezeigt.

 

10.3.5 Datenstrom mit KIX-Konsolenscript vorbereiten
Nutzen Sie dazu das Konsolenkommando:

Maint::KPIDashboard::Prepare 

 
Wenn Sie dieses Kommando ohne Parameter aufrufen, wird ein XML-Datenstrom und ein JSON-Datenstrom 
für jedes KPI-Dashboard erstellt, dass eine Vorbereitung benötigt. Es werden so viele parallele Prozesse 
genutzt, wie bei der Erstellung des KPI-Dashboards angegeben.

Optional können Sie den Parameter "--type" mit den Werten "XML" oder "JSON" angeben, um das gewünschte 
Datenformat vorzubereiten.

 

10.3.6 Datenstrom mit cronjobs vorbereiten
Wenn Sie Daten regelmäßig vorbereiten, können Sie dafür einen Cronjob definieren. Die nötige Cronjob- 
Vorlage ist bereits im Verzeichnis var/cron installiert.
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10.4 Daten-Plugins für KPI-Dashboard
Der KPI-Dashboard-Kern ermöglicht es, mit Plugin-Modulen die verfügbaren KPI-Daten zu erweitern und/oder 
zu überschreiben.

Diese Plugin-Module müssen in der SysConfig registriert werden (SysConfig-Schlüssel "KPIDashboard :: 
CustomModule"). Die Plugin-Module müssen im Pfad /opt/kix/Kernel/System/KPIDashboard/ liegen. Das 
Plugin-Modul muss nur zwei Methoden zur Verfügung stellen: "new" and "Run".

Die Methode "Run" erhält zwei Parameter:

"TicketID" und "Data"

und muss einen Hash zurückgeben mit Daten-Attributsschlüssen und Werten. Der Parameter "Data" enthält 
die bereits für ein Ticket berechneten KPI-Daten. Die Liste der neuen Attribute eines Plugin-Moduls kann mit 
SysConfig-Erweiterungen verfügbar gemacht werden (siehe SysConfig-Schlüssel 
"KPIDashboard###KPIDataAttributes" und "KPIDashboard###DefaultSelectedAttributes" ).



KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul KPI-Dashboard

Online KPI-Dashboard

Erstellt am: 19.01.2022                                                                   Seite 183
 

10.5 Online KPI-Dashboard
Das Online-KPI-Dashboard bietet die Möglichkeit, die Standard-Diagramme ohne die Verwendung von 
PowerPivot anzuzeigen. Es funktioniert wie das Standard-Ticketdashboard. Jedes Dashboard-Element ist ein 
einzelnes Widget, das in der SysConfig-Gruppe "Frontend::Agent::OnlineDashboard" aktiviert / deaktiviert 
werden kann. Zusätzlich können Agenten das Widget für sich persönlich ein- / ausschalten.

10.5.1 Das Online-KPI-Dashboard öffnen
Das Online-KPI-Dashboard ist nur verfügbar, wenn es im Widget "KPI-Dashboard erstellen" dafür konfiguriert 
wurde.

 

  
Abb.: Widget "KPI-Dashboard erstellen"  
 
 

Wenn ein Online-KPI-Dashboard verfügbar ist, wird in der Liste der verfügbaren Dashboards ein  Symbol 
angezeigt. Ein Klick auf das  Symbol öffnet das Online-KPI-Dashboard. 

Es öffnet sich ein neuer Browser-Tab und das Online-KPI-Dashboard öffnet sich. Ein kleines Popup informiert 
den Anwender darüber. Es wird angezeigt, solange die Datenverarbeitung läuft.

Wenn das Online-KPI-Dashboard vorbereitete Daten nutzt, wird der gesamte JSON-Datenstrom in den 
Browser geladen. Wenn das Online-KPI-Dashboard so konfiguriert ist, dass keine vorbereiteten Daten genutzt 
werden, startet die Datenberechnung. Der JSON-Datenstrom wird danach in den Browser geladen.

Bitte beachten: Weil der komplette JSON-Datenstrom in den Browser geladen wird, kann es ein paar 
Minuten dauern, bis das Laden der Daten abgeschlossen ist. Zusätzlich erhöht sich der 
Speicherbedarf des Browsers signifikant.
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10.5.2 Einstellungen für das Online-KPI-Dashboard
Die Daten im Online-KPI-Dashboard werden in Widgets dargestellt. Im linken Bereich des Browsers befindet 
sich das Widget "Einstellungen". Hier sind alle Widgets gelistet, die vom KIX-Administrator aktiviert worden 
sind.

 

 

 

Abb.: Widget "Einstellungen"  
 
Hier können Agenten die Widgets nach Ihren Vorlieben ein-/ausblenden und die Einstellung speichern. Jedes 
Widget hat eine vordefinierte Position auf dem Bildschirm, können aber via Drag&Drop verschoben werden. 
Die Position der Widgets wird beim Ausloggen aus KIX gespeichert.
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10.5.3 Filter für das Online-KPI-Dashboard
Wenn aktiv, wird das Widget "Filter" im linken Bereich des Browers angezeigt. Damit können die Daten im 
Online-KPI-Dashboard gefiltert dargestellt werden.

 

 

 

Abb.: Widget "Filter"  
 
Welche Attribute gefiltert werden, wird in der SysConfig-Einstellung "KPIDashboardBackend###010-Filters" 
festgelegt. Die Filterattribute finden Sie im Schlüssel "Filters".

Die im Filter angezeigten Werte werden live aus dem JSON-Datenstrom übernommen und repräsentieren alle 
möglichen Werte im aktuellen Datenstrom. Alle aktiven Filter sind untereinander mit einem logischen UND 
verknüpft.

Nach dem Laden des Online-KPI-Dashboards sind keine Filter gesetzt. Um Daten zu filtern, wählen Sie im 
Widget "Filters" die entsprechenden Werte im jeweiligen Filter und klicken Sie auf "Anwenden".
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11 Zusatzmodul MRO Bundle
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•
•
•
•
•

11.1 Einführung
Dieses Handbuch richtet sich an Administratoren, die mit KIX Professional MRO (Maintenance, Repair, 
Overhaul) arbeiten werden.

Die Software  unterstützt als Standardsystem Ihren gesamten Instandhaltungs- und Wartungsprozess für 
Gebäudetechnik, Maschinen, Anlagen, Werkzeuge und tangierendes Equipment. 

Betriebssicherheit und -abläufe werden übersichtlicher. Sämtliche Vorgänge, die im Rahmen der 
regelmäßigen Zertifizierungen (TÜV, ISO) notwendig sind, werden erleichtert.

 

Folgende servicetypische Grundfunktionen stehen Ihnen u. a. direkt nach der Installation zur Verfügung

Gerätedatenbank / CMDB
Auftragsmanagement
Workflow Managament
Wartungsplaner
Berichtswesen

 
Ergänzend zu diesem Handbuch finden Sie weitere Dokumentationen unter: www.kixdesk.com1

http://www.kixdesk.com
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11.2 Hinweise zum Arbeiten mit KIX MRO

11.2.1 Bezeichnungen
Um die Software allgemein verständlich zu halten, wurden IT gebräuchliche Begriffe umbenannt.

 

Alte Bezeichnung Neue Bezeichnung 

Incident Wartung (reaktiv)

WideSpreadIncident Flächenstörung

Incident Major -

Service Request Allg. Anfrage

Problem -

CMDB Objektdatenbank

CI Objekt

Wartungs-CI Wartungsobjekt

Wartungs-CI-Klasse Wartungsobjektklasse

Wartungs-CI-Kontakt Kontakt Wartungsobjekt

Maintenance Wartung (geplant)

CI Daten Objektdaten

CI Admin Module Admin Module Objekt

Deployment State Verwendungsstatus

Queue Team

Ticket Auftrag
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•

•

Hinweis

Aus technischen Gründen werden im Admin Modul weiterhin beide Bezeichnungen 
verwendet.

Wenn das Wording in der Agenten-Oberfläche Fehler aufweist, befolgen Sie die Maßnahmen 
in der Installationsanleitung.
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11.3 Installation
Um KIX MRO zu nutzen, muss bereits ein KIX  auf Ihrem System installiert sein. Sollte das nicht der Fall sein, 
finden Sie die jeweilige Installationsanleitung auf www.kixdesk.com.

11.3.1 Installation unter debian / ubuntu
Fügen Sie bitte folgende Zeile zu Datei /etc/apt/sources.list hinzu:

deb http://packages.kixdesk.com/customers/xxxxxxxxxxx/debian kixpro2017 stable 

 

Nachdem Sie Ihr persönliches Repository eingebunden und die Voraussetzung erfüllt haben, installieren Sie 
KIX MRO wie folgt:

apt-get update 
apt-get install kixpro kixpro-bundle-mro

11.3.2 Installation unter OpenSUSE / SLES
Fügen Sie das Repository von KIX Professional hinzu:

zypper addrepo http://packages.kixdesk.com/customers/xxxxxxxxxxx/suse/kixpro2017/ 
stable kixpro

 

 Nachdem Sie Ihr persönliches Repository eingebunden und die Voraussetzung erfüllt haben, installieren Sie 
KIX MRO wie folgt:

zypper refresh
 
zypper install kixpro kixpro-bundle-mro

11.3.3 Installation unter CentOS / Red Hat
Erstellen Sie eine neue Repository-Datei /etc/yum.repos.d/kixpro.repo mit folgendem Inhalt:
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[kixpro] 
name=kixpro 
baseurl=http://packages.kixdesk.com/customers/xxxxxxxxxxx/redhat/kixpro2017/stable
gpgcheck=1 
enabled=1 
gpgkey= proxy=_none_

Nachdem Sie Ihr persönliches Repository eingebunden und die Voraussetzung erfüllt haben, installieren Sie 
KIX MRO wie folgt: 
 

yum check-updates 
yum install kixpro kixpro-bundle-mro
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11.3.4 Hinweise zum Upgrade
Bei allen Versionen kleiner KIX 17.7, die ein Upgrade auf eine höhere Version erhalten, müssen Sie folgendes 
beachten:

Um ausgewählte Werte von zugeordneten Objekten an Tickets zu übertragen, wurde das Paket 
"DFITSMConfigItemReferenceFetchCIAttributes2" integriert. Liefert das Objekt mehrere Attributwerte, so wird 
nur der erste Attributwert übernommen.

Für die Objekt-Klassen "Computer", "Hardware" und "Network" besteht nun die Möglichkeit, einem Objekt 
einen Standort zu zu ordnen. Diese Objekt-Klassen wurden um das optionale Attribut "Location" erweitert.

Wenn Sie Sysconfig-Schlüssel selbst angepasst haben, eigenständig Übersetzungen hinzugefügt oder eigene 
Felder in der Ticketinfo-Sidebar angelegt haben, überprüfen Sie diese manuell auf das neue Wording. Treten 
Fehler in der Oberfläche auf, ist das ein Hinweis, dass ggf. noch SysConfig-Schlüssel angepasst werden 
müssen. Kontrollieren Sie dafür Ihre ZZZAuto.pm im Config-Verzeichnisses Ihres KIX auf "alte" Begriffe. Dort 
finden Sie auch den Hinweis auf die anzupassenden SysConfig-Schlüssel.

Durch das neue Wording wird die Übersetzung für den Tickettyp "Incident" in "Wartung (reaktiv)" ausgeliefert. 
An manchen Stellen in der Oberfläche wird der Tickettyp jedoch nicht übersetzt (Beispiel: Sidebar). Möchten 
Sie auch dort auf ein einheitliches Wording nicht verzichten,  sollten Sie die Bezeichnung des betroffenen 
Tickettyps im Adminbereich anpassen. Das hat allerdings Einfluss auf bereits vorhandene ACLs und 
Workflows. Diese müssten dann an den Stellen, wo dieser Tickettyp Verwendung findet, im Nachgang 
ebenfalls angepasst werden. 

•

•

Hinweis

Objekt-Klassendefinitionen, die nicht im bisherigen Auslieferungszustand vorliegen (wenn z. 
B. mehr als eine Version der Objekt-Klassendefinition vorhanden ist), werden durch das 
Update NICHT geändert. Dies muss durch den Admin selbst manuell erfolgen.
Objekt-Klassendefinitionen, die nicht existieren, werden durch das Update nicht angelegt.



Fazit

Alle selbst vorgenommenen Anpassungen/Ergänzungen/Erweiterungen müssen geprüft und 
manuell nach gezogen werden.



http://git.intra.cape-it.de/Customerprojects/Generic/DFITSMConfigItemReferenceFetchCIAttributes
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11.4 Die Bestandteile des KIX MRO Bundles
KIX MRO beinhaltet die Module Kanban Board, Wartungsplaner und Field Service sowie einige spezifische 
MRO Erweiterungen.
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•

•

11.4.1 Kanban Board
Die digitale Weiterentwicklung der Post-it-Wand: Visualisieren Sie Ihre Arbeitsaufgaben und schaffen Sie sich 
Ihre individuelle Organisations- und Projektstruktur.

Ermöglicht die optimale Einsatzplanung durch schnelle und individuell einstellbare Zuordnung von 
Aufgaben
Permanenter Überblick über Verfügbarkeit und Auslastung Ihrer Mitarbeiter

Weitere Informationen sowie Konfigurationsmöglichkeiten finden Sie auf www.kixdesk.com.
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•
•

•

•

11.4.2 Wartungsplaner
Instandhaltung und Wartung dienen der möglichst langfristigen Nutzung und Planung Ihres technischen 
Equipments. Durch regelmäßige, planbare und ereignisbasierte Wartungen minimieren Sie Geräte- und 
Maschinenstillstandszeiten.

Unterstützt werden zyklische und schwellwertbasierte Wartungen
Für jeden Wartungsplan sind Vorlagen (bspw. Checklisten) oder Wartungsverträge hinterlegbar 
(papierlose Dokumentation)
Entsprechend der Wartungspläne erstellt das System automatisch die passenden Wartungsaufträge 
für das Equipment und die Teams
Sie erhalten einen Überblick über alle Termine durch die Darstellung der Wartungsaufträge in einem 
Kalender

Weitere Informationen sowie Konfigurationsmöglichkeiten finden Sie auf www.kixdesk.com3.

http://www.kixdesk.com


KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul MRO Bundle

Die Bestandteile des KIX MRO Bundles

4 http://www.kixdesk.com

Erstellt am: 19.01.2022                                                                   Seite 196
 

•
•
•
•

•
•
•
•

11.4.3 Field Service
Erleichterung der Verwaltung, der Planung und der Bearbeitung von Aufträgen im technischen Außendienst. 
Der Field Service optimiert alle Arbeitsschritte vom Dispatching bis hin zur abschließenden Dokumentation.

Tourenplanung und -verwaltung in einem übersichtlichen Kanban-Board
Kartendarstellung örtlich verteilter Arbeitsaufträge und Störungsmeldungen
Durchgehend papierlose Dokumentation der Entstör-, Wartungs-/Instandhaltungsaufträge
Intuitive Field Service-App für Android-basierte Mobilgeräte inklusive:

Offline-Modus mit automatischer Synchronisation,
Checklisten-Funktion
Digitaler Unterschrift und 
Mehrfacher Verschlüsselung

Weitere Informationen sowie Konfigurationsmöglichkeiten finden Sie auf www.kixdesk.com4. 

http://www.kixdesk.com
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11.4.4 KIX MRO Erweiterungen
Nachdem Sie das MRO-Bundle installiert haben, können Sie die grundlegenden Parameter dieses 
Erweiterungspakets bei Bedarf anpassen.

Um die Erweiterung zu konfigurieren, öffnen Sie "SysConfig" im Admin-Bereich. Wählen Sie die SysConfig- 
Gruppe „MROExtensions“. Eine Standardkonfiguration ist bereits im Paket enthalten. Sie können diese nach 
Belieben ändern. In den folgenden Abschnitten werden die relevanten SysConfig-Optionen aufgelistet.

11.4.4.1 Generierung des CI-Namens

Die automatische Erstellung eines CI-Namens ist standardmäßig für alle neuen CIs der Klasse "CostCenter" 
aktiviert.

Event-Handler Registrierung

SysConfig ITSMConfigItem :: EventModulePre # ## 
200-GenerateNameFromAttributes

Registrierung des CI Event 
Handlers.

Event-Handler Konfiguration

SysConfig MRO :: 
GenerateNameFromAttributes 
###... 

Diese Konfigurationsoptionen sind erforderlich, 
wenn Sie den Event-Handler verwenden. In den 
Beschreibungen erfahren Sie, was zu tun ist 
und wie Sie es konfigurieren.

11.4.4.2 CI-Nummer aus eindeutigem Attribut generieren

Die automatische Erstellung einer eindeutigen CI-Nummer auf der Grundlage eines eindeutigen Attributwerts 
eines neuen CI wird standardmäßig für alle neuen CIs der Klasse „CostCenter“ aktiviert.

Event-Handler Registrierung

SysConfig ITSMConfigItem :: EventModulePost ### 
100-SetCINumberByUniqueAttribute

Registrierung des CI Event 
Handlers.

Hinweis

Bitte beachten Sie: Wenn Sie den Namen eines neuen CIs nicht automatisch erstellen möchten, 
deaktivieren Sie diese Registrierungsoption.
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Event-Handler Konfiguration

Sy 
sC 
on 
fig

MRO :: 
SetCINumberByUniqueAttr 
ibute :: ...         

 Diese Konfigurationsoptionen sind bei Verwendung des Event- 
Handlers erforderlich. In den Beschreibungen erfahren Sie, was zu tun 
und wie Sie konfigurieren müssen.

Hinweis

Bitte beachten Sie: Wenn Sie die CI-Nummer nicht automatisch aus einem Attribut eines neuen CI 
erstellen möchten, deaktivieren Sie diese Registrierung.
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12 Zusatzmodul Security Management
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12.1 Allgemeines zu Security Management
Security Management ermöglicht es, die CMDB von KIX (als führendes System), so weit möglich in externen 
Security-Managment-Systemen (z.B. verinice.PRO) abbilden zu können. Daraufhin kann der 
Sicherheitsbeauftragte, welcher das externe System nutzt, beispielsweise den IT-Grundschutz auf die 
übertragenen CIs anwenden.

Mit Hilfe der REST-Schnittstelle von verinice.PRO und KIX werden die umzusetzen Maßnahmen, die zur 
Einhaltung des Grundschutzes notwendig sind, anschließend als einzelne Tickets in KIX erfasst.

Diese Tickets kann dann die IT-Abteilung, welche wiederum KIX verwendet, entsprechend bearbeiten und die 
dazugehörigen Maßnahmen umsetzen und sowie am Ticket protokollieren.

Dadurch wird der Prozess der Zusammenarbeit beider Abteilungen im Unternehmen unterstützt und eine 
saubere und strukturierte Übergabe sowie Dokumentation der Aufgaben gewährleistet.

 

Das Modul unterstützt die folgenden drei Perspektiven in verinice.PRO durch die bereits integrierten 
Backends. Es ist möglich mehrere Backends gleichzeitig zu verwenden.

 

Perspektive Verantwortliches Backend

BSI-Grundschutz BSI

Information Security Management ISM

Modernisierter BSI-Grundschutz BSIModern

 

 

Bitte beachten:

Für die Anzeige der Maßnahmen-Beschreibungstexte aus verinice.PRO (Perspektive „BSI-Grundschutz“) im 
Artikel-Inhalt werden die relevanten Text-Daten bereits mitgeliefert. Diese stammen aus der „15. 
Ergänzungslieferung“ des IT-Grundschutz-Katalogs, der ebenfalls in verinice.PRO verwendet werden sollte 
(der Katalog kann kostenlos von „verinice.com5“ heruntergeladen werden).

Sollte es eine aktuellere Version geben (nicht das „IT-Grundschutz-Kompendium“, dieses ist für den 
modernisierten BSI-Grundschutz), können die neuen Texte verwendet werden, indem der aktualisierte 

http://verinice.com
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Katalog entpackt (zip) und der enthalte „m“-Ordner in „kix-home/SecurityManagement/var/verinice_BSI“ 
abgelegt wird.
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•

•

12.2 Installation von Security Management

12.2.1 Voraussetzungen
KIX Professional 17.x - gleicher Major- und Minor-Version wie SecurityManagement. Hat Ihr Security 
Management die Version 17.11.1, so muss mindestens ein KIX Professional 17.11.0 installiert sein.
verinice.PRO 1.2x mit entsprechender REST-API ist vorhanden

12.2.2 Paket Installation
Installation unter Debian / Ubuntu
Fügen Sie bitte folgende Zeile zu Datei /etc/apt/sources.list hinzu:

deb http://packages.kixdesk.com/customers/xxxxxxxxxxx/debian kixpro2017 stable

Nachdem Sie Ihr persönliches Repository eingebunden und die Voraussetzung erfüllt haben, installieren Sie 
Security Management wie folgt:

apt-get update apt-get install kixpro-security-management

Installation unter OpenSUSE / SLES
Fügen Sie das Repository von KIX Professional hinzu:

zypper addrepo http://packages.kixdesk.com/customers/xxxxxxxxxxx/suse/kixpro2017/stable6 kixpro

Nachdem Sie Ihr persönliches Repository eingebunden und die Voraussetzung erfüllt haben, installieren 
Sie Security Management wie folgt:

zypper refresh zypper install kixpro-security-management

Installation unter CentOS / Red Hat

Hat Erstellen Sie eine neue Repository-Datei /etc/yum.repos.d/kixpro.repo mit folgendem Inhalt:

[kixpro] name=kixpro baseurl=http://packages.kixdesk.com/customers/xxxxxxxxxxx/redhat/kixpro2017/ 
stable7 gpgcheck=1 enabled=1 gpgkey= proxy=_none_

Nachdem Sie Ihr persönliches Repository eingebunden und die Voraussetzung erfüllt haben, installieren 
Sie Security Management wie folgt:

yum check-updates yum install kixpro-security-management

http://packages.kixdesk.com/customers/xxxxxxxxxxx/debian
http://packages.kixdesk.com/customers/xxxxxxxxxxx/suse/kixpro2016/stable
http://packages.kixdesk.com/customers/xxxxxxxxxxx/redhat/kixpro2016/stable
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•
•

•
•

•
•

•
•

12.2.3 Migration von Version 17.4.x
SecurityManagement 17.4.x wurde unter dem alten Namen "verinice4KIX" geführt. Ab Version 17.5.x läuft es 
nun unter "Security Management". Beim Update von verinice4KIX müssen die folgenden Anpassungen 
vorgenommen werden, damit alles reibungslos miteinander funktioniert:

12.2.3.1 Änderungen relevanter SysConfig-Einstellungen

Core::VeriniceInterface###RESTServiceURL
Wird auf den Standard zurück gesetzt, da der Schlüssel umbenannt wurde. Die folgenden 
Verbindungseinstellungen müssten ggf. ebenfalls geprüft und angepasst werden. 
 

Core::VeriniceInterface###SOAPServiceURL
Wird auf den Standard zurück gesetzt, da der Schlüssel umbenannt wurde. Die folgenden 
Verbindungseinstellungen müssten ggf. ebenfalls geprüft und angepasst werden.

 

Durch regelmäßige Änderungen in der Konfiguration dynamischer Felder müssen folgende Schlüssel zurück 
gesetzt werden:

Ticket::Frontend::KIXSidebarVeriniceTaskMainData###DynamicField
Ticket::Frontend::AgentTicketZoomTabVeriniceTaskData###DynamicField

Daemon::SchedulerCronTaskManager::Task###CheckForVeriniceTask
Wird auf den Standard zurück gesetzt, da der Schlüssel umbenannt wurde. Hier müsste ggf. 
das Intervall angepasst werden.

12.2.3.2 Anpassungen im Adminbereich

Durch die Änderungen im Backendaufbau werden neue dynamische Felder angelegt:

Neues Feld Inhalt

TaskConfigItemID Beinhaltet die IDs der beteiligten CIs aus KIX.

TaskExternalCIName Beinhaltet die CI Namen des externen System.

TaskTitle Beinhaltet den Maßnahmen-Titel, aus verinice.PRO, zur 
Aufgabe. Je nach genutzten Backend, sind nicht alle Felder 
relevant bzw. haben kein Gegenstück in verinice.PRO.
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Neues Feld Inhalt

TaskChapter Beinhaltet den Maßnahmen-Titel, aus verinice.PRO, zur 
Aufgabe. Je nach genutzten Backend, sind nicht alle Felder 
relevant bzw. haben kein Gegenstück in verinice.PRO.

TaskDescription Beinhaltet das Maßnahmen-Kapitel, aus verinice.PRO, zur 
Aufgabe.

TaskImplementationState Beinhaltet den Status der Maßnahme, aus verinice.PRO, zur 
Aufgabenumsetzung. Je nach genutzten Backend, sind nicht 
alle Felder relevant bzw. haben kein Gegenstück in 
verinice.PRO.

TaskImplementationByDate Beinhaltet das Datum der Maßnahme, aus verinice.PRO, zur 
Aufgabenumsetzung.

TaskImplementationExplanation Beinhaltet die Erläuterung der Maßnahme, aus verinice.PRO, zur 
Aufgabenumsetzung.

TaskID Beinhaltet die ID der Aufgabe des externen System (z.B.: 
„dbid"einer Maßnahme aus verinice.PRO).

•
•
•
•
•
•
•
•

Hinweis

Die Mappings für KIX-Attribute zu verinice-Attributen sollten immer kontrolliert werden.  
Nur updaterelevant - Dadurch können alte dynamische Felder ungültig gesetzt werden:

TaskVeriniceCIName
TaskMeasureTitle
TaskMeasureChapter
TaskMeasureDescription
TaskMeasureImplementationImplementation
TaskMeasureImplementationByDate
TaskMeasureImplementationExplanation
TaskMeasureVeriniceID
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12.3 Administration von Security Management
Einstellungen zur Vewendung Ihres Security Management können im Adminbereich von KIX über die 
SysConfig getroffen werden. In den nachfolgenden Kapiteln werden die einzelnen Schlüssel näher erläutert.

 

12.3.1 Abrufen von Tasks in KIX
Möchten Sie geänderte Objekte aus verinice.PRO nach KIX manuell synchonisieren, führen Sie in einer 
Konsole folgendes Kommando aus:

bin/kix.Console.pl Maint::Ticket::CheckForTasks

Dieser Befehl wird ansonsten vom KIX-Daemon aller 5 Minuten ausgeführt.



KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul Security Management

Administration von Security Management

Erstellt am: 19.01.2022                                                                   Seite 206
 

12.3.2 Neue Objekte

12.3.2.1 Neue Access Control List (ACL)

Während der Installation wird eine neue ALC als Konfiguration im Admin-Bereich eingetragen. Diese blendet 
den neuen Ticket-Tab „verinice Aufgabeninformationen“ aus, falls ein Ticket kein verinice.PRO Aufgaben- 
Ticket ist.

 

12.3.2.2 Neuer Ticket-Typ

Während der Installation wird ein neuer Ticket-Typ (“veriniceTask”) angelegt. Dieser wird standardmäßig zum 
Anlegen für neue verinice.PRO Aufgaben-Tickets verwendet.

 

12.3.2.3 Neue dynamische Felder

Während der Installation werden neue dynamische Felder angelegt:

Name Funktion

TaskConfigItemID Beinhaltet die IDs der beteiligten CIs aus KIX.

TaskExternalCIName Beinhaltet die CI Namen des externen System.

TaskID Beinhaltet die ID der Aufgabe des externen System (z.B.: „dbid“ 
einer Maßnahme aus verinice.PRO).

Task... Beinhalten allgemeine Werte zur Aufgabe (z.B.: den 
Maßnahmen-Titel aus verinice.PRO). Je nach genutzten 
Backend (siehe Kapitel ), sind nicht alle Felder relevant bzw. 
haben kein Gegenstück in verinice.PRO.

TaskImplementation... Beinhalten Werte zur Aufgabenumsetzung (z.B.: 
Umsetzungsdatum der Maßnahme aus verinice.PRO). Je nach 
genutzten Backend (siehe Kapitel ), sind nicht alle Felder 
relevant bzw. haben kein Gegenstück in verinice.PRO.
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„TaskConfigItemID“, „TaskExternalCIName“ und „TaskID“ werden so weit möglich automatisch gesetzt. Alle 
weiteren Felder werden durch eine konfigurierte Zuordnung befüllt .

 

12.3.2.4 Neue CI-Klassen

Während der Installation werden neue CI-Klassen angelegt:

Name Funktion

Server Dient als Repräsentation eines Configuration Items in verinice (z.B. 
der Server-Kategorie der BSI-Grundschutz-Perspektive).

ClientGroup Dient als Repräsentation der Client-Kategorie der BSI-Grundschutz- 
Perspektive von verinice.PRO. Ein „Client“ in verinice.PRO ist eine 
Gruppe von CIs mit gleichen Eigenschaften.

 

12.3.2.5 Neue Ticketstatus

Während der Installation werden sechs neue Ticketstatus angelegt. Ein einfacher Status-Workflow ist 
ebenfalls vorhanden.

Name Funktion

Task new

(Aufgabe neu)

Wird standardmäßig bei neuen Aufgaben-Tickets gesetzt.

Task assigned

(Aufgabe zugewiesen)

Kann verwendet werden, um anzuzeigen, dass das Aufgaben- 
Ticket einen Bearbeiter zugewiesen wurde.

Task implementation

(Aufgabe-Umsetzung)

Kann verwendet werden, um anzuzeigen, dass das Aufgaben- 
Ticket bearbeitet wird.

Task rejected

(Aufgabe zurückgewiesen)

Kann verwendet werden, um anzuzeigen, dass das Aufgaben- 
Ticket nicht bearbeitet wird, bzw. nicht mehr relevant ist oder 
auch, dass der falsche Bearbeiter gewählt wurde.
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Task done

(Aufgabe erledigt)

Kann verwendet werden, um anzuzeigen, dass das Aufgaben- 
Ticket fertig bearbeitet wurde und die Maßnahme umgesetzt 
ist.

Task implementation accepted

(Aufgabenumsetzung akzeptiert)

Kann verwendet werden, um anzuzeigen, dass die Maßnahme 
des Aufgaben-Tickets zufriedenstellend umgesetzt und somit 
akzeptiert ist.
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12.3.3 Konfiguration von Security Management

SysConfig Optionen (siehe Seite 210) 

SOAP-Schnittstelle - URL (siehe Seite 210) 

SOAP-Schnittstelle - Benutzername (siehe Seite 210) 

SOAP-Schnittstelle - Passwort (siehe Seite 211) 

SOAP-Schnittstelle - SSL (siehe Seite 211) 

REST-Schnittstelle - URL (siehe Seite 211) 

REST-Schnittstelle - Benutzername (siehe Seite 211) 

REST-Schnittstelle - Passwort (siehe Seite 211) 

REST-Schnittstelle - SSL (siehe Seite 212) 

Quellenbezeichnung (siehe Seite 212) 

verinice Backends (siehe Seite 212) 

Synchronisation – relevante CI-Klassen (siehe Seite 212) 

Synchronisation – Attribut-Zuordnungen (siehe Seite 213) 

Synchronisation – Attributoptionen-Zuordnungen (siehe Seite 213) 

Synchronisation – LinkType Mapping (siehe Seite 213) 

Event-Modul für Ticket-Änderungen (siehe Seite 214) 

Ticket-Typ (siehe Seite 214) 

Ticketstatus-Workflow (siehe Seite 214) 

Aufgaben-Ticket – BSI Backend – Kerndaten (siehe Seite 214) 

Aufgaben-Ticket – BSI Backend – Artikel (siehe Seite 215) 

Aufgaben-Ticket – BSI Backend – dynamische Felder – Zuordnungen (siehe Seite 215) 

Aufgaben-Ticket – BSI Backend – dynamische Felder – bei Ticketänderung (siehe Seite 215) 

Aufgaben-Ticket – BSIModern Backend – Kerndaten (siehe Seite 215) 

Aufgaben-Ticket – BSIModern Backend – Artikel (siehe Seite 216) 

Aufgaben-Ticket – BSIModern Backend – dynamische Felder – Zuordnungen (siehe Seite 216) 

Aufgaben-Ticket – BSIModern Backend – dynamische Felder – bei Ticketänderung (siehe Seite 216) 

Zuordnung KIX-Bezeichner / verinice-Bezeichner (siehe Seite 217) 

Aufgaben-Ticket – ISM Backend – Kerndaten (siehe Seite 217) 

Aufgaben-Ticket – ISM Backend – Artikel (siehe Seite 217) 

Aufgaben-Ticket – ISM Backend – dynamische Felder – Zuordnungen (siehe Seite 217) 

Aufgaben-Ticket – ISM Backend – dynamische Felder – bei Ticketänderung (siehe Seite 218) 

Aufgaben-Ticket – Erstellung durch Zeitplaner-Modul (siehe Seite 218) 

Sidebar – Dynamische Felder (siehe Seite 218) 

Ticket-Tab - Dynamische Felder (siehe Seite 218) 

Ticket-Tab – weitere Einstellungen (siehe Seite 219) 
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12.3.3.1 SysConfig Optionen

Nach der Installation können Sie einige Einstellungen in der SysConfig vornehmen.

Öffnen Sie hierfür die SysConfig im Admin-Bereich von KIX. Wählen Sie die Hauptgruppe „Security 
Management“ und eine der folgenden Untergruppen aus:

Core::Ticket
Core::VeriniceInterface
Daemon::SchedulerCronTaskManager::Task
Frontend::Agent::KIXSidebarBackend
Frontend::Agent::Ticket::ViewTicketZoomTabVeriniceTaskData
VeriniceSync::BSI
VeriniceSync::BSIModern
VeriniceSync::ISM
VeriniceTask::BSI
VeriniceTask::BSIModern
VeriniceTask::ISM

Eine Standard-Konfiguration ist bereits gegeben. Sie können diese entsprechend Ihren Anforderungen 
anpassen. Die folgenden Kapitel erläutern die einstellbaren SysConfig Optionen.

12.3.3.2 SOAP-Schnittstelle - URL

SysConfig Option: Core::VeriniceInterface###SOAPServiceURL

Definiert die Service-URL für SOAP-Anfragen für die CI-Synchronisation mit verinice.PRO.

12.3.3.3 SOAP-Schnittstelle - Benutzername

SysConfig Option: Core::VeriniceInterface###SOAPAuthenticationName

Definiert den Benutzernamen für den Zugriff auf die SOAP-Schnittstelle von verinice.PRO.

Die SysConfig-Option „Ticket::EventModulePost###ITSMConfigItemLinkAdd“ wird durch die 
Installation aktiviert.



Diese Option ist erforderlich und muss angepasst werden.

Diese Option ist erforderlich und der Standardwert ist „admin“.



KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul Security Management

Administration von Security Management

Erstellt am: 19.01.2022                                                                   Seite 211
 

12.3.3.4 SOAP-Schnittstelle - Passwort

SysConfig Option: Core::VeriniceInterface###SOAPAuthenticationPassword

Definiert das Passwort für den Zugriff auf die SOAP-Schnittstelle von verinice.PRO.

12.3.3.5 SOAP-Schnittstelle - SSL

SysConfig Option: Core::VeriniceInterface###SOAPNoSSLVerify

Deaktiviert die SSL-Zertifikatsvalidierung für die SOAP-Schnittstelle, z.B. falls ein transparenter HTTPS-Proxy 
verwendet wird.

12.3.3.6 REST-Schnittstelle - URL

SysConfig Option: Core::VeriniceInterface###RESTServiceURL

Definiert die Service-URL (Host) für die REST-API von verinice (standardmäßig mit Port "8081").

12.3.3.7 REST-Schnittstelle - Benutzername

SysConfig Option: Core::VeriniceInterface###RESTAuthenticationName

Definiert den Nutzernamen für den Zugriff auf die REST-API von verinice.PRO.

12.3.3.8 REST-Schnittstelle - Passwort

SysConfig Option: Core::VeriniceInterface###RESTAuthenticationPassword

Definiert das Passwort für den Zugriff auf die REST-API von verinice.PRO.

Diese Option ist erforderlich und der Standardwert ist „geheim“.

Die Aktivierung dieser Option geschieht auf eigene Gefahr!

Diese Option ist erforderlich und muss angepasst werden.

Diese Option ist erforderlich und der Standardwert ist „verinice“.

Diese Option ist erforderlich und der Standardwert ist „verinice“.
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12.3.3.9 REST-Schnittstelle - SSL

SysConfig Option: Core::VeriniceInterface###RESTNoSSLVerify

Deaktiviert die SSL-Zertifikatsvalidierung für die REST-API, z.B. falls ein transparenter HTTPS-Proxy 
verwendet wird.

12.3.3.10 Quellenbezeichnung

SysConfig Option: Core::VeriniceInterface###SourceName

Definiert den Namen der Quellenbezeichnung. Der Name wird für die Synchronisation der KIX CMDB mit 
verinice.PRO verwendet. Damit können CI, die durch eine vorherige Synchronisation mit selber 
Quellenbezeichnung angelegt wurden, in verinice.PRO ermittelt und aktualisiert werden. Zudem dient die 
Bezeichnung dazu, verinice.PRO Aufgaben-Tickets mit synchronisierten CIs in KIX zu verknüpfen.

12.3.3.11 verinice Backends

SysConfig Option: Core::ActiveBackends

Definiert, welche Backends für verinice aktiv sind. Nur aktive Backends werden für die Synchronisation, die 
Aufgaben-Ticket-Erstellung und die Rückmeldung von Ticket-änderungen an verinice.PRO berücksichtigt.

12.3.3.12 Synchronisation – relevante CI-Klassen

SysConfig Option: VeriniceSync::[Backend_Name]###RelevantCIClasses

Definiert, welche CI-Klassen in der Synchronisationsansicht verwendet werden können. Der Schlüssel muss 
die CI-Klasse und der Inhalt die ID des entsprechenden Objekts in verinice (z.B. „server“, „asset“ oder „it- 
system“) sein.

Die Aktivierung dieser Option geschieht auf eigene Gefahr!

Diese Option ist erforderlich und der Standardwert ist „KIX“.

Diese Option ist erforderlich.

Diese Option ist erforderlich. Welche Werte aus verinice.PRO möglich sind, kann der Datei 
„SNCA.xml“ von verinice.PRO entnommen werden.
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12.3.3.13 Synchronisation – Attribut-Zuordnungen

SysConfig Option: VeriniceSync::[Backend_Name]###AttributeMapping

Definiert die Zuordnungen (Mapping) für die Synchronisation der CI-Attribute mit den entsprechenden 
Attributen des Objekts in verinice.PRO. Der Schlüssel muss die CI-Klasse, gefolgt von einem dreifachen 
Doppelpunkt und dem CI-Attribut sein. Der Inhalt sollte die ID des entsprechenden Attributs des Objekts in 
verinice.PRO sein.

12.3.3.14 Synchronisation – Attributoptionen-Zuordnungen

SysConfig Option: VeriniceSync::[Backend_Name]###AttributeOptionMapping

Definiert die Zuordnungen (Mapping) für die Synchronisation der verfügbaren Optionen eines CI-Attributs 
(Dropdown) mit den Optionen des entsprechenden Attributs des Objekts in verinice.PRO. Der Schlüssel muss 
die CI-Klasse, gefolgt von einem dreifachen Doppelpunkt und dem CI-Attribut, gefolgt von einem weiteren 
dreifachen Doppelpunkt und der Option selbst sein. Der Inhalt sollte die ID der entsprechenden Option des 
Attributs des Objekts in verinice.PRO sein

12.3.3.15 Synchronisation – LinkType Mapping

SysConfig Option: VeriniceSync::<BackendName>###LinkTypeMapping

Diese Optionen bestimmen, wie das Mapping der Linktypen von KIX nach verinice.PRO aussehen soll. Die 
Schlüssel haben die Form <Quell-CI-Klasse>::<Ziel-CI-Klasse>::<Linktyp>. Wie Inhalte sind feste Werte aus 
verinice.PRO (siehe dort SNCA.xml)

Abbildung: Link-Type-Mapping

 

Diese Option ist erforderlich. Welche Werte aus verinice.PRO möglich sind, kann der Datei 
„SNCA.xml“ von verinice.PRO entnommen werden.



Welche Werte aus verinice möglich sind, kann der Datei „SNCA.xml“ von verinice.PRO entnommen 
werden.
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12.3.3.16 Event-Modul für Ticket-Änderungen

SysConfig Option: Ticket::EventModulePost###444-VeriniceTaskTicketForwarding

Event-Modul, um Änderungen eines Aufgaben-Tickets nach verinice.PRO zu übertragen. Unter 
"SetKIXWorkflowOfTaskOnTicketState" kann definiert werden, welcher Ticketstatus, welchen KIX-Workflow- 
Status in verinice.PRO setzt.

12.3.3.17 Ticket-Typ

SysConfig Option: VeriniceTicketType

Ticket-Typ für verinice Aufgaben-Tickets.

12.3.3.18 Ticketstatus-Workflow

SysConfig Option: TicketStateWorkflowExtension###veriniceTask

Definiert den Ticketstatus-Workflow für verinice Aufgaben-Tickets.

12.3.3.19 Aufgaben-Ticket – BSI Backend – Kerndaten

SysConfig Option: VeriniceTask::BSI###TicketData

Definiert die Kern-Daten eines neuen verinice.PRO Aufgaben-Tickets. Für "Titel" sind Platzhalter, wie z.b. 
"<VERINICE_mnums_id>" oder "<VERINICE_server_name>" für verinice Attribute möglich. Die mögliche 
Attribut-Platzhalter für Maßnahmen („mnums“), Bausteinen („bstumsetzung“) und CIs („server“ bzw. „client“), 
können der Datei „SNCA.xml“ von verinice.PRO entnommen werden.

Standardmäßig wird bei Zuweisung der Aufgabe („Task assigned“) der KIX-Workflow-Status in 
verinice.PRO auf „Läuft“ und beim Akzeptieren der Aufgabenumsetzung („Task implementation 
accepted“) auf „Beendet“ gesetzt.



Diese Option ist erforderlich und der Standardwert ist „veriniceTask“

Damit der Workflow angewendet wird und Ticket-Status entsprechend eingeschränkt werden, muss 
die SysConfig-Option „Ticket::Acl::Module###950_TicketStateWorkflow“ aktiviert sein.



Diese Option ist erforderlich.
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12.3.3.20 Aufgaben-Ticket – BSI Backend – Artikel

SysConfig Option:

VeriniceTask::BSI###ArticleData und VeriniceTask::BSI###ArticleDataBody

Artikel-Daten eines neu erstellten verinice Aufgaben-Tickets. Für "Subject" bzw. für den Body-Text sind 
Platzhalter, wie zum Beispiel "<VERINICE_mnums_id>" oder "<VERINICE_server_name>" für verinice.PRO 
Attribute möglich. Die mögliche Attribut-Platzhalter für Maßnahmen („mnums“), Bausteinen 
(„bstumsetzung“) und CIs („server“ bzw. „client“), können der Datei „SNCA.xml“ von verinice.PRO entnommen 
werden.

12.3.3.21 Aufgaben-Ticket – BSI Backend – dynamische Felder – Zuordnungen

SysConfig Option: VeriniceTask::BSI###TicketDataDynamicFieldMapping

Definiert das Mapping für dynamische Felder von neuen verinice.PRO Aufgaben-Tickets. Der Schlüssel ist 
das dynamische Feld und der Inhalt das verinice.PRO Attribut. Mögliche verinice.PRO Attribute können der 
Datei „SNCA.xml“ von verinice.PRO entnommen werden.

12.3.3.22 Aufgaben-Ticket – BSI Backend – dynamische Felder – bei Ticketänderung

SysConfig Option: VeriniceTask::BSI###DynamicFieldsForResponse

Definiert, welche dynamischen Felder bei Änderungen von Aufgaben-Tickets an verinice.PRO durch das 
Event-Modul (siehe Kapitel ) übermittelt werden (1 = aktiv, 0 = inaktiv). Eine Zuordnung (siehe Kapitel ) muss 
für die dynamischen Felder konfiguriert sein.

12.3.3.23 Aufgaben-Ticket – BSIModern Backend – Kerndaten

SysConfig Option: VeriniceTask::BSIModern###TicketData

Diese Option ist erforderlich. Für den Body-Text ist zusätzlich der spezielle Platzhalter 
"<VERINICE_mnums_bsi_description>" möglich (standardmäßig bereits eingetragen). Damit wird der 
Maßnahmen-Beschreibungstext aus dem BSI-Grundschutzkatalog (siehe Kapitel ) an die 
entsprechende Stelle eingefügt.



Diese Option ist erforderlich.

Diese Option ist erforderlich.
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Definiert die Kern-Daten eines neuen verinice Aufgaben-Tickets. Für "Titel" sind Platzhalter, wie z.b. 
"<VERINICE_bp_safeguard_id>" oder "<VERINICE_bp_itsystem_name>" für verinice Attribute möglich. Um 
Werte nur für einen bestimmten verinice Objekttyp zu definieren, kann dem Ticket-Attribut der KIX-Bezeichner 
(gefolgt von drei Doppelpunkten) vorangestellt werden (z.B. "Module:::Title"). Einträge ohne KIX-Bezeichnner 
sind der Standard. 

12.3.3.24 Aufgaben-Ticket – BSIModern Backend – Artikel

SysConfig Option:

VeriniceTask::BSIModern###ArticleData

Artikel-Daten eines neu erstellten verinice.PRO Aufgaben-Tickets. Für "Subject" und "Body" sind Platzhalter, 
wie z.b. "<VERINICE_bp_safeguard_id>" oder "<VERINICE_bp_itsystem_name>" für verinice.PRO Attribute 
möglich. Für "Body" sind zudem einige DOM-Elemente möglich (z.B. <br />, für "Zeilenumbrüche" - wenn der 
"ContentType" mit "text/html" angegeben ist). Um Werte nur für einen bestimmten verinice.PRO Objekttyp zu 
definieren, kann dem Artikel-Attribut der KIX-Bezeichner (gefolgt von drei Doppelpunkten) vorangestellt 
werden (z.B. "Module:::Subject"). Einträge ohne KIX-Bezeichnner sind der Standard.

12.3.3.25 Aufgaben-Ticket – BSIModern Backend – dynamische Felder – Zuordnungen

SysConfig Option: VeriniceTask::BSIModern###TicketDataDynamicFieldMapping

Definiert das Mapping für dynamische Felder von neuen verinice.PRO Aufgaben-Tickets. Der Schlüssel ist 
das dynamische Feld und der Inhalt das verinice.PRO Attribut. Um Werte nur für einen bestimmten 
verinice.PRO Objekttyp zu definieren, kann dem dynamischen Feld der KIX-Bezeichner (gefolgt von drei 
Doppelpunkten) vorangestellt werden (z.B. "Module:::TaskTitle"). Einträge ohne KIX-Bezeichnner sind der 
Standard.

12.3.3.26 Aufgaben-Ticket – BSIModern Backend – dynamische Felder – bei 
Ticketänderung

SysConfig Option: VeriniceTask::BSIModern###DynamicFieldsForResponse

Diese Option ist erforderlich.

Diese Option ist erforderlich.

Diese Option ist erforderlich.
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Definiert, welche dynamischen Felder bei Änderungen von Aufgaben-Tickets an verinice.PRO durch das 
Event-Modul (siehe Kapitel ) übermittelt werden (1 = aktiv, 0 = inaktiv). Eine Zuordnung (siehe Kapitel ) muss 
für die dynamischen Felder konfiguriert sein.

12.3.3.27 Zuordnung KIX-Bezeichner / verinice-Bezeichner 

SysConfig Option: VeriniceTask::BSIModern###VeriniceObjects

Diese Option definiert, welche Objekte von verinice.PRO für die verinice.PRO Aufgaben-Tickets in KIX 
betrachtet werden sollen. der "Key" ist der KIX-interne Bezeichner und "Value" der entsprechende Objekt- 
Bezeichner (Typ) in verinice.PRO. 

12.3.3.28 Aufgaben-Ticket – ISM Backend – Kerndaten

SysConfig Option: VeriniceTask::ISM###TicketData

Definiert die Kern-Daten eines neuen verinice.PRO Aufgaben-Tickets. Für "Titel" sind Platzhalter, wie z.b. 
"<VERINICE_control_name>" oder "<VERINICE_asset_name>" für verinice.PRO Attribute möglich. Die 
mögliche Attribut-Platzhalter für Controls („control“), Control-Gruppe („controlgroup“) und CIs („asset“), 
können der Datei „SNCA.xml“ von verinice.PRO entnommen werden.

12.3.3.29 Aufgaben-Ticket – ISM Backend – Artikel

SysConfig Option:

VeriniceTask::ISM###ArticleData und VeriniceTask::ISM###ArticleDataBody

Artikel-Daten eines neu erstellten verinice Aufgaben-Tickets. Für "Subject" bzw. für den Body-Text sind 
Platzhalter, wie zum Beispiel "<VERINICE_control_name>" oder "<VERINICE_asset_name>" für verinice 
Attribute möglich. Die mögliche Attribut-Platzhalter für Controls („control“), Control-Gruppen („controlgroup“) 
und CIs („asset“), können der Datei „SNCA.xml“ von verinice.PRO entnommen werden.

12.3.3.30 Aufgaben-Ticket – ISM Backend – dynamische Felder – Zuordnungen

SysConfig Option: VeriniceTask::ISM###TicketDataDynamicFieldMapping

Diese Option ist erforderlich.

Diese Option ist erforderlich.

Diese Option ist erforderlich.
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Definiert das Mapping für dynamische Felder von neuen verinice.PRO Aufgaben-Tickets. Der Schlüssel ist 
das dynamische Feld und der Inhalt das verinice.PRO Attribut. Mögliche verinice .PRO Attribute können der 
Datei „SNCA.xml“ von verinice.PRO entnommen werden.

12.3.3.31 Aufgaben-Ticket – ISM Backend – dynamische Felder – bei Ticketänderung

SysConfig Option: VeriniceTask::ISM###DynamicFieldsForResponse

Definiert, welche dynamischen Felder bei Änderungen von Aufgaben-Tickets an verinice.PRO durch das 
Event-Modul (siehe Kapitel ) übermittelt werden (1 = aktiv, 0 = inaktiv). Eine Zuordnung (siehe Kapitel ) muss 
für die dynamischen Felder konfiguriert sein.

12.3.3.32 Aufgaben-Ticket – Erstellung durch Zeitplaner-Modul

SysConfig Option:

Daemon::SchedulerCronTaskManager::Task###CheckForVeriniceTask

Zeitplaner-Modul-Registrierung (Scheduler), welcher prüft, ob es neue verinice.PRO Aufgaben gibt und 
entsprechend dafür neue Tickets erstellt. Der Inhalt für "Schedule" ist eine Cron-Notation.

12.3.3.33 Sidebar – Dynamische Felder

SysConfig Option:

Ticket::Frontend::KIXSidebarVeriniceTaskMainData###DynamicField

Bestimmt die dynamischen Felder, die in der Sidebar „verinice Aufgaben-hauptinformationen“ im 
Agentenfrontend angezeigt werden. Mögliche Einstellungen sind „0“ für „nicht anzeigen“ und „1“ für 
„anzeigen“.

12.3.3.34 Ticket-Tab - Dynamische Felder

SysConfig Option:

Ticket::Frontend::AgentTicketZoomTabVeriniceTaskData###DynamicField

Diese Option ist erforderlich.

Diese Option ist erforderlich.

Vorkonfiguriert wird alle 5 Minuten geprüft.
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Bestimmt die dynamischen Felder, die im Tab „verinice Aufgabeninformationen“ im Agentenfrontend 
angezeigt werden. Mögliche Einstellungen sind „0“ für „nicht anzeigen“ und „1“ für „anzeigen“ sowie „2“ für 
„anzeigen und als Pflichtfeld markieren“.

12.3.3.35 Ticket-Tab – weitere Einstellungen

SysConfig Option: Ticket::Frontend::AgentTicketZoomTabVeriniceTaskData###***

Diese Optionen bestimmen, welche Rechte ein Nutzer haben muss, um den Tab verwenden zu können, ob 
das Ticket gesperrt sein muss, ob der Ticket-Status geändert werden kann und welche Ticket-Status (über 
deren Status-Typen) dabei zur Verfügung stehen.

Einige Optionen sind erforderlich.
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12.3.4 Vorbereitungen zur Verwendung

12.3.4.1 Vorbereitung für verinice

Für die Synchronisation von CIs und die Ermittlung von verinice Aufgaben müssen die jeweiligen 
Schnittstellen-URLs (siehe Kapitel und ) und ggf. die Benutzer und Passwörter dafür (siehe Kapitel und sowie 
und ) in der SysConfig an Ihre Umgebung angepasst werden.

Objekte der Kategorie „Client“ in der Perspektive BSI-Grundschutz in verinice stehen für Gruppen von CIs, mit 
selber Konfiguration. Um dies in KIX darstellen zu können, wurde die neue Klasse „ClientGroup“ angelegt. 
Damit diese ihre zugehörigen „Clients“ ermitteln kann, muss in den entsprechenden CI-Klassen (bspw. 
„Computer“) ein neues Attribut in die Klassendefinition eingefügt werden:

{
Key => 'ClientGroup',
Name => 'ClientGroup',
Searchable => 1,
Input => {
    Type => 'CIClassReference',
    ReferencedCIClassName => 'ClientGroup',
    ReferencedCIClassLinkType => 'Includes',
    ReferencedCIClassLinkDirection => 'Reverse',
    ReferencedCIClassReferenceAttributeKey => 'Name',
    Required => 1,
    },
},

In den betreffenden „Client“-CIs in KIX muss dann noch das relevante „ClientGroup“-CI in dem neuen Attribut 
ausgewählt werden. Dadurch werden die CI auch miteinander verknüpft. In verinice.PRO ist nach 
Synchronisation des „ClientGroup“-CIs die Anzahl der „Clients“ (die verknüpften CIs des „ClientGroup“-CIs) 
als Attribut ersichtlich.

12.3.4.2 Synchronisation

Damit CIs synchronisiert werden können, müssen 3 Voraussetzungen erfüllt sein. Sie müssen zu einer in der 
SysConfig konfigurierten Klasse gehören (siehe Kapitel ), ein Mapping für diese Klasse sollte vorhanden sein 
(siehe Kapitel und ) und das Attribut „Synchronisation mit verinice“ muss für das jeweilige Configuration Item 
auf „ja“ gestellt sein:

{
Key => 'VeriniceSync',
Name => 'Synchronization with verinice',
Input => {
    Type => 'GeneralCatalog',
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    Class => 'ITSM::ConfigItem::YesNo',
    Translation => 1,
    Required => 1,
    },
},

Durch die Installation des Moduls „Security Management“ wurde die Klasse „Server“ (Kopie der Standard- 
Klasse „Computer“) angelegt, welche bereits einige verinice.PRO-bezogene Attribute (z.B. Schutzbedarf), 
sowie das Attribut „Synchronisation mit verinice“ beinhaltet. Die Klasse „Server“ ist zudem für alle 3 
mitgelieferten Backends (siehe hierzu Kapitel ) vorkonfiguriert.

Im Menü „CMDB“ steht der neue Unterpunkt „verinice Sync“ zur Verfügung, womit die Synchronisation- 
Übersicht geöffnet werden kann. Darin werden alle konfigurierten Klassen, für welche Backends sie 
konfiguriert sind und die Anzahl der zu synchronisierenden CIs angezeigt. Nach erfolgter Synchronisation 
erscheint ein Fenster mit dem Ergebnis, in welchem angegeben wird, wie viele Configuration Items in 
verinice.PRO angelegt bzw. verändert wurden. Eventuelle Fehler werden mit Verweis auf das jeweilige 
relevante Fehler-Log ebenfalls angezeigt.

 

Die Synchronisation kann auch manuell über ein Terminal mit dem CLI-Modul 
„Maint::ITSM::SyncConfigItemsToVerinice“ ausgeführt werden.

 

In verinice müssen die neuen Configuration Items in der jeweiligen Perspektive dann nur noch aus den 
„importierten Objekten“ in die jeweilige relevante Objekt-Kategorie per „Ausschneiden“ und „Einfügen“ 
verschoben werden.

12.3.4.3 verinice Aufgabentickets

Damit Tickets erstellt werden, müssen in verinice.PRO den synchronisierten Configuration Items „Bausteine“ 
aus dem „IT-Grundschutz“-Katalog („BSI-Grundschutz“) bzw. dem „IT-Grundschutz“-Kompendium 
(„Modernisierter BSI-Grundschutz“) oder Controls (ISM-Perspektive) zugewiesen werden. Für die, in den 
Bausteinen beinhalteten Maßnahmen bzw. Controls muss anschließend das Attribut „KIX Workflow Status“ 
auf „Starte Workflow“ eingestellt werden.

In KIX wird standardmäßig alle 5 Minuten durch den Zeitplaner (siehe Kapitel ) per REST angefragt, ob in 
verinice.PRO „Aufgaben“ (Maßnahmen/Controls) mit gestartetem KIX Workflow existieren. Gibt es 
entsprechende „Aufgaben“, wird für jede „Aufgabe“ jeweils ein neues verinice Aufgaben-Ticket in KIX erstellt. 
Gibt es bereits ein offenes Ticket für diese „Aufgabe“ werden lediglich die dynamischen Felder aktualisiert.

Bitte beachten

Sollte eine Klasse für mehrere Backends konfiguriert sein, werden die relevanten CIs für jedes 
beteiligte Backend angelegt bzw. aktualisiert. D.h. ein Configuration Item in KIX kann bis zu 3x (in 
unterschiedlichen Ausprägungen, je nach Backend und Mapping) in verinice.PRO vorhanden sein.
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Das im Zeitplaner verwendetet CLI-Modul „Maint::Ticket::CheckForTasks“ kann auch über ein Terminal 
manuell ausgeführt werden.

 

Bei Ticketerstellung wird das nächste freie „KIX Ticket X“-Attribut der Maßnahme/Control in verinice mit dem 
Link zum Ticket und der Ticketnummer gefüllt. Damit auch in verinice der Bezug zu den KIX-Tickets hinterlegt 
ist.

Solange der Workflow-Status auf „Starte Workflow“ bleibt, wird bei der nächsten Anfrage (über den Zeitplaner 
oder auch manuell per Terminal) die Maßnahme/Control erneut betrachtet und, falls kein offenes Ticket für 
diese „Aufgabe“ in KIX mehr existiert, ein weiteres verinice.PRO Aufgaben-Ticket für diese „Aufgabe“ erzeugt 
und das nächste freie „KIX Ticket X“-Attribut in verinice.PRO gefüllt.

 

Nachdem eine Aufgabe umgesetzt worden ist, kann der Umsetzungsstatus und weitere Informationen (siehe 
Kapitel ), durch setzen des relevanten Ticket-Status des verinice Aufgaben-Ticket in KIX (siehe Kapitel ) an 
verinice.PRO übermittelt werden.
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13 Zusatzmodul Telefonintegration
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13.1 Installation Zusatzmodul Telefonintegration

13.1.1 Anforderungen an die Telefonanlage

13.1.1.1 Grundsätzliche Anforderungen

Um die CTI-Erweiterung für KIX nutzen zu können, muss die Telefonanlage grundsätzlich in der Lage sein, für 
bestimmte Aktionen (mind. INCOMING und CONNECTED) eine bestimmte URL (Action-URL) ansprechen zu 
können. Zudem muss die Telefonanlage ein Dial-by-URL unterstützen, d.h. es muss möglich sein, eine URL 
aufzurufen und der Telefonanlage dadurch mitzuteilen, dass vom Apparat eines Arbeitsplatzes eine 
bestimmte Zielnummer gewählt wird.

Eingehende Anrufe

Die Telefonanlage teilt KIX per URL-Aufruf eine Aktion mit (z.B. INCOMING):

<FQDN des KIX Servers>/cti.pl?Action=<Action>&Src=<ID>&Dest=<ID>

z.B.: http://.../cti.pl?Action=INCOMING&Src=03715347620&Dest=1234

Diese URL würde z.B. bei einem eingehenden Anruf von der Nummer 0371/5347-620 auf die interne 
Rufnummer (Nebenstelle) 1234 aufgerufen werden. Die Angabe der Zielrufnummer kann ebenfalls die 
komplette Ziffernfolge (inkl. Länderkennung, Vorwahl und Kopfnummer enthalten).

Grundsätzlich wird jede Art von ID (IP, MAC, SIP, Rufnummer,...) unterstützt, solange diese ID am jeweiligen 
Datensatz (Kundennummer/Mitarbeiter) in KIX hinterlegt ist. Für jeden Ansprechpartner und Agenten können 
unterschiedliche Typen von IDs genutzt werden.

Optimal ist eine Unterstützung für folgende Aktionen/Ereignisse (Bezeichnung kann je Telefonanlage 
variieren):

INCOMING Ein Telefonanrufer ruft an.

MISSED Das Telefonat wurde nicht angenommen.

CONNECTED Der Anruf wird von der Telefonanlage zu einem Arbeitsplatztelefon 
verbunden, d.h. der Mitarbeiter nimmt ab.

HANGUP Das Telefonat wurde beendet.
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Ausgehende Anrufe

Damit KIX die ausgehenden Telefonanrufe der Mitarbeiter automatisch historisieren und den 
entsprechenden Vorgängen zuordnen kann, ist es notwendig, dass die Telefon Dial-by-URL unterstützt. Dies 
bedeutet, dass für die Anwahl einer bestimmten Rufnummer ein Aufruf einer URL ausreicht. Diese URL 
enthält die Rufnummer/ID des Mitarbeiter-Apparates und die gewünschte Zielrufnummer/ID.

Das CTI-Modul unterstützt ebenfalls ein direktes Dial-by-URL über das Telefon des Mitarbeiters. Hierzu muss 
die IP des entsprechenden Telefons am Datensatz des Mitarbeiters vorhanden sein.

Nach dem Aufruf der URL durch KIX wählt die Telefonanlage die Zielrufnummer und verbindet das Gespräch 
auf den Telefonapparat des entsprechenden Mitarbeiters.

Beispiel (Server-Dial): <FQDN des Telefonanlagenservers>/dialOut? 
Src=1234&Dest=03715347620

Beispiel (Telefon-Dial): <FQDN des Telefons>/dialOut?Number=03715347620

 

Der Aufbau der URL wird durch die Telefonanlage vorgegeben und ist in KIX konfigurierbar. Für den Server- 
Dial-Out kann KIX hierbei auch eine Verbindung über einen Proxy-Server (inkl. Authentifizierung) nutzen.

 

13.1.2 Paket Installation
Installieren Sie das Paket "kixpro-cti" mit der "Paketverwaltung" (Menü "Admin" Bereich "Systemverwaltung" ) 
oder über die Kommandozeile.

 

13.1.3 Integration in Ihre Telefonanlage
CTI4KIX enthält bereits ein CTI-Backend. Dies unterstützt die Kommunikation zwischen KIX Professional und 
Ihrer Telefonanlage durch Nutzung von HTTP-Requests.
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13.1.4 HTTP Backend - Konfiguration der ActionURLs
Um das HTTP-Backend und alle CTI-Funktionalitäten nutzen zu können, muss Ihre Telefonanlage so 
genannte "ActionURLs" unterstützen. Die erforderlichen ActionURLs müssen Ihrer Telefon konfiguriert 
werden, damit eine Kommunikation mit der CTI4KIX-Erweiterung möglich ist.

Für jede erforderliche ActionURL muss diese URL konfiguriert werden:

<FQDN des KIX Servers>/cti.pl?Action=<Action>&Src=<ID>&Dest=<ID>

 
Die Parameter "ID" kann jeder Identifier (MAC, SIP, Telefonnummer) sein, solange der Identifier identisch zu 
dem im Kontakteintrag eines Agenten oder Ansprechpartner ist.  
Der Parameter "Action" kann einer der folgenden sein:

INCOMING Ein eingehender Telefonanruf wurde in Ihrer Telefonanlage registriert.

MISSED Ein eingehender Telefonanruf wurde nicht mit einem Telefon verbunden 
und der Anrufer hat aufgelegt.

CONNECTED Ein eingehender Telefonanruf wurde mit einem Telefon verbunden.

HANGUP Der Telefonanruf wurde beendet.

 
Um den korrekten Kundenkontakt und das Ziel eines eingehenden Anrufs zu identifizieren ,muss zumindest 
die Aktion CONNECTED konfiguriert worden sein. Wenn diese Kommunikation korrekt konfiguriert ist und 
funktioniert, kann ein Agent die Eingabemaske für ein neues Ticket öffnen, nachdem er den Telefonhörer 
abgenommen hat. Die Informationen über den Anrufer und alle zugehörigen Informationen (bspw. 
zugeordnete ConfigItems) werden bereits angezeigt, sofern sie in der Kundendatenbank gefunden werden 
können. 
 

Bitte beachten: Wenn Sie ein anderes CTI-Backend nutzen, lesen Sie für nähere Informationen die 
Dokumentation für dieses Backend.
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13.2 Konfiguration Zusatzmodul Telefonintegration
Wenn Sie das Paket installiert haben, können Sie in der SysConfig alle notwendigen Parameter zur 
Kommunikation mit der Telefonanlage konfigurieren. Wählen Sie dazu die SysConfig-Gruppe "CTI4KIX".  
Nachdem die Seite neu geladen wurde, wählen Sie die Untergruppe "Core". 

Es werden bei der Installation zwei neue Berechtigungsgruppen angelegt: "CTI" und "CTIManager", um den 
Zugriff zu den CTI-Funktionen zu managen. Die Gruppe "CTI" ist für eine zukünftige Verwendung reserviert. 
Das "CTIManager"-Modul ist ein Protokoll aller derzeitigen oder vergangenen CTI-Aktivitäten. Darauf haben 
nur Agenten mit "rw"-Rechten in der Gruppe "CTIManager" Zugriff.

In den persönlichen Einstellungen eines Agenten stehen nach der Installation drei neue Widgets 
"TelefonID" /"PhoneIDType" / "PhoneIP" zur Verfügung. Passen Sie dieses Einstellungen entsprechend Ihrer 
Gegebenheiten an.

 

Auswahl des Backends (siehe Seite 227) 

Ansprechpartner PhoneID Type Mapping (siehe Seite 228) 

Ansprechpartner PhoneID Type Mapping - Standard (siehe Seite 228) 

Ansprechpartner PhoneID Mapping (siehe Seite 228) 

Agenten PhoneID Type (siehe Seite 228) 

Eingehende Anrufe - Filter (siehe Seite 229) 

Erkennung der Nummernerweiterung (siehe Seite 230) 

Komplettierung der Nummernerweiterung (siehe Seite 230) 

Standard Länder-Code (siehe Seite 230) 

Einstellungen für ausgehende Anrufe (siehe Seite 230) 

Telefonnummernauswahl anzeigen (siehe Seite 231) 

Suchtyp für Suche nach Agenten und Ansprechpartnern bei eingehenden Anrufen (siehe Seite 231) 

Suche nach Kunden (siehe Seite 231) 

 

13.2.1 Auswahl des Backends
SysConfig-Einstellung: CTI::BackendModule

Mit dieser Einstellung legen Sie fest, welches Backend für CTI genutzt werden soll. Standardmäßig ist das 
HTTP-Backend (Action URL handling) verfügbar und ausgewählt. Wenn Sie andere Backend-Module in KIX 
Professional installiert haben, sind diese ebenfalls auswählbar.
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13.2.2 Ansprechpartner PhoneID Type Mapping
SysConfig-Einstellung: CTI::Parameters###CustomerUserPhoneIDTypeAttribute

Mit dieser Einstellung legen Sie fest, welches Attribut eines Ansprechpartners den Typ der Telefonnummer 
spezifiert. Der Typ kann eine Telefonnummer, ein Session Initiation Protocol (SIP) oder eine MAC-Adresse 
sein, abhängig von Ihrem installierten Backend.

Der Standardwert ist "UserPhoneType". Es kann für jeden Kunden ein anderer Typ verwendet werden.

 

13.2.3 Ansprechpartner PhoneID Type Mapping - Standard
SysConfig-Einstellung: CTI::Parameters###CustomerUserPhoneIDTypeDefault

Mit dieser Einstellung legen Sie den Standardtyp der Telefonnummer fest, wenn in 
"CTI::Parameters###CustomerUserPhoneIDTypeAttribute" kein Typ angegeben ist.

 

13.2.4 Ansprechpartner PhoneID Mapping
SysConfig-Einstellung: CTI::Parameters###CustomerUserPhoneIDAttributes
SysConfig-Einstellung: CTI::Parameters###CustomerUserPhoneIDAttributeDefault

Mit dieser Einstellung legen Sie fest, welche Attribute eines Ansprechpartners als Telefonnummer genutzt 
werden. Der Typ kann eine Telefonnummer, ein Session Initiation Protocol (SIP) oder eine MAC-Adresse sein, 
abhängig von Ihrem installierten Backend.

Standardmäßig werden "UserPhone" und "UserMobile" genutzt.

 

13.2.5 Agenten PhoneID Type
SysConfig-Einstellung: CTI::Parameters###AgentPhoneIDTypeDefault

Mit dieser Einstellung legen Sie fest, welchen Typ die Telefonnummer eines Agenten hat. Der Typ kann eine 
Telefonnummer, ein Session Initiation Protocol (SIP) oder eine MAC-Adresse sein, abhängig von Ihrem 
installierten Backend.

Der Standardwert ist "Telefonnummer".
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13.2.6 Eingehende Anrufe - Filter
SysConfig-Einstellung: CTI::Parameters###IncomingPhoneIDSrcFilterRegEx
SysConfig-Einstellung: CTI::Parameters###IncomingPhoneIDDestFilterRegEx

Für eingehende Anrufe können Teile der Quellen- oder Zielparameter durch einen Filter eingeschränkt 
werden. Wenn das Format der Parameter nicht dem Wert in der Datenbank übereinstimmt, kann dies durch 
RegEx adaptiert werden.

Ein Beispiel für die Quelle:

Wert in der Datenbank: 00493715347
Format des eingehenden Anrufes: #000134@00493715347

Hier muss das RegEx den Teil nach dem "@" extrahieren, damit der Wert mit dem Wert in der Datenbank 
übereinstimmt.
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13.2.7 Erkennung der Nummernerweiterung
SysConfig-Einstellung: CTI::Parameters###ExtensionNumberLengthThreshold

Mit dieser Einstellung definieren Sie die Längenschwelle einer Telefonnummer innerhalb der sie als 
Nummernerweiterung interpretiert wird.

Der Standardwert ist "3".

13.2.8 Komplettierung der Nummernerweiterung
SysConfig-Einstellung: CTI::Parameters###ExtensionNumberCompletion

Mit dieser Einstellung definieren Sie den ersten Teil einer Telefonnummer, um eine Erweiterungsnummer zu 
komplettieren.

13.2.9 Standard Länder-Code
SysConfig-Einstellung: CTI::Parameters###DefaultCountryCode

Mit dieser Einstellung legen Sie die Standard-Länderkennung fest.

13.2.10 Einstellungen für ausgehende Anrufe
Die folgenden Einstellungen sind notwendig, um die Funktionalität für ausgehende Anrufe zu konfigurieren. 
Bitte beachten Sie, dass ausgehende Anrufe nur möglich sind, wenn eine Telefonnummer für den 
Ansprechpartner des Tickets UND für den aktuellen Agenten verfügbar ist. Wenn das nicht der Fall ist, wird 
der entsprechende Dialog nicht angezeigt.

Bitte beachten Sie, das alle Einstellungen mit "HTTP" nur für das HTTP-Backend gelten. Wenn Sie ein anderes 
Backend nutzen, schauen Sie bitte in die Dokumentation des jeweiligen Backend.

SysConfig-Einstellung: CTI::Backend::HTTP::Parameters###DialFrom

Abhängig von Ihrer Infrastruktur kann der Server die zentrale Kommunikation zum Wählen übernehmen. Es 
kann sein, dass der Server manchmal bspw. wegen Firewalls nicht in der Lage ist, zu wählen. Dann kann 
diese Einstellung auf "Client" geändert werden. Damit kann ein Nutzer direkt via Javascript initiiert aus dem 
Web-Browser wählen.

SysConfig-Einstellung:CTI::Backend::HTTP::Parameters###DialOutURL

Diese Einstellung legt die URL-Vorlage fest, die für ausgehende Anrufe genutzt wird. Wenn die Telefonanlage 
ein "dial-byURL"unterstützt, kann KIX Professional automatisch die ausgehenden Anrufe von Agenten 
historisieren und den entsprechenden Aufgaben zuordnen. Dieser URL enthält die Telefonnummer des 
Agenten und die Ziel-Rufnummer.
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SysConfig-Einstellung: CTI::Backend::HTTP::Parameters###DialOutProxyURL

Mit dieser Einstellung legen Sie den Proxy-URL für ausgehende Anrufe fest. Die Einstellung ist nur sinnvoll, 
wenn in "CTI::Backend::HTTP::Parameters###DialFrom" der Wert "Server" gewählt wurde. Die Einstellung 
muss deaktiviert werden, wenn kein Proxy genutzt wird.

SysConfig-Einstellung: CTI::Backend::HTTP::Parameters###ClientDialServerFeedbackURL

Mit dieser Einstellung legen Sie die URL-Vorlage fest, die bei client-seitigem Wählen genutzt wird, um den 
Server zu informieren.

 

13.2.11 Telefonnummernauswahl anzeigen
SysConfig-Einstellung: 
CTI::Backend::HTTP::Parameters###AgentPhoneOutboundEnablePhoneIDSelection

Für einen ausgehenden Anruf kann eine Auswahlliste angezeigt werden, in der ein Agent die Nummer 
auswählen kann von der der ausgehende Anruf initiiert wird.

 

13.2.12 Suchtyp für Suche nach Agenten und Ansprechpartnern bei 
eingehenden Anrufen

SysConfig-Einstellung: CTI::Parameters###SearchType

Mit dieser Einstellung legen Sie den Suchtyp fest, der genutzt werden soll, um nach Agenten oder 
Ansprechpartnern bei eingehenden Anrufen zu suchen. "Live" ist langsamer, führt aber eine Live-Suche durch 
und aktualisiert die Metadaten in der Datenbank. "Meta" ist schneller, nutzt aber nur die Metadaten, die in der 
Datenbank gespeichert sind.

 

13.2.13 Suche nach Kunden
SysConfig-Einstellung: CTI:Parameters###AgentPhoneNewCTIActionForCustomerUserLookUp

Mit dieser Einstellung legen Sie fest, welche CTI-Aktion die Suche nach Kunden auslöst, wenn ein Agent ein 
neues Ticket während eines eingehenden Anrufs öffnet. Standardmäßig ist als Aktion "CONNECTED" gesetzt, 
was bedeutet, dass ein eingehender Anruf zu einem Nutzer-Telefon verbunden wird. 
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14 Zusatzmodul Wartungsplaner
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14.1 Installation Zusatzmodul Wartungsplaner

14.1.1 Vorraussetzungen
KIX Professional 17 - aktuelle Version

14.1.2 Paket Installation
Installieren Sie das Paket "Wartungsplaner" über den Paketmanager des Betriebssystems oder über die 
Kommandozeile: kixpro-maintenanceplan.

Ist die Klasse "Wartungsplan" nicht vorhanden, finden Sie die Klassendefinition unter "<KIXHome>/var/ 
packagesetup/InitialCIClassDefinitions/" .

14.1.3 Neue Access Control Lists (ACL)
Während der Installation werden drei neue ACLs im System angelegt.

"500_TicketTypeMaintenance_OnlyInAgentfro 
ntend"

Bewirkt Nichtanzeige des Tickettyps "Maintenance" im 
Kundenfrontend.

"500_TicketTypeMaintenance_ActionAgentTic 
ketX"

Versteckt 13 Ticket-Aktionen (Menüpunkte in der 
Ticketübersicht). Welche genau das sind entnehmen Sie 
bitte der ACL direkt: Admin → ACL-Verwaltung→ ACL 
"500_TicketTypeMaintenance_ActionAgentTicketX" 
anklicken.

"500_TicketTypeMaintenance_ActionAgentTic 
ketMaintenance"

Wenn ein Ticket nicht vom Typ "Maintenance" ist, wird 
der Wartungstab nicht angezeigt und die Aktion 
"Wartungsdokumentation" steht nicht zur Verfügung.

14.1.4 Anpassung der CI-Klassen
Passen Sie die CI-Klassen für den Wartungsplaner entsprechend an: "<KIXHome>/var/packagesetup/ 
InitialCIClassDefinitions/MaintenanceCI.def".

14.1.5 Neuer Tickettyp
Während der Installation wird ein neuer Tickettyp "Maintenance" erzeugt. Er wird benutzt, um Wartungstickets 
zu kennzeichnen.
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14.1.6 Neue dynamische Felder
Die neu zur Verfügung stehenden dynamischen Felder sind relevant für Wartungstickets, welche automatisch 
erzeugt werden, wenn Wartungszeitpunkt erreicht wurde.

 

Feldname Erklärung

MaintenancePlan Enthält die ID des relevanten Wartungsplan-ConfigItem.

MaintenanceDate Enthält das Datum der Wartung.

MaintenanceCI Enthält die ID des relevanten ConfigItem, das gewartet werden soll.

MaintenanceCIClass Enthält die Klasse des relevanten ConfigItem, das gewartet werden soll.

MaintenancePlanTime Enthält die geplante Zeit für diese Wartung.

MaintenanceCILocation Enthält den Standort-ID des relevanten ConfigItem, das gewartet werden 
soll.

MaintenanceCostCenter Enthält die zugehörige Kostenstellen-ID des relevanten ConfigItem, das 
gewartet werden soll.

MaintenanceCIContact Enthält die ID des Ansprechpartners des relevanten ConfigItem, 
das gewartet werden soll.

MaintenanceCIType Enthält den Typ des relevanten ConfigItem, das gewartet werden soll.

MaintenanceSupplier Enthält den Kunden/Lieferanten, der die Wartung durchführt.

MaintenanceDueDate Enthält das Fälligkeitsdatum einer zeitbasierten Wartung.

MaintenanceThreshold Enthält den Schwellwert einer Schwellwert-basierten Wartung.

MaintenanceThresholdAttrib 
ute

Enthält den Attributname mit dem aktuellen Betriebszählwert 
des ConfigItem, das gewartet werden soll.
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Feldname Erklärung

MaintenanceReachedValue Enthält den aktuellen Betriebszählwert des ConfigItems, das gewartet 
werden soll.

MaintenanceSupplier Enthält den Kunden/Lieferanten, der die Wartung durchführt.

MaintenanceDueDate Enthält das Fälligkeitsdatum einer zeitbasierten Wartung.

MaintenanceThreshold Enthält den Schwellwert einer Schwellwert-basierten Wartung.

MaintenanceThresholdAttrib 
ute

Enthält den Attributname mit dem aktuellen Betriebszählwert 
des ConfigItem, das gewartet werden soll.

MaintenanceReachedValue Enthält den aktuellen Betriebszählwert des ConfigItems, das gewartet 
werden soll.

MaintenanceType Enthält den Typ des relevanten ConfgItem, das gewartet werden soll.

MaintenanceCosts Enthält die Kosten des relevanten ConfigItems, das gewartet werden soll.

RepairCosts Enthält die Reparaturkosten des relevanten ConfigItem, das gewartet 
werden soll.

MaintenancePlannedStart Enthält die geplante Startzeit.

MaintenancePlannedEnd Enthält die geplante Endzeit.

MaintenanceActualStart Enthält die aktuelle Startzeit.

MaintenanceActualEnd Enthält die aktuelle Endzeit.

MaintenanceType Enthält den Typ des relevanten ConfgItem, das gewartet werden soll.

MaintenanceCosts Enthält die Kosten des relevanten ConfigItems, das gewartet werden soll.
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Feldname Erklärung

RepairCosts Enthält die Reparaturkosten des relevanten ConfigItem, das gewartet 
werden soll.

MaintenancePlannedStart Enthält die geplante Startzeit.

MaintenancePlannedEnd Enthält die geplante Endzeit.

MaintenanceActualStart Enthält die aktuelle Startzeit.

MaintenanceActualEnd Enthält die aktuelle Endzeit.
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14.2 Konfiguration Zusatzmodul Wartungsplaner
Um die Einstellungen für diese Funktion zu konfigurieren, wählen Sie in der SysConfig die Gruppe "KIX Pro". 
Nachdem die Seite neu geladen wurde, wählen Sie eine der Untergruppen:

Core::CMDBMaintenanceCheckScheduler
Core::ITSMConfigItem
Core::Ticket
Frontend::Agent::KSBSimilarTicketList
Frontend::Agent::Ticket::ViewMaintenanceDocumentation
Frontend::Agent::Ticket::ViewTicketZoomTabMaintenance

 

14.2.1 Klassen für zeitbasierte Wartung
SysConfig-Einstellung: CMDBMaintenanceCheckScheduler::CIClassesTimeBased

Mit dieser Einstellung legen Sie fest, welche ConfigItem-Klassen für zeitbasierte Wartungen relevant sind. 
Der Eintrag im Feld "Schlüssel" ist der Klassenname. Der Eintrag im Feld "Inhalt" kann eine "1" oder eine "0" 
sein. Beim Wert "1" wird "Nächste Prüfung Erinnerung" verwendet, um zu prüfen, ob ein Wartungsticket erstellt 
werden muss. Beim Wert "0" wird "Nächste Prüfung" verwendet, um zu prüfen, ob ein Wartungsticket erstellt 
werden muss.

 

14.2.2 Klassen für schwellwertbasierte Wartung
SysConfig-Einstellung: CMDBMaintenanceCheckScheduler::CIClassesThresholdBased

 
Mit dieser Einstellung legen Sie fest, welche ConfigItem-Klassen für schwellenwert basierte Wartungen 
relevant sind. Der Eintrag im Feld "Schlüssel" ist der Klassenname. Der Eintrag im Feld "Inhalt" kann eine "1" 
oder eine "0" sein. Beim Wert "1" wird "Nächste Prüfung Erinnerung" verwendet, um zu prüfen, ob ein 
Wartungsticket erstellt werden muss. Beim Wert "0" wird "Nächste Prüfung" verwendet, um zu prüfen, ob ein 
Wartungsticket erstellt werden muss.

 

Bitte beachten: Diese Einstellung ist notwendig. Initial wird diese Einstellung leer ausgeliefert und 
muss zwingend vor der ersten Verwendung gefüllt werden.



Bitte beachten: Diese Einstellung ist notwendig. Initial wird diese Einstellung leer ausgeliefert und 
muss zwingend vor der ersten Verwendung gefüllt werden.
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14.2.3 Relevante Verwendungsstatus
SysConfig-Einstellung: CMDBMaintenanceCheckScheduler::CICassesDeploymentStates

Mit dieser Einstellung legen Sie fest, welche Verwendungsstatus für die jeweilige Klasse relevant sind, um zu 
prüfen, ob ein Wartungsticket erstellt werden muss. Der Eintrag im Feld "Schlüssel" ist der Klassenname. Der 
Eintrag im Feld "Inhalt" ist der Verwendungsstatus. Sie können hier mehrere Verwendungsstatus angeben, 
getrennt durch Komma oder Semikolon.

 

14.2.4 Prüfung schwellwertbasierender Wartungen
SysConfig-Einstellung: CMDBMaintenanceCheckScheduler::CheckThresholdBased

Mit dieser Einstellung legen Sie fest, ob schwellenwert basierte Wartungen auch durch den Scheduler geprüft 
werden sollen. Dies kann mehrere Tickets für die gleiche Wartung verursachen, falls die Überprüfung 
nochmals durchgeführt wird. Der Standardwert ist "Ja".

14.2.5 Link-Typen
SysConfig-Einstellung: CMDBMaintenanceCheckScheduler::TicketLinkType

Mit dieser Einstellung legen Sie den Verknüpfungstyp zwischen einem Wartungsticket und dem 
dazugehörigen ConfigItem fest. Der Standardwert ist "RelevantTo".

 

14.2.6 Ersetzen der derzeitigen ConfigItem-Version
SysConfig-Einstellung: CMDBMaintenanceCheckScheduler::ReplaceCIVersion

Mit dieser Einstellung legen Sie fest, ob eine Änderung des Wertes bei "Datum letzte Wartung" oder "Nächste 
Prüfung" die aktuelle Version eines ConfigItem ersetzt ("Ja") oder eine neue Version erzeugt wird ("Nein"). Der 
Standardwert ist "Ja".

Hinweis

Bitte beachten: Diese Einstellung ist auch notwendig. Wird hier kein Status hinterlegt, werden die CIs 
nicht geprüft.
Achtung: Es muss die englische Bezeichnung des Deployment-States eingegeben werden.



Bitte beachten: Diese Einstellung ist notwendig.
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14.2.7 Standard Ticketdaten
SysConfig-Einstellung: CMDBMaintenanceCheckScheduler::NewTicket###TicketData

Mit diesen Einstellungen legen Sie die Ticketdaten für neue Wartungstickets fest. Der Eintrag im Feld 
"Schlüssel" kann eine ConfigItem Klasse gefolgt von ":::" und einem Ticketattribut sein. Die Einstellung dient 
ebenfalls als Fallback.  
 

14.2.8 Ticketattribute - ConfigItem-Atrribute Mapping
SysConfig-Einstellung: 
CMDBMaintenanceCheckScheduler::NewTicket###TicketDataCIAttributeMapping

Mit dieser Einstellung legen Sie das Mapping fest, welches Ticketattribut (Eintrag im Feld "Schlüssel") seinen 
Wert von welchem ConfigItem Attribut (Eintrag im Feld "Inhalt") erhält. Der Eintrag im Feld "Schlüssel" kann 
eine ConfigItem-Klasse gefolgt von ":::" und einem Ticketattribut oder einem dynamischen Feld sein. Bei 
dynamischen Feldern nutzen Sie bitte die Syntax "DynamicField_Feldname". Der Eintrag im Feld "Inhalt" muss 
mit "Maintenance:::" beginnen, gefolgt von einem Attribut, wenn das Attribut ein Unterattribut von einem 
Wartungsattribut in den relevanten ConfigItem Klassen ist.

 

14.2.9 Standard Artikeldaten
SysConfig-Einstellung: CMDBMaintenanceCheckScheduler::NewTicket###ArticleData

Mit dieser Einstellung legen Sie die Artikeldaten für ein neu erzeugtes Wartungsticket fest. Die Einstellung 
dient ebenfalls als Fallback. Der Eintrag im Feld "Schlüssel" kann eine ConfigItem Klasse gefolgt von ":::" und 
einem Artikelattribut sein.

 

Bitte beachten: Diese Einstellung ist notwendig.

Bitte beachten: Die Einstellung ist notwendig. Es wird empfohlen, ein ConfigItem-Referenzattribut zu 
nutzen (bspw. "ServiceReference"), wenn das relevante Ticketattribut kein dynamisches Feld ist. Es 
sind nur dynamische Felder des Typs "Ticket" möglich.



Bitte beachten: Diese Einstellung ist notwendig.
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14.2.10 Scheduler Registrierung
SysConfig-Einstellung: 
Daemon::SchedulerCronTaskManager::Task###CMDBMaintenanceCheckScheduler

Diese Einstellung ist die Registrierung des Schedulers. Wenn der Scheduler läuft, werden alle Wartungen von 
relevanten ConfigItems geprüft und Wartungstickets erzeugt, wenn notwendig. Der Wert im Feld "Inhalt" für 
den Schlüssel "Scheduler" ist eine cron-Notation.

 

14.2.11 Event für Gültigkeitsprüfung
SysConfig-Einstellung: ITSMConfigItem::EventModulePre###100-CheckAttributes

Diese Einstellung ist die Registrierung für ein ConfigItem Event-Modul, dass den Inhalt von ConfigItem- 
Attributen prüft, BEVOR eine neue Version des ConfigItems erzeugt wird. Nutzen sie die folgenden 
Einstellungen "CheckCIAttributes###CIAttributeValuesMaintenancePlan" und 
"CheckCIAttributes###CIAttributeValuesMaintenanceCI" um die Parameter für die Prüfung festzulegen. 
Dieses Event sichert ebenfalls ab, dass jeder Wartungsplan nur einmal in einem zu wartenden ConfigItem 
genutzt wird.

 

14.2.12 Gültigkeitsprüfung - Parameter für Wartungsplaner
SysConfig-Einstellung: CheckAttributes###CIAttributeValuesMaintenancePlan

Mit dieser Einstellung definieren Sie die ConfigItem-Attribute der ConfigItem-Klasse "MaintenancePlan" für 
die Gültigkeitsprüfung. Der Eintrag im Feld "Schlüssel" ist das Attribut gefolgt von ":::" und einem spezifischen 
Wert des jeweiligen Attributs. Die Einträge im Feld "Inhalt" sind andere Attribute, die obligatorisch sind, wenn 
der spezielle Wert genutzt wird. Wenn die Prüfung ein negatives Ergebnis ergibt, wird eine Fehlermeldung 
dargestellt.

 

Bitte beachten: Die Einstellung ist notwendig. Bitte deaktivieren Sie die Einstellung nur wenn 
unbedingt notwendig. Es ist ebenfalls notwendig, das der Deamon läuft.



Bitte beachten: Die Einstellung ist notwendig. In der Standard-Einstellung ist festgelegt, dass bei 
zeit-basierten Wartungen das Attribut "Intervall" einen Wert haben muss. Ebenso ist in der Standard- 
Einstellung festgelegt, dass das Attribut "Contact" einen Inhalt haben muss, wenn der 
Ansprechpartnertyp auf "fest" gesetzt ist.
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14.2.13 Gültigkeitsprüfung - Parameter für gewartete ConfigItems
SysConfig-Einstellung: CheckCIAttributes###CIAttributeValuesMaintenanceCI

Mit dieser Einstellung definieren Sie die ConfigItem-Attribute der gegebenen ConfigItem-Klasse für die 
Gültigkeitsprüfung. Der Eintrag im Feld "Schlüssel" ist die Klasse gefolgt von "###" und einem Wartungs- 
Unterattribut gefolgt von ":::" und einem spezifischen Wert des jeweiligen Attributs. Die Einträge im Feld 
"Inhalt" sind andere Attribute, die obligatorisch sind, wenn der spezielle Wert genutzt wird. Nutzen Sie 
"Maintenance:::" vor dem obligatorischen Attribut, um es als Unter-Attribut der jeweiligen ConfigItem-Klasse 
zu kennzeichnen. Wenn eine Klasse nicht spezifiziert ist, wird der spezifische Eintrag genutzt für 
"CMDBMaintenanceCheckScheduler::CIClasses...". Wenn ein ConfigItem keinen Wert für das angegebene 
Unter-Attribut hat, wird das zugehörige Attribut des relevanten Wartungsplan-ConfigItem geprüft. Wenn dies 
ebenfalls scheitert, erscheint eine Fehlermeldung.

 

14.2.14 Event für Prüfung nach Wertaktualisierung bei einer 
schwellwertbasierten Wartung

SysConfig-Einstellung: ITSMConfigItem::EventModulePost###100-ThresholdCheck

Das ist die Registrierung für ein ConfigItem Event-Modul für schwellwert-basierte Wartungen. Das Modul 
prüft, ob bei einer schwellwert basierten Wartung ein Wartungsticket für ein ConfigItem erzeugt werden soll. 
Es werden die relevanten Optionen von "Core::CMDBMaintenanceCheckScheduler" verwendet.

 

14.2.15 Ticketdaten an ein ConfigItem zurückschreiben
SysConfig-Einstellung: Ticket::EventModulePost###600-WriteMaintenanceTicketDataIntoCI

 

Bitte beachten: Diese Einstellung ist notwendig. In der Standard-Einstellung ist festgelegt, dass bei 
der derzeit betrachteten Wartung die Attribute "Interval" und "Datum nächste Prüfung" einen Wert 
haben müssen, wenn "zeitbasiert" für den Wartungstyp angegeben wurde. Wenn "schwellwert 
basiert" als Wartungstyp angegeben wurde, müssen die Attribute "Wartung" und "Nächste Prüfung" 
einen Inhalt haben.
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14.2.16 ConfigItem-Attribute - Mapping dynamischer Felder
SysConfig-Einstellung: UpdateMaintenanceCIData###CIAttributeMapping

 

14.2.17 Parameter für Suche nach gleichen Tickets
SysConfig-Einstellung: KIXSideBarSimilarTickets###000 (010, 020)

 

14.2.18 Berechtigung für "Änderungs"-Popup
SysConfig-Einstellung: Ticket::Frontend::AgentTicketMaintenance###Permission

 

14.2.19 Gewünschte Sperre einstellen
SysConfig-Einstellung: Ticket::Frontend::AgentTicketMaintenance###RequiredLock

 

14.2.20 Anlegen von Wartungstickets
Die Prüfung, ob Wartungstickets erzeugt werden müssen, geschieht entweder durch den Daemon im 
Hintergrund oder über dieses Konsole-Script:

sudo -u www-data bin/kix.Console.pl Admin::MaintenancePlan::Check
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14.3 Nutzung
Hier finden Sie unterschiedliche Ansätze, um Ihnen die Benutzung des Moduls zu vereinfachen.

14.3.1 Anpassung der CI-Klassen für den Wartungsplaner
Um einen Wartungsplan an einem ConfigItem zu hinterlegen, muss vorher die CI-Klasse des ConfigItems 
entsprechend angepasst werden (Pfad in der Installation "<KIXHome>/var/packagesetup/ 
InitialCIClassDefinitions/MaintenanceCI.def" ).

 

14.3.1.1 Anpassung für zeitbasierte Wartung

Möchten Sie eine zeitbasierte Wartung anlegen, passen Sie den Code wie folgt an:

[
    {
        Key        => 'AssignedCostCenter',
        Name       => 'Assigned Cost Center',
        Searchable => 1,
        Input => {
            Type                           => 'CIClassReference',
            ReferencedCIClassName          => 'Cost Center',
            ReferencedCIClassLinkType      => 'RelevantTo',
            ReferencedCIClassLinkDirection => '',
            Required => 0,
        },
    },
    {
        Key        => 'CILocation',
        Name       => 'Asset Location',
        Searchable => 1,
        Input => {
            Type                           => 'CIClassReference',
            ReferencedCIClassName          => 'Location',
            ReferencedCIClassLinkType      => 'RelevantTo',
            ReferencedCIClassLinkDirection => '',
            Required => 0,
        },
    },
    {
        Key        => 'ResponsibleUser',
        Name       => 'Responsible user',
        Searchable => 1,
        Input => {
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            Type      => 'Customer', 
        },
    },
    {
        Key        => 'Maintenance',
        Name       => 'Maintenance',
        Searchable => 1,
        Input => {
            Type                           => 'CIClassReference',
            ReferencedCIClassName          => 'MaintenancePlan',
            ReferencedCIClassLinkType      => 'Includes',
            ReferencedCIClassLinkDirection => 'Reverse',
            Required                       => 1,
        },
        Sub => [
            {
                Key   => 'MaintenanceType',
                Name  => 'Maintenance type',
                Input => {
                    Type        => 'GeneralCatalog',
                    Class       => 'ITSM::ConfigItem::Maintenance::Type',
                    Translation => 1,
                    Required    => 0,
                },
            },
            {
                Key   => 'TimeBased',
                Name  => 'Time based',
                Input => {
                    Type     => 'Dummy',
                    Required => 0,
                },
                Sub => [
                    {
                        Key        => 'Interval',
                        Name       => 'Interval',
                        Searchable => 1,
                        Input      => {
                            Type => 'GeneralCatalog',
                            Class => 'ITSM::ConfigItem::Maintenance::Interval',
                            Translation => 1,
                            Required => 0,
                        },
                    },
                    {
                        Key => 'NextCheckDate',
                        Name => 'Next check date',
                        Searchable => 1,
                        Input => {
                            Type => 'Date',
                            Required => 1,
                        },
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                        CountMin => 0,
                        CountMax => 1,
                        CountDefault => 1,
                    },
                    {
                        Key => 'NextCheckDateReminder',
                        Name => 'Next check date reminder',
                        Searchable => 1,
                        Input => {
                            Type => 'Date',
                            Required => 1,
                        },
                        CountMin => 0,
                        CountMax => 1,
                        CountDefault => 1,
                    },
                ],
                CountMin => 0,
                CountDefault => 0,
                CountMax => 1,
            }, 
            {
                Key        => 'TicketTemplate',
                Name       => 'Ticket-Template',
                Searchable => 1,
                Input         => {
                    Type      => 'TicketTemplateReference',
                    Required  => 0,
                },
                CountMin     => 0,
                CountDefault => 0,
                CountMax     => 1,
            },
            {
                Key        => 'MaintenanceSupplier',
                Name       => 'Maintenance supplier',
                Input         => {
                    Type      => 'CIACCustomerCompany',
                    Required  => 0,
                },
                CountMin     => 0,
                CountMax     => 1,
            },
            {
                Key        => 'PlannedMaintenanceTime',
                Name       => 'Planned maintenance time (min)',
                Searchable => 1,
                Input         => {
                    Type      => 'Text',
                },
                CountMin     => 0,
                CountMax     => 1,
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                CountDefault => 0,
            },
            {
                Key => 'LastMaintenanceDate',
                Name => 'Last maintenance date',
                Searchable => 1,
                Input => {
                    Type => 'Date',
                    Required => 1,
                },
                CountMin => 0,
                CountMax => 1,
                CountDefault => 0,
            },
            {
                Key => 'MaintenanceNote',
                Name => 'Maintenance note',
                Searchable => 1,
                Input => {
                    Type => 'TextArea',
                    Required => 1,
                },
                CountMin => 0,
                CountMax => 1,
                CountDefault => 0,
            },
        ],
        CountMin => 0,
        CountMax => 10,
    },
];

14.3.1.2 Anpassung für schwellenwert basierte Wartung

Möchten Sie eine schwellenwert besierte Wartung anlegen, passen Sie den Code wie folgt an:

[
    {
        Key        => 'AssignedCostCenter',
        Name       => 'Assigned Cost Center',
        Searchable => 1,
        Input => {
            Type                           => 'CIClassReference',
            ReferencedCIClassName          => 'Cost Center',
            ReferencedCIClassLinkType      => 'RelevantTo',
            ReferencedCIClassLinkDirection => '',
            Required => 0,
        },
    },
    {
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        Key        => 'CILocation',
        Name       => 'Asset Location',
        Searchable => 1,
        Input => {
            Type                           => 'CIClassReference',
            ReferencedCIClassName          => 'Location',
            ReferencedCIClassLinkType      => 'RelevantTo',
            ReferencedCIClassLinkDirection => '',
            Required => 0,
        },
    },
    {
        Key        => 'ResponsibleUser',
        Name       => 'Responsible user',
        Searchable => 1,
        Input => {
            Type      => 'Customer', 
        },
    },
    {
        Key        => 'Maintenance',
        Name       => 'Maintenance',
        Searchable => 1,
        Input => {
            Type                           => 'CIClassReference',
            ReferencedCIClassName          => 'MaintenancePlan',
            ReferencedCIClassLinkType      => 'Includes',
            ReferencedCIClassLinkDirection => 'Reverse',
            Required                       => 1,
        },
        Sub => [
            {
                Key   => 'MaintenanceType',
                Name  => 'Maintenance type',
                Input => {
                    Type        => 'GeneralCatalog',
                    Class       => 'ITSM::ConfigItem::Maintenance::Type',
                    Translation => 1,
                    Required    => 0,
                },
            },
            {
                Key => 'ThresholdBased',
                Name => 'Threshold based',
                Input      => {
                    Type        => 'Dummy',
                    Required    => 0,
                },
                Sub => [
                    {
                        Key        => 'ThresholdAttribute',
                        Name       => 'Threshold attribute',
                        Input => {
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                            Type      => 'Text',
                            Size      => 50,
                            MaxLength => 50,
                            Required  => 0,
                        },
                    },
                    {
                        Key        => 'NextCheckThreshold',
                        Name       => 'Next check threshold',
                        Input => {
                            Type      => 'Text',
                            Size      => 50,
                            MaxLength => 50,
                            Required  => 0,
                        },
                    },
                    {
                        Key        => 'NextCheckThresholdReminder',
                        Name       => 'Next check threshold reminder (%)',
                        Input => {
                            Type      => 'Text',
                            Size      => 50,
                            MaxLength => 50,
                            Required  => 0,
                        },
                    },
                    {
                        Key => 'NextCheckThresholdIncrease',
                        Name => 'Automatic threshold increase by',
                        Searchable => 1,
                        Input => {
                            Type => 'GeneralCatalog',
                            Class => 
'ITSM::ConfigItem::Maintenance::ThresholdIncrease',
                            Translation => 1,
                            Required => 0,
                        },
                        Sub => [
                            {
                                Key        => 'ManualThresholdIncrease',
                                Name       => 'Manual value for threshold increase',
                                Input => {
                                    Type      => 'Text',
                                    Size      => 50,
                                    MaxLength => 50,
                                    Required  => 0,
                                    RegEx     => '^\d+$',
                                },
                            },
                        ],
                    },
                ],
                CountMin => 0,
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                CountDefault => 0,
                CountMax => 1,
            },
            {
                Key        => 'TicketTemplate',
                Name       => 'Ticket-Template',
                Searchable => 1,
                Input         => {
                    Type      => 'TicketTemplateReference',
                    Required  => 0,
                },
                CountMin     => 0,
                CountDefault => 0,
                CountMax     => 1,
            },
            {
                Key        => 'MaintenanceSupplier',
                Name       => 'Maintenance supplier',
                Input         => {
                    Type      => 'CIACCustomerCompany',
                    Required  => 0,
                },
                CountMin     => 0,
                CountMax     => 1,
            },
            {
                Key        => 'PlannedMaintenanceTime',
                Name       => 'Planned maintenance time (min)',
                Searchable => 1,
                Input         => {
                    Type      => 'Text',
                },
                CountMin     => 0,
                CountMax     => 1,
                CountDefault => 0,
            },
            {
                Key => 'LastMaintenanceDate',
                Name => 'Last maintenance date',
                Searchable => 1,
                Input => {
                    Type => 'Date',
                    Required => 1,
                },
                CountMin => 0,
                CountMax => 1,
                CountDefault => 0,
            },
            {
                Key => 'MaintenanceNote',
                Name => 'Maintenance note',
                Searchable => 1,
                Input => {
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                    Type => 'TextArea',
                    Required => 1,
                },
                CountMin => 0,
                CountMax => 1,
                CountDefault => 0,
            },
        ],
        CountMin => 0,
        CountMax => 10,
    },
];

Bei Bedarf können Sie beide Arten der Wartung innerhalb einer CI-Klasse auch miteinander kombinieren.

 

14.3.2 Zusammensetzung der Wartungsintervalle
Nachfolgend finden Sie kurze Beispiele, wie sich die Wartungsintervalle zusammensetzen und wie diese 
genau verwendet werden. 
 

•
•
•
•

•
•

Beispiele

`WeekdayPerMonth`:
Geben Sie in den Intervall-Daten an: `[Every]:::[Weekdays]`

[Every] ist eine komma-separierte Liste des Nten Wochentags im Monat.
[Weekdays] ist eine komma-separierte Liste der Wochentage.
Beispiel für jeden zweiten Dienstag im Monat: 2:::2

 
`Woche`, `Monat`, `Jahr`:

Hier muss in den Intervall-Daten lediglich eine Zahl eingetragen werden.
Beispiel für den 2. Monat: 2

 
Bitte beachten: Bei `Einmalig` und `Wochentag` wird in den Intervall-Daten nichts hinterlegt.
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15 Zusatzmodul Zeiterfassung
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15.1 Installation Zusatzmodul Zeiterfassung

15.1.1 Vorraussetzungen
KIX Professional 17 - aktuelle Version 
 

15.1.2 Paket Installation
Installieren Sie das Paket "KIXTicketAccounting" mit der "Paketverwaltung" (Menü "Admin" Bereich 
"Systemverwaltung") oder über die Kommandozeile.
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15.2 Konfiguration Zusatzmodul Zeiterfassung

Begriff Erklärung

PreferencesGroups###PreferencesTim 
eAccounting

Registrierung neuer persönlichen Einstellung.

Frontend::Module###AgentTicketTimeA 
ccountingEdit

Frontend Module Registrierung.

Frontend::Module###AgentTicketZoom 
TabTimeAccounting

Frontend Module Registrierung.

Frontend::Output::FilterElementPre###T 
imeAccountingInputStyleHHMM

De-/Aktiviert Output Filter für die Layoutänderung zur 
Zeiteingabe in Format hh:mm

"TemplateFileRegexp" Erlaubt Einschränkung auf 
bestimmte tt-Files.

"ReferToEditTimeTabR 
egexp"

Regulärer Ausdruck der alle 
Tickettemplates erfasst, welche 
die Bearbeitung von 
Zeitbuchungen erlauben.

Gebuchte Zeiten müssen immer 
im Zeitbuchungstab bearbeitet 
werden.

Frontend::Output::FilterElementPre###T 
imeAccountingTimeUnitsCheck 

De-/Aktiviert Output Filter für die Festlegung der mindestens 
zu buchenden Zeit.

"MinimumTimeUnits" Gibt die mindestens 
einzugebende Zeit in Minuten an.

Loader::Agent::CommonJS###900- 
KIXTicketTimeAccounting

Registrierung von JS-Dateien.

Loader::Agent::CommonCSS###900- 
KIXTicketTimeAccounting 

Registrierung von CSS-Dateien.
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Begriff Erklärung

Ticket::Acl::Module###500- 
AccountetTimeRestrictTicketStates

Ticket-ACL zur Beschränkung von Ticketstatus und 
Ticketaktionen für Tickets ohne Zeiteintrag.

Ticket::CustomModule###900- 
KIXTicketTimeAccounting

Erweiterung der Ticketfunktionen.

Ticket::Frontend::AgentTicketTimeAcco 
untingEdit###Permission

Benötigte Berechtigungen.

Ticket::Frontend::AgentTicketZoomTab 
AccountedTime###AccountedTimeArti 
cle

Wenn Arbeitszeit ohne Artikel erfasst wird, sollen diese 
Zeiteinheiten dann an einen Artikel angehangen werden?

Ticket::Frontend::AgentTicketZoomTabT 
imeAccounting###RedirectURL

URL zur Weiterleitung bei Schließen des Popups.

TicketTimeAccounting::ReferenceFields 
###InitialReference

Festlegung der vorausgewählten Buchungsreferenz

"Ticket Owner Attribute" Persönliche Präferenz des 
Ticketbesitzers

"Ticket Responsible 
Attribute"

Persönliche Präferenz des 
Ticketverantwortlichen

"Current User Attribute" Persönliche Präferenz des 
Agenten

"Ticket Attribute" Am Ticket hinterlegte 
Präferenz
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Begriff Erklärung

TicketTimeAccounting::ReferenceFields: 
:1

Konfiguration für das erste Referenzfeld:

"DynamicField" Dynamisches Feld für die 
Referenz (Artikelbasiert)

"PreferenceDynamicField 
"

Dynamisches Feld für die 
Präferenz (Ticketbasiert)

"Mandatory" Pflichtfeldeinstellung für 
" 
AgentTicketTimeAccountingEdi 
t" und 
" 
AgentTicketZoomTabTimeAcco 
unting"

"ShowInStats" Referenz in Statistiken 
verwenden

TicketTimeAccounting::ReferenceFields: 
:2

Konfiguration für das zweite Referenzfeld:

"DynamicField" Dynamisches Feld für die 
Referenz (Artikelbasiert)

"PreferenceDynamicField 
"

Dynamisches Feld für die 
Präferenz (Ticketbasiert)

"Mandatory" Pflichtfeldeinstellung für 
" 
AgentTicketTimeAccountingEdi 
t" und 
" 
AgentTicketZoomTabTimeAcco 
unting"

"ShowInStats" Referenz in Statistiken 
verwenden



KIX 17 Administration  –  KIX Pro Zusatzmodule
Zusatzmodul Zeiterfassung

Konfiguration Zusatzmodul Zeiterfassung

Erstellt am: 19.01.2022                                                                   Seite 256
 

Begriff Erklärung

TicketTimeAccounting::ReferenceFields: 
:3

Konfiguration für das dritte Referenzfeld:

"DynamicField" Dynamisches Feld für die 
Referenz (Artikelbasiert)

"PreferenceDynamicField 
"

Dynamisches Feld für die 
Präferenz (Ticketbasiert)

"Mandatory" Pflichtfeldeinstellung für 
" 
AgentTicketTimeAccountingEdi 
t" und 
" 
AgentTicketZoomTabTimeAcco 
unting"

"ShowInStats" Referenz in Statistiken 
verwenden

TicketTimeAccounting::ReferenceFields: 
:4

Konfiguration für das vierte Referenzfeld:

"DynamicField" Dynamisches Feld für die 
Referenz (Artikelbasiert)

"PreferenceDynamicField 
"

Dynamisches Feld für die 
Präferenz (Ticketbasiert)

"Mandatory" Pflichtfeldeinstellung für 
" 
AgentTicketTimeAccountingEdi 
t" und 
" 
AgentTicketZoomTabTimeAcco 
unting"

"ShowInStats" Referenz in Statistiken 
verwenden
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Begriff Erklärung

TicketTimeAccounting::Flag Konfiguration für das Markierungsfeld:

"DynamicField" Dynamisches Feld für die 
Referenz (Artikelbasiert)

"Mandatory" Pflichtfeldeinstellung für 
"AgentTicketTimeAccountingEdit" 
und 
" 
AgentTicketZoomTabTimeAccoun 
ting"

"ShowInStats" Referenz in Statistiken verwenden

Ticket::Frontend::AgentTicketZoomTabT 
imeAccounting###TableFields

Konfiguration der anzuzeigenden Tabellenspalten. 
Standardkonfiguration umfasst alle möglichen Angaben:

100::Date → Date

110::Time Units → TimeUnitsDHMS

120::Editor → CreateBy

200::Project → ReferenceField 1

210::Subproject → ReferenceField2

220::Workpackage → ReferenceField3

230::Subworkpackage → ReferenceField4

300::Description → Description

Schlüssel besteht aus numerischem Präfix + „::“ + 
Spaltenüberschrift der die Spaltenreihenfolge definiert. Der 
Wert bezeichnet das jeweilige anzuzeigende Attribut.

Ticket::EventModulePost###CreateKIXT 
TAEntry

Registrierung des Ticket-Events

DashboardBackend###0300- 
TimeAccounting

Frontend Module Registrierung
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•
•

•
•

•
•
•

•
•
•
•
•

Begriff Erklärung

Frontend::Module###AgentITSMConfigI 
temAccountedTickets

Registrierung Frontendmodule zur Anzeige und CSV- 
Download der kontierten Tickets

ITSMConfigItem::Frontend::MenuModul 
e###900-AccountedTickets

Aktivierung der CI-Aktion „Accounted Tickets“ bei Ansicht 
eines ITSM Config Items

ITSMConfigItem::Frontend::AgentITSMC 
onfigItemAccountedTickets###Permiss 
ion

Benötigte Berechtigung zum Aufrufen der Funktion. Standard: 
„RO“

ITSMConfigItem::Frontend::AgentITSMC 
onfigItemAccountedTickets###Selectio 
n

Registrierung der in Aktion „AccountedTickets“ beinhalteten 
Abschnitte

AccountedTickets::Section001
AccountedTickets::Section002

AccountedTickets::Section001###- 
Config

Konfiguration für Abschnitt

Title = Accounted Tickets
Description = Shows ticket which

account time to current object.

KIXTTAReference = 1
LinkReference = 0
LinkType = ReworkFor

AccountedTickets::Section001###- 
TicketList

Definiert welche Ticketattribute in der Ticketliste des 
Bereiches angezeigt werden. Die Spaltenreihenfolge wird 
durch alphanumerische Sortierung der Schlüssel definiert. 
Dazu wird ein mittels Doppl-Doppelpunkt abgetrennter Präfix 
verwendet. Der Präfix ist gefolgt von der techn. Bezeichnung 
des anzuzeigenden Ticketattributes. Der Wert enthält die 
Beschriftung der Spalte.

001::TicketNumber = Ticketnumber
010::Title = Title
020::State = State
030::Owner = Owner
040::ObjectAccountedTime = Accounted Time (on this 
reference)
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•

•
•

•
•
•

•
•

•
•
•

•

•
•

•
•
•
•

•

Begriff Erklärung

AccountedTickets::Section001###- 
DefaultSelection

Definiert ob der Abschnitt im Bereich „CSV Herunterladen“ 
bereits markiert ist oder manuell ausgewählt werden muss.

Standard: Ja

AccountedTickets::Section002###- 
Config

Siehe AccountedTickets::Section001###-TicketList

Title = Accounted Tickets
Description = Shows ticket which are not accounted but 
linked to current object
KIXTTAReference = 1
LinkReference = 01
LinkType = ReworkFor

AccountedTickets::Section002###- 
TicketList

Siehe AccountedTickets::Section001###-TicketList

Title = Accounted Tickets
Description = Shows ticket which are not accounted but 
linked to current object
KIXTTAReference = 1
LinkReference = 01
LinkType = ReworkFor

AccountedTickets::Section002###- 
DefaultSelection

Siehe AccountedTickets::Section002###-DefaultSelection

Standard: Ja

LinkObject::Type###ReworkFor Registrierung LinkTyp

SourceName → Rework For
TargetName → Rework

LinkObject::PossibleLink###3605 Aktivierung Verknüpfung Ticket ↔ ITSMConfigItem
Object1 → Ticket
Object2 → ITSMConfigItem
Type → ReworkFor

Frontend::KIXSidebarBackend###- 
BudgetOverview

Parameter für KIXSidebar Backend BudgetOverview

nur Referenzebene 1 (Project)
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•

•

•

•

•

Begriff Erklärung

Frontend::KIXSidebarBackend###- 
BudgetDetailview

Parameter für KIXSidebar Backend BudgetDetailview

bis Referenzebene 4 (Subworkpackage)

AgentCustomerInformationCenter::Back 
end###0800-CIC-BudgetOverview

Parameter für CIC-Dashboard BudgetOverview

nur Referenzebene 1 (Project)

AgentCustomerInformationCenter::Back 
end###0805-CIC-BudgetOverview

Parameter für CIC-Dashboard BudgetOverview

bis Referenzebene 4 (Subworkpackage)

 

15.2.1 CIC-Dashlet und Ticket-Sidebar freie Budgets
Die beiden Features dienen zur Anzeige der bereits gebuchten und noch im Rahmen des jeweils 
referenzierten Projektes, Teilprojektes, Arbeitspaketes oder Teilarbeitspaketes verfügbaren Zeitkontingents.  
Die Funktionen sind bei der Paket-Installation aktiviert aber sind nur dann verfügbar, wenn folgende 
Bedingungen erfüllt sind:

die erste Buchungsreferenz mittels DynamicField-Typ "{}ITSMConfigItemReference" bei der 
Zeiterfassung aktiviert ist

          UND

 die Definitionen für CI-Klassen „Project" und „Workpackage" entsprechend MANUELL angepasst sind. 
Zu den Definitionen von „Project" und „Workpackage" ist noch das Attribut 
"CustomerCompany" (KundenID) manuell einzutragen. Als Attributtyp soll "CustomerCompany 
CIACCustomerCompany" verwendet werden.

 

{
Key => 'CustomerCompany',
Name => 'CustomerCompany',
Searchable => 1,
Input =>
    {   
    Type => 'CIACCustomerCompany',
    },
}
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Die Definition von „Project" ist um ein Attribut "PlannedEffort" (required - Array[0..1]) zu ergänzen.

 

{
Key => 'PlannedEffort',
Name => 'Planned effort (hours),
Searchable => 0,
Input =>
    {
    Type => 'Text',
    Required => 1,
    Size => 50,
    MaxLength => 100,
    },
}
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•
•

•
•
•
•
•

Bei der Standard-Konfiguration werden die Zeiten für Arbeitspakete aufgelistet (1 Zeile pro AP).

Ticketsidebar: Es werden alle (und nur) Arbeitspakete aufgelistet, die im Ticket gebucht wurden.
CIC Dashlet: Es werden alle (und nur die) Arbeitspakete aufgelistet, die zur Kunden-ID zugeordnet sind 
UND mindestens in einem Ticket gebucht wurden.

 

Es ist konfigurierbar, ob die Zeiten für Projekte, Teilprojekte, Arbeitspakete oder Teilarbeitspakete aufgelistet 
werden sollen (evtl. für CIs von anderen Klassen, je nach der Konfiguration von Buchungsreferenzen).

Verfügbare Standard-Spalten sind:

Projekt
Teilprojekt
Arbeitspaket
gebucht
verfügbar

Die Zahl "gebucht" wird dabei aus ALLEN Buchungen auf dieses Arbeitspaket ermittelt (die Summe von 
Buchungen auf diese AP aus ALLEN Tickets).

Die Zahl "verfügbar" ist die Differenz aus "gebucht" und dem Wert im (konfigurierbarem) CI-Klassenattribut 
_"PlannedEffort".

Ist der Wert in "verfügbar" negativ, wird die Zeile rot markiert. Die Anzeige von Spalten Projekt/Teilprojekt / 
Arbeitspaket/Teilarbeitspaket ist konfigurierbar.
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16 Haftungsausschluss KIX Pro Zusatzmodule
Alle Text- und Grafikteile dieses Dokumentes wurden mit besonderer Sorgfalt bearbeitet. Dennoch kann für 
eventuelle technische oder redaktionelle Fehler oder Auslassungen in diesem Dokument keine Haftung 
übernommen werden. Dies gilt auch für jegliche Neben- oder Folgeschäden, die möglicherweise aus 
Bereitstellung, Funktion oder Gebrauch dieses Materials entstehen.

Hinweise bezüglich Gestaltung, Ergänzungen und eventuell vorhandener Fehler können Sie jederzeit unserem 
Supportteam (https://forum.kixdesk.com) weiterleiten. Gern werden wir sinnvolle Anregungen und 
Verbesserungen aufgreifen und umsetzen.

Alle in diesem Druckwerk mitgeteilten Daten, Merkmale und Beschreibungen können sich jederzeit und ohne 
besondere Ankündigungen ändern. Personennamen und Firmenbezeichnungen sind frei erfunden. Eventuelle 
Übereinstimmungen mit real existierenden Personen und Unternehmen sind rein zufällig.  
 
Copyright ©2022

c.a.p.e. IT GmbH, Chemnitz

https://forum.kixdesk.com
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•
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•
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17 Zweckbestimmung für die Verwendung von KIX 
Zusatzmodulen im medizinischen Bereich

KIX ist weder dafür geeignet, bestimmt, noch zugelassen, Krankheiten, Verletzung oder Behinderungen zu 
erkennen, verhüten, überwachen, behandeln, zu lindern oder zu kompensieren. KIX dient auch nicht der 
Untersuchung, der Ersetzung oder der Veränderung des anatomischen Aufbaus oder eines physiologischen 
Vorgangs. Zudem darf KIX nicht dafür eingesetzt werden, unmittelbar ein diagnostisches oder 
therapeutisches Produkt zu steuern. KIX ist ferner nicht dazu bestimmt, mit einem Medizinprodukt so 
verwendet zu werden, dass dieses Medizinprodukt seine Zweckbestimmung erfüllen kann.

KIX ist im medizinischen Bereich ausschließlich für Verwaltungs- und Datenbankaufgaben zu verwenden. 
Unter Beachtung der vorstehenden Einschränkungen kann KIX daher im medizinischen Umfeld angewendet 
werden

für reine Dokumentationszwecke, wie etwa:
das übergreifendes Management von Equipment in Form von Verwaltung und Inventarisierung 
der Gerätedaten (Metadaten der Geräte) wie Namen, IP-Adressen, Seriennummern, 
Verantwortliche, Garantiezeiten, Dienstleister, Betriebsdokumentation, Lizenzinformationen, 
Kostenstellen sowie der Verwaltung / Organisation der Benutzer, Geräte-Einweisungen;
die zentrale Dokumentation aller Tätigkeiten und Änderungen in der IT etwa aufgrund von 
durchgeführten Instandhaltungs- oder anderen Serviceleistungen (bspw. Medizingeräte- 
Logbuch);
zum Aufbau einer Wissensdatenbank.

zur Automatisierung und Vereinfachung allgemeiner Verwaltungsabläufe, wie etwa:
im Service und technischen Kundendienst, beispielsweise im IT-Service (Störungen, 
Änderungen, Wartung);
in der Haustechnik (Störungen, Änderungen, Reinigung) oder der Medizingerätetechnik.

für Überwachungszwecke und Kalenderfunktionen, etwa:
von zentralen IT-Diensten (Netzwerk, Mail, Datenserver, SAP,...);
sowie von Störungs- und Bedarfsmeldungen an die IT, Haustechnik, Medizingerätetechnik;
die Planung von regelmäßigen Wartungsarbeiten und die Erinnerung an Wechsel von 
Verschleißteilen;
die Organisation von regelmäßigen Bestellungen und die Einsatzplanung der Service- 
Techniker.

KIX dient nicht dazu, das Funktionieren von Medizinprodukten zu ermöglichen oder zu gewährleisten und 
darf zu diesem Zweck auch nicht eingesetzt werden. Sofern KIX im Rahmen der vorstehenden 
Funktionalitäten zudem einen Datenaustausch in Form einer Schnittstellenfunktion zulässt, weisen wir 
darauf hin, dass KIX nicht zur Veränderung oder sonstige Einflussnahme auf Daten in medizinisch oder 
therapeutisch relevanter Art und Weise genutzt werden darf.
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Eine Verwendung von KIX im medizinischen Bereich ist nur innerhalb der oben dargelegten Bereiche 
zulässig. Für eine darüber hinausgehende oder abweichende Verwendung übernimmt die c.a.p.e. IT GmbH 
keinerlei Haftung.


	Zusatzmodul Anonymisierung
	Installation Zusatzmodul Anonymisierung
	Voraussetzung
	Paket Installation

	Konfiguration Zusatzmodul Anonymisierung
	Anonymer Agent
	Attribute für anonymen Agenten
	E-Mail Domain als anonymer Agent
	Anonymen Agenten erzeugen bei Notwendigkeit
	Anonyme Kunden-ID
	Match-Kriterien für Kunden-ID
	Anonyme Kunden-ID durch Backend
	Match-Kriterien für Kunden-ID durch Backend
	Anonymer Ansprechpartner
	Match-Kriterien für Ansprechpartner
	Anonymer Ansprechpartner durch Backend
	Match-Kriterien für Ansprechpartner durch Backend
	E-Mail als anonymer Ansprechpartner
	Anonymisierte Historien-Komentare
	Artikel E-Mail Adressen
	Dynamisches Feld für Anonymisierungs-Flag
	Tickets mit Anonymisierungs-Flag ignorieren

	Benutzung
	Konfiguration eines Generic Agent
	Tickets via Skript anonymisieren
	Beispiel eines anonymisierten Tickets


	Zusatzmodul Field Service
	Installation des Moduls
	Voraussetzungen
	Paket Installation
	Neue Gruppe

	Installation der App auf einem Mobile Device
	Voraussetzung
	Installation der App
	Konfigurieren der Server URL
	Geräte-ID in KIX registrieren

	Konfiguration
	Widget "Kartenansicht" in Kanban-Seitenleiste
	Regionsangabe für Google Maps
	Google API Schlüssel
	Maximale Suchtiefe
	Relevante CI-Klasse
	Relevante CI-Klassenattribute
	Relevante Ansprechpartner-Attribute
	Cache Time To Live
	Hervorhebung der Farben
	Karteneinstellungen für Kanban-View Konfiguration
	Tour-Status Workflow
	MobileDataSet: Maximum Leerlauf-Zeit
	MobileDataSet: Ausgabeverzeichnis
	MobileDataSet: Enthaltene Anhänge
	MobileDataSet: Enthaltene verknüpfte Objekte
	MobileDataSet: Geräte-ID Attribute
	MobileDataSet: Typ des Eintrages in der Tickethistorie für neue, synchronisierte Artikel
	MobileDataSet: Kommentar des Eintrages in der Tickethistorie für neue, synchronisierte Artikel


	Zusatzmodul Inventarisierung Baramundi Backend
	Installation Baramundi Backend
	Vorraussetzungen
	Paket Installation

	Konfiguration Baramundi Backend
	Source
	Backend „Baramundi“
	Backend „BaramundiMD“ (Mobile Devices)
	InventoryContentXPath für das Baramundi-Backend
	Xpath-Struktur und Beispiele
	Beispiel


	Zusatzmodul Inventarisierung DB Backend
	Installation DB Backend
	Voraussetzungen
	Installation

	Konfiguration DB Backend
	Sources
	Source - Backend - Mapping
	Konfiguration in Config.pm
	Inventory Content XPath


	Zusatzmodul Inventarisierung OPSI Backend
	Installation OPSI Backend
	Vorraussetzungen
	Paket Installation

	Konfiguration OPSI Backend
	Source
	Source-Backend-Mapping
	Source-Parameter
	SSL-Verification
	InventoryContentXPath-Struktur

	Beispiel ConfigItem-Klasse

	Zusatzmodul Inventarisierung VMWare Backend
	Installation VMWare Backend
	Vorraussetzungen
	Paket Installation 

	Konfiguration VMWare Backend
	Grundlagen
	SysConfig-Optionen
	Source
	Source-Backend-Mapping
	Source-Parameter
	Alternatives ObjectType mapping
	ObjectType Fallback
	SSL Verification
	InventoryContentXPath-Struktur
	Beispiel ConfigItem-Klassen für das VMWare-Backend


	Zusatzmodul ITSM-Standard Workflows
	Installation Zusatzmodul ITSM-Standard Workflows
	 Voraussetzungen
	Paket Installation

	Tickettypen
	Relevante Ticketstatus
	Speicherung des Abschlusscodes
	Ticketaktion "Workaround erfassen"
	Ticketaktion "Schließen"

	Konfiguration von ITSM-Standard Workflows

	Zusatzmodul Kanban Board
	Installation Zusatzmodul Kanban Board
	Vorraussetzungen
	Paket Installation
	Neue Gruppen
	Neue Tabellen

	Konfiguration Zusatzmodul Kanban Board
	Widget "Verteilbare Tickets" in der Kanban-Seitenleiste
	Normalisierung der Spaltenbreiten
	Ticket-Attribute im Kopfbereich einer Ticket-Karte
	Ticket-Attribute im Inhaltsbereich einer Ticket-Karte
	Dynamische Links für Ticket-Attribute
	Dummy Attributes
	Fortschrittsbalken für Ticket-Attribute
	Meta Status als Spalten
	Farben der Tickettypen
	Tickettyp-spezifische CSS-Klassen
	Dynamische Felder als Swimlane-Attribute
	Anzahl der Tickets im Kanban-Board
	Zugriff auf das "Änderungs"-Popup
	Einstellen der benötigten Sperre
	Anzeigen des "Incident State" des Ticketservices
	Ändern verschiedener Ticketattribute und Dynamische Felder beim Verschieben eines Tickets im Kanban-Board
	Nächste mögliche Statustypen
	Hinzufügen einer Notiz beim Verschieben eines Tickets im Kanban-Board
	Notizfeld als Pflichtfeld
	Standardwerte für Notizüberschrift und Notizinhalt
	Größe des Notiz-Eingabefeldes
	Standard Artikeltyp
	Mögliche Artikeltypen
	Historie-Typ
	Historie-Kommentar


	Zusatzmodul KIX-Connect
	Installation von KIX Connect
	Vorraussetzungen
	Installation
	Neue Dynamische Felder
	Neue ACls

	Generischer Invoker
	Verwendung

	Erweiterte Transportoptionen
	Zusätzliche Header
	Proxy-Einstellungen
	Konfiguration SSL

	Umgang mit großen Datenmengen
	Caching bearbeiteter Datensätze
	IncidentStateRecalc verzögern/auslassen
	Asynchrones Ausführen von Calls

	Vorkonfigurierte WebServices
	KIX2KIX
	KIX2JIRA
	KIX2i-doit
	BaramundiSync
	VMWareAirWatchSync


	Zusatzmodul KPI-Dashboard
	Installation Zusatzmodul KPI-Dashboard
	Voraussetzungen
	Installation

	Konfiguration Zusatzmodul KPI-Dashboard
	KPI Bereich - Analysierte Jahre
	Die Standard Dashboard-Datei
	Statustyp Einschränkung
	Archiv-Markierung Einschränkung
	Ignorierte Queues
	Ignorierte Tickettypen
	Ignorierte Services
	Ignorierte SLAs
	Eskalationsbasis
	Eskalations-Zeitbasis
	Datenstrom - Verzeichnis für die Datenaufbereitung
	Datenstrom - Dynamische Felder
	Liste der verfügbaren Ticket-Attribute
	Liste der verfügbaren KPI-Attribute
	Liste der standardmäßig ausgewählten Attribute
	Datenbank-Sicht
	Liste der verfügbaren Datenbank-Sichtattribute
	Symbole für den OutOfSLA Prozentsatz
	Einstellungen für die Elemente im Online-KPI-Dashboard
	Erklärung der Standard KPI-Daten

	Administration Zusatzmodul KPI-Dashboard
	Neue KPI-Dashboards erstellen
	KPI-Datenquelle in PowerPivot konfigurieren
	Vorbereitung der Datenströme
	Datenstrom mit KIX-GUI vorbereiten
	Datenstrom mit KIX-Konsolenscript vorbereiten
	Datenstrom mit cronjobs vorbereiten

	Daten-Plugins für KPI-Dashboard
	Online KPI-Dashboard
	Das Online-KPI-Dashboard öffnen
	Einstellungen für das Online-KPI-Dashboard
	Filter für das Online-KPI-Dashboard


	Zusatzmodul MRO Bundle
	Einführung
	Hinweise zum Arbeiten mit KIX MRO
	Bezeichnungen

	Installation
	Installation unter debian / ubuntu
	Installation unter OpenSUSE / SLES
	Installation unter CentOS / Red Hat
	Hinweise zum Upgrade

	Die Bestandteile des KIX MRO Bundles
	Kanban Board
	Wartungsplaner
	Field Service
	KIX MRO Erweiterungen


	Zusatzmodul Security Management
	Allgemeines zu Security Management
	Installation von Security Management
	Voraussetzungen
	Paket Installation
	Migration von Version 17.4.x

	Administration von Security Management
	Abrufen von Tasks in KIX
	Neue Objekte
	Konfiguration von Security Management
	Vorbereitungen zur Verwendung


	Zusatzmodul Telefonintegration
	Installation Zusatzmodul Telefonintegration
	Anforderungen an die Telefonanlage
	Paket Installation
	Integration in Ihre Telefonanlage
	HTTP Backend - Konfiguration der ActionURLs

	Konfiguration Zusatzmodul Telefonintegration
	Auswahl des Backends
	Ansprechpartner PhoneID Type Mapping
	Ansprechpartner PhoneID Type Mapping - Standard
	Ansprechpartner PhoneID Mapping
	Agenten PhoneID Type
	Eingehende Anrufe - Filter
	Erkennung der Nummernerweiterung
	Komplettierung der Nummernerweiterung
	Standard Länder-Code
	Einstellungen für ausgehende Anrufe
	Telefonnummernauswahl anzeigen
	Suchtyp für Suche nach Agenten und Ansprechpartnern bei eingehenden Anrufen
	Suche nach Kunden


	Zusatzmodul Wartungsplaner
	Installation Zusatzmodul Wartungsplaner
	Vorraussetzungen
	Paket Installation
	Neue Access Control Lists (ACL)
	Anpassung der CI-Klassen
	Neuer Tickettyp
	Neue dynamische Felder

	Konfiguration Zusatzmodul Wartungsplaner
	Klassen für zeitbasierte Wartung
	Klassen für schwellwertbasierte Wartung
	Relevante Verwendungsstatus
	Prüfung schwellwertbasierender Wartungen
	Link-Typen
	Ersetzen der derzeitigen ConfigItem-Version
	Standard Ticketdaten
	Ticketattribute - ConfigItem-Atrribute Mapping
	Standard Artikeldaten
	Scheduler Registrierung
	Event für Gültigkeitsprüfung
	Gültigkeitsprüfung - Parameter für Wartungsplaner
	Gültigkeitsprüfung - Parameter für gewartete ConfigItems
	Event für Prüfung nach Wertaktualisierung bei einer schwellwertbasierten Wartung
	Ticketdaten an ein ConfigItem zurückschreiben
	ConfigItem-Attribute - Mapping dynamischer Felder
	Parameter für Suche nach gleichen Tickets
	Berechtigung für "Änderungs"-Popup
	Gewünschte Sperre einstellen
	Anlegen von Wartungstickets

	Nutzung
	Anpassung der CI-Klassen für den Wartungsplaner
	Zusammensetzung der Wartungsintervalle


	Zusatzmodul Zeiterfassung
	Installation Zusatzmodul Zeiterfassung
	Vorraussetzungen
	Paket Installation

	Konfiguration Zusatzmodul Zeiterfassung
	CIC-Dashlet und Ticket-Sidebar freie Budgets


	Haftungsausschluss KIX Pro Zusatzmodule
	Zweckbestimmung für die Verwendung von KIX Zusatzmodulen im medizinischen Bereich

